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Get Started

SYNCED AND LOADED iCloud keeps your data in sync across your iPhone, Mac, and any 
other iOS devices.

Over the past few years, users have become obsessed with the notion of having their documents and data 
LQVWDQWO\�DYDLODEOH�ZKHUHYHU�WKH\�DUH��RQ�ZKLFKHYHU�GHYLFH�WKH\�KDSSHQ�WR�EH�XVLQJ�DW�WKH�WLPH��:LWK�L&ORXG��
$SSOH�KDV�FKDUJHG�KHDGILUVW�LQWR�WKH�GLJLWDO�V\QFLQJ�VSKHUH��$�IUHH�L&ORXG�DFFRXQW�OHWV�\RX�V\QF�\RXU�GRFX-
PHQWV��GDWD��DFFRXQWV��SKRWRV��PRELOH�EDFNXSV��SXUFKDVHV��DQG�VR�PXFK�PRUH�
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What Is iCloud?
iCloud is a catchall phrase that covers Apple’s suite of sync and backup services, which aim to keep your  
GHYLFHVȃL26�GHYLFHV�UXQQLQJ�L26���RU�ODWHU�DQG�GHVNWRS�FRPSXWHUV�UXQQLQJ�26�;�/LRQ�RU�ODWHU��RU�:LQGRZV�
9LVWD�RU�ODWHUȃRQ�WKH�VDPH�SDJH��QR�PDWWHU�ZKLFK�RQH�\RXȇUH�XVLQJ�DW�DQ\�JLYHQ�PRPHQW��<RX�FDQ�FUHDWH�DQ�
L&ORXG�DFFRXQW�IRU�IUHH�RQ�DQ\�GHYLFH�WKH�VHUYLFH�LV�FRPSDWLEOH�ZLWK�

These services cover four general areas: document and data sync, mobile backup, location awareness, and 
SXUFKDVH�PDQDJHPHQW�

A free iCloud account provides 5GB of storage for data sync and mobile backup; you can purchase  
DGGLWLRQDO�VSDFH�IRU�D�\HDUO\�IHH��0DQ\�WKLQJV�WKDW�\RXU�L&ORXG�DFFRXQW�V\QFVȃ\RXU�SXUFKDVHG�FRQWHQW�DQG�
\RXU�3KRWR�6WUHDP�LPDJHV��IRU�H[DPSOHȃGR�QRW�FRXQW�WRZDUG�WKLV�OLPLW���)RU�PRUH�LQIRUPDWLRQ��VHH�ȊStorage in 
the Cloudȋ�ODWHU�LQ�WKLV�FKDSWHU��

Unlike some third-party services, iCloud doesn’t focus on preserving individual files or providing a central folder 
ZKHUH�\RX�FDQ�XSORDG�GRFXPHQWV�WR�DFFHVV�DFURVV�SODWIRUPV��:LWK�L&ORXG��$SSOH�ZDQWV�\RX�WR�VWRS�ZRUU\LQJ�
DERXW�ZKHUH�\RXȇYH�VDYHG�VSHFLILF�ILOHV��DQG�LQVWHDG�IRFXV�RQ�WKH�LQIRUPDWLRQ�LWVHOI�

Sync and Share

iCloud’s behind-the-scenes sync features focus on keeping your data up-to-date, syncing documents and infor-
PDWLRQ�EHWZHHQ�GHYLFHV��DQG�VWUHDPLQJ�\RXU�UHFHQWO\�WDNHQ�SKRWRV�DFURVV�GHYLFHV���)RU�PRUH�RQ�V\QFLQJ��VHH�
ȊDocuments & Dataȋ�LQ�WKH�Ȋ:RUN�:LWK�L&ORXGȋ�FKDSWHU��

EMAIL L&ORXG�RIIHUV�XVHUV�D�IUHH�HPDLO�DFFRXQW��LQ�WKLV�FDVH��XVLQJ�WKH�IRUPDW�name@icloud.com) for sending 
DQG�UHFHLYLQJ�HPDLO��7KLV�DFFRXQW�XVHV�WKH�Ζ0$3�SURWRFRO��VR�LW�ZRUNV�ZLWK�DQ\�VWDQGDUG�HPDLO�FOLHQW��VXFK�DV�26�
;ȇV�0DLO���DV�ZHOO�DV�WKH�L26�0DLO�DSS�DQG�WKH�L&ORXG�:HE�DSS�

DATA SYNC iCloud lets you access, update, and sync your contacts, calendars, reminders, Safari bookmarks 
DQG�WDEV��QRWHV��SKRWRV��DQG�PRUH�DFURVV�DOO�RI�\RXU�GHYLFHV�DQG�WKH�:HE�

iPhone, iPad, and iPod touch devices running iOS 5 or later can sync calendar, reminder, contacts, notes, Web 
EURZVHU�GDWD��DQG��IRU�L3KRQH�XVHUV�UXQQLQJ�L26����DQ\�3DVVERRN�WLFNHWV�RU�FRXSRQV�\RX�PD\�KDYH�SLFNHG�XS�

0DFV�UXQQLQJ�26�;�����0RXQWDLQ�/LRQ�FDQ�V\QF�FDOHQGDU��UHPLQGHU��FRQWDFW��DQG�QRWHV�GDWD�XVLQJ�WKH�&DOHQGDU��
5HPLQGHUV��&RQWDFWV��DQG�1RWHV�DSSV��UHVSHFWLYHO\��L&DO��$GGUHVV�%RRN��DQG�0DLO�LQ�26�;�������:LQGRZV�XVHUV�
FDQ�XVH�2XWORRN������RU�ODWHU��<RX�FDQ�DOVR�FKRRVH�WR�V\QF�\RXU�:HE�EURZVHUȇV�ERRNPDUNV��

$OO�GDWD�V\QFLQJ�LQIRUPDWLRQ�FRXQWV�WRZDUG�\RXU�IUHH��*%�VWRUDJH�OLPLW��

DOCUMENTS SYNC Several of Apple’s built-in OS X and iOS apps—along with many third-party apps available 
on the App Store—can store their documents to your iCloud account, allowing you to access those files from 
PXOWLSOH�GHYLFHV��/LNH�V\QFHG�GDWD��WKLV�LQIRUPDWLRQ�FRXQWV�WRZDUG�\RXU�IUHH��*%�VWRUDJH�OLPLW�
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PHOTO STREAM L&ORXGȇV�SKRWR�VHUYLFH�DOORZV�\RX�WR�VQDS�D�SLFWXUH�IURP�DQ\�L26�GHYLFH��RU�XSORDG�DQ�LPDJH�WR�D�
Photo Stream–compatible program or folder on your Mac or PC) and seamlessly share it to all your other devices 
DQG�FRPSXWHUV��3KRWR�6WUHDP�VWRUHV�WKH�ODVW����GD\Vȇ�ZRUWK�RI�LPDJHV�RQOLQH��LI�\RX�KDYH�D�0DF�RU�3&�FRQQHFWHG�
WR�3KRWR�6WUHDP��LPDJHV�DXWRPDWLFDOO\�GRZQORDG�WR�\RXU�FRPSXWHU��VR�WKH\ȇUH�LQVWDQWO\�VWRUHG�RIIOLQH��<RXU�L26�
GHYLFHV��LQ�FRQWUDVW��FDQ�RQO\�DFFHVV�WKH�ODVW�����3KRWR�6WUHDP�LWHPV��DQG�\RX�KDYH�WR�GRZQORDG�LPDJHV�PDQXDOO\�

L&ORXG�DOVR�OHWV�\RX�FUHDWH�6KDUHG�3KRWR�6WUHDPV�VR�\RX�FDQ�VKDUH�LPDJHV�ZLWK�IDPLO\�DQG�IULHQGV���)RU�PRUH�
RQ�3KRWR�6WUHDP��VHH�ȊPhoto Streamȋ�LQ�WKH�Ȋ:RUN�:LWK�L&ORXGȋ�FKDSWHU��

Back Up Files

ΖQ�DGGLWLRQ�WR�V\QFLQJ�\RXU�ILOHV��SXUFKDVHV��DQG�GDWD�WR�L&ORXG��\RX�FDQ�EDFN�XS�\RXU�L26�GHYLFHV�WR�LW��7KLV�
FRXQWV�WRZDUG�\RXU�IUHH��*%�VWRUDJH�OLPLW��7R�EDFN�XS�\RXU�L3KRQH��L3RG��RU�L3DG��RSHQ�LWV�6HWWLQJV�DSS�DQG�
navigate to iCloud > Storage & Backup.

CLOUD BACKUP You can back up to iCloud, which lets you restore from the cloud.

Enable the iCloud Backup option, and your device automatically backs up accounts, documents, settings, and 
WKH�&DPHUD�5ROO�DOEXP�WR�L&ORXG�ZKHQHYHU�WKH�GHYLFH�LV�SOXJJHG�LQWR�D�SRZHU�VRXUFH��FRQQHFWHG�WR�:L�)L��DQG�
DVOHHS��ORFNHG���<RX�FDQ�DOVR�IRUFH�DQ�L&ORXG�EDFNXS�DW�DQ\�WLPH�E\�JRLQJ�WR�Settings > iCloud > Storage & Backup 
and tapping the Back Up Now�EXWWRQ��ZKLFK�WXUQV�LQWR�&DQFHO�%DFNXS�ZKLOH�D�EDFNXS�LV�RFFXUULQJ��
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If you ever need to restore your device, you can do so over the air, with the iCloud backup working in tandem 
ZLWK�\RXU�L7XQHV�DQG�$SS�6WRUH�SXUFKDVHV�VR�\RX�FDQ�JHW�\RXU�GHYLFH�EDFN�WR�ZKHUH�LW�ZDV��$�QRWH��<RX�PD\�QRW�
EH�DEOH�WR�UHVWRUH�FHUWDLQ�SXUFKDVHVȃIRU�H[DPSOH��VRPH�PRYLHV�DQG�79�VKRZVȃLQWHUQDWLRQDOO\�GXH�WR�OLFHQV-
LQJ�UHVWULFWLRQV��FKHFN�\RXU�FRXQWU\ȇV�WHUPV�DQG�FRQGLWLRQV�WR�EH�VXUH���)RU�PRUH�RQ�L&ORXG�EDFNXS��VHH�ȊMobile 
Backupȋ�LQ�WKH�Ȋ:RUN�:LWK�L&ORXGȋ�FKDSWHU��

Find Your People, Places, and Things

0LVVLQJ�\RXU�L3KRQH�RU�FDQȇW�ILQG�\RXU�IULHQGV"�<RXU�L&ORXG�DFFRXQW�OHWV�\RX�WUDFN�DQ\�L26�GHYLFH�WKDW�\RXȇYH�OLQNHG�
WR�LW��ZLWK�VRPH�DVVLVWDQFH�IURP�WKH�)LQG�0\�L3KRQH�DSS�RQ�L26�DQG�RQ�WKH�:HE��ΖQ�DGGLWLRQ��\RXU�DFFRXQW�OHWV�\RX�
XVH�$SSOHȇV�)LQG�0\�)ULHQGV�VHUYLFH�WR�FRQQHFW�DQG�PHHW�XS�ZLWK�\RXU�SDOV�DQG�IDPLO\�PHPEHUV��ΖI�\RXȇYH�OLQNHG�\RXU�
iCloud account with your Mac, you can also use its Back to My Mac service to remotely connect to your computer 
IURP�DIDU���)RU�PRUH�LQIRUPDWLRQ�RQ�WKHVH�VHUYLFHV��VHH�Ȋ/RFDWLRQ�$ZDUHQHVVȋ�LQ�WKH�Ȋ:RUN�:LWK�L&ORXGȋ�FKDSWHU��

iPHONE TRACKER /RVW�\RXU�GHYLFH"�ΖI�\RX�DGGHG�\RXU�L&ORXG�DFFRXQW�WR�LW��\RX�FDQ�ORFDWH�LW�HDVLO\�XVLQJ�)LQG�0\�
L3KRQH��7KLV�DSS�OHWV�\RX�WUDFN�GRZQ�DQ\�L26�GHYLFHȃRU�0DFȃWKDW�KDV�$SSOHȇV�)LQG�0\�device�VHUYLFH�HQDEOHG�

TRACKING DEVICE Lost your iPhone, iPad, iPod, or Mac? If you have it linked with iCloud, 
you can track it by logging in to the iCloud website.
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If you’ve lost your device, you can log in to the iCloud website RU�WKH�)LQG�0\�L3KRQH�DSS�RQ�D�GLIIHUHQW�L26� 
GHYLFH�WR�ILQG�LW��)URP�WKHUH��\RX�FDQ�PDNH�WKH�GHYLFH�HPLW�D�VRXQG��HYHQ�LI�LWȇV�LQ�VLOHQW�PRGH���HQDEOH�/RVW�
PRGH�WR�WUDFN�LWV�ORFDWLRQ��DQG�UHPRWHO\�ORFN��DQG�RSWLRQDOO\�ZLSH��LW��<RX�FDQ�HYHQ�FKRRVH�WR�UHFHLYH�DQ�HPDLO�
QRWLILFDWLRQ�LI�\RXU�GHYLFH�LV�LQLWLDOO\�RII�EXW�ODWHU�UHWXUQV�RQOLQH�

FIND MY FRIENDS This app allows you to broadcast your location temporarily or permanently to a select group 
RI�SHRSOH��DV�ZHOO�DV�ORFDWH�WKRVH�IULHQGV�DQG�IDPLO\�ZKR�KDYH�JLYHQ�\RX�SHUPLVVLRQ�WR�ORFDWH�WKHP�

FRIEND FINDER The Find My Friends app lets you track down those friends who’ve given 
you permission to locate them.

<RX�FDQ�WXUQ�\RXU�ORFDWLRQ�RQ�RU�RII��FUHDWH�D�)DYRULWHV�OLVW�IURP�\RXU�)LQG�0\�)ULHQGV�FRQWDFWV��FUHDWH�D�WHP-
porary event so that people not on your contacts list can find you during a specific outing, and restrict sharing 
ZLWK�VSHFLDOL]HG�FRQWUROV��ΖI�\RX�ZDQW�WR�QRWLI\�\RXU�IULHQGV�ZKHQ�\RX�HQWHU�RU�OHDYH�D�VSHFLILF�SODFH��RU�LI�\RX�
ZDQW�WR�EH�QRWLILHG�DERXW�WKHLU�PRYHPHQWV���\RX�FDQ�DOVR�VHW�WKDW�XS�ZLWKLQ�WKH�DSS��7KLV�DSS�RQO\�ZRUNV�IRU�
L3DG��L3KRQH��DQG�L3RG�WRXFK�XVHUV�

http://www.icloud.com
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BACK TO MY MAC�<RXȇUH�RQ�YDFDWLRQ�DQG�VXGGHQO\�UHPHPEHU�WKDW�\RX�QHHG�WR�ZRUN�RQ�D�SURMHFW�\RX�OHIW�
DW�KRPH��:KDW�WR�GR"�ΖI�\RX�KDYH�L&ORXGȇV�%DFN�WR�0\�0DF�VHUYLFH�HQDEOHG�DQG�D�QHDUE\�0DF�WR�XVH��\RX�FDQ�
UHPRWHO\�FRQQHFW�WR�\RXU�KRPHERXQG�FRPSXWHU�HYHQ�LI�LWȇV�PLOHV�DZD\�

SCREENS AWAY With Back to My Mac, you can view your computer’s screen from a 
distant location.

Back to My Mac lets you connect via file sharing or screen sharing, giving you the freedom to access your com-
SXWHU�LQ�PXOWLSOH�ZD\V�

iTunes in the Cloud

iCloud’s purchase management focuses on three areas—past purchases, purchases in the cloud, and iTunes 
0DWFK��D�����\HDUO\�DGG�RQ�ȃWKDW�FROOHFWLYHO\�PDNH�XS�L7XQHV�LQ�WKH�&ORXG���)RU�PRUH�LQIRUPDWLRQ��VHH�ȊPur-
chase Managementȋ�LQ�WKH�Ȋ:RUN�:LWK�L&ORXGȋ�FKDSWHU��

PAST PURCHASES The Purchased screen in the App Store, iTunes Store, and iBookstore on a Mac, PC, or iOS 
device allows you to view your purchase history for apps, music, videos, and books, and redownload any of 
WKHP�IRU�IUHH��
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CLASSY CATALOG Redownload your previously purchased songs from the iTunes app at 
any time.

In addition, your Mac, PC, and iOS devices can automatically download any new purchases you make using 
\RXU�L&ORXG�DFFRXQW���$�IHZ�FDYHDWV��5HGRZQORDGLQJ�FHUWDLQ�LWHPV��VXFK�DV�PXVLF�DQG�WHOHYLVLRQ�VKRZV��PD\�EH�
UHVWULFWHG�E\�FRXQWU\��$QG�LI�DQ�LWHP�\RXȇYH�SXUFKDVHG�LV�QR�ORQJHU�DYDLODEOH�RQ�WKH�L7XQHV�6WRUH��\RX�PD\�QRW�
EH�DEOH�WR�UHGRZQORDG�LW��

PURCHASES IN THE CLOUD As mentioned above, you can set your Mac, PC, iPhone, iPod touch, or iPad to 
automatically download any new music, apps, and books you buy from other devices, and you can also redown-
ORDG�DQ\�SUHYLRXVO\�SXUFKDVHG�FRQWHQW�IURP�WKH�WKUHH�VWRUHV�

The iBooks app takes this one step further: Any content you’ve previously purchased on the store shows up in 
\RXU�L%RRNV�OLEUDU\�ZLWK�D�OLWWOH�GRZQORDG�LFRQ�LQ�WKH�WRS�ULJKW�FRUQHU��7KLV�DOORZV�\RX�WR�TXLFNO\�VHH�\RXU�OLEUDU\��
WKRXJK�WKH�ERRNV�WKHPVHOYHV�PD\�QRW�EH�RQ�\RXU�GHYLFH��WR�GRZQORDG�RQH��MXVW�WDS�WKH�ERRN�LQ�TXHVWLRQ�
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CLOUDY PAGES All your purchased books automatically show up in your iBooks library, 
though you can’t read any of them until you tap one to download it.

This only applies to content you’ve purchased—iCloud won’t sync books you’ve manually loaded onto your 
GHYLFH�IURP�RWKHU�SODFHV�

iTUNES MATCH Though you can redownload individual music tracks to your device using the Purchased fea-
WXUH��IRU�DQ�DGGLWLRQDO�����D�\HDU�\RX�FDQ�XQORFN�L7XQHV�0DWFK��ZKLFK�OHWV�\RX�XSORDG�\RXU�0DFȇV�RU�3&ȇV�L7XQHV�
OLEUDU\�DQG�DFFHVV�LW�IURP�DQ\�GHYLFH�\RXȇUH�ORJJHG�LQWR�
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FOR A SONG iTunes Match lets you stream or download any song you’ve  
uploaded from your Mac’s or PC’s library, whether you purchased it from the  

iTunes Store or elsewhere.

Once enabled, iTunes Match scans the songs in your music library and links them to the correct song in the 
L7XQHV�FDWDORJ�IRU�HDV\�GRZQORDGLQJ�DQG�VWUHDPLQJ�WR�\RXU�GHYLFHV��ΖI�\RX�GLGQȇW�RULJLQDOO\�SXUFKDVH�\RXU�VRQJV�
IURP�L7XQHV�EXW�WKH\ȇUH�DYDLODEOH�LQ�WKH�FDWDORJ��\RX�FDQ�GRZQORDG�'50�IUHH�����NESV�$$&�YHUVLRQV�IRU�IUHH��
L7XQHV�XSORDGV�\RXU�XQPDWFKHG�VRQJV�WR�L&ORXG�VR�WKDW�\RX�FDQ�DFFHVV�WKHP�IURP�PXOWLSOH�GHYLFHV�
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Set Up iCloud
1RZ�WKDW�\RX�KDYH�DQ�LGHD�RI�ZKDW�FRQVWLWXWHV�L&ORXG��LWȇV�WLPH�WR�VHW�XS�\RXU�YHU\�ILUVW�DFFRXQW���ΖI�\RX�DOUHDG\�
KDYH�DQ�L&ORXG�DFFRXQW��FRQJUDWXODWLRQV��<RXȇUH�ZHOFRPH�WR�VNLS�WKLV�VHFWLRQ�DQG�MXPS�WR�ȊStorage in the Cloud,” 
RU�UHDG�RQ�WR�OHDUQ�DERXW�KRZ�WR�VHW�XS�\RXU�RWKHU�GHYLFHV��

READY TO ROLL Creating an iCloud account and adding it to your other devices is easy.

A few notes before we begin: While it’s free to sign up for iCloud, you can’t do so just anywhere; you must cre-
DWH�DQ�DFFRXQW�RQ�HLWKHU�DQ�L26�GHYLFH�UXQQLQJ�L26���RU�ODWHU�RU�D�0DF�UXQQLQJ�26�;�������RU�ODWHU��8QIRUWXQDWH-
O\��:LQGRZV�XVHUV�KDYH�WR�ILUVW�FUHDWH�DQ�DFFRXQW�RQ�RQH�RI�WKHVH�SODWIRUPV�EHIRUH�WKH\�FDQ�ORJ�LQ�RQ�WKHLU�3&�

<RXȇUH�DOVR�OLPLWHG�WR�FUHDWLQJ�WHQ�L&ORXG�DFFRXQWV�SHU�GHYLFH��<RX�VKRXOG�RQO\�QHHG�RQH�RU�WZR��VR�\RXȇOO�SURE-
DEO\�QHYHU�UXQ�XS�DJDLQVW�WKLV�OLPLW��+RZHYHU��EHFDXVH�WKLV�OLPLW�SHUVLVWV�DIWHU�IXOO�GHYLFH�ZLSHV��WKHUHȇV�D�SRVVL-
ELOLW\�\RX�PD\�HQFRXQWHU�LW�LI�\RX�KDYH�DQ�ROGHU�L26�GHYLFH�RU�0DF��ΖI�\RX�GR�JHW�DQ�DOHUW�WKDW�SUHYHQWV�\RX�IURP�
FUHDWLQJ�D�QHZ�L&ORXG�DFFRXQW��ZH�VXJJHVW�JRLQJ�WR�\RXU�QHDUHVW�$SSOH�6WRUH�IRU�KHOS�

Do You Have an Apple ID?

ΖI�\RXȇYH�HYHU�SXUFKDVHG�DQ\WKLQJ�IURP�WKH�L7XQHV�6WRUH��$SS�6WRUH��RU�L%RRNVWRUH��\RX�KDYH�DQ�$SSOH�Ζ'���<RXU�XVHU-
QDPH�LV�SUREDEO\�WKH�HPDLO�DGGUHVV�\RX�XVHG�WR�VLJQ�XS�IRU�L7XQHV���ΖI�\RXȇYH�ORJJHG�LQWR�WKH�L7XQHV�RU�$SS�6WRUH�DSSV�
ZLWK�WKLV�$SSOH�Ζ'��\RX�VKRXOG�VHH�WKH�HPDLO�DGGUHVV�DOUHDG\�ILOOHG�RXW�LQ�WKH�$SSOH�Ζ'�VHFWLRQ�RI�WKH�L&ORXG�VFUHHQ�

All iCloud accounts stem from Apple IDs, so it’s very easy to convert your current Apple ID into an iCloud  
DFFRXQW��<RXȇOO�VWLOO�EH�DEOH�WR�XVH�\RXU�$SSOH�Ζ'�IRU�HYHU\WKLQJ�\RX�FXUUHQWO\�XVH�LW�IRU��EXW�\RXȇOO�DOVR�JHW�DOO�RI�
L&ORXGȇV�IHDWXUHV��$QG�LI�RWKHU�PHPEHUV�RI�\RXU�IDPLO\�XVH�WKLV�$SSOH�Ζ'��WKH\ȇOO�VWLOO�EH�DEOH�WR�XVH�LW�IRU�SXU-
FKDVHV�ZLWKRXW�KDYLQJ�DFFHVV�WR�DOO�RI�\RXU�L&ORXG�LQIRUPDWLRQ���)RU�PRUH�RQ�PDQDJLQJ�PXOWLSOH�$SSOH�Ζ'V�DQG�
L&ORXG��VHH�ȊAccountsȋ�LQ�WKH�Ȋ7URXEOHVKRRW�L&ORXGȋ�FKDSWHU��

To convert your Apple ID into an iCloud account, open the iCloud preference screen on your iOS device or Mac, 
WKHQ�VLJQ�LQWR�L&ORXG�ZLWK�\RXU�FXUUHQW�$SSOH�Ζ'�DQG�SDVVZRUG��7KH�VFUHHQ�ZLOO�SURPSW�\RX�WR�DJUHH�WR�WKH�
L&ORXG�WHUPV�DQG�FRQGLWLRQV��RQFH�\RX�GR��\RXȇUH�UHDG\�WR�EHJLQ�XVLQJ�WKH�VHUYLFH�
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NEW MAIL If you want to add an iCloud email address to your old Apple ID, just turn on 
the Mail switch in Settings > iCloud.

1RWH��ΖI�\RX�GR�FRQYHUW�DQ�$SSOH�Ζ'�LQWR�DQ�L&ORXG�DFFRXQW��\RX�ZRQȇW�JHW�DQ�L&ORXG�HPDLO�DGGUHVV��#LFORXG�
FRP��E\�GHIDXOW��ΖI�\RX�ZDQW�RQH��DOO�\RX�KDYH�WR�GR�LV�JR�WR�Settings > iCloud and toggle the Mail switch on 
�RU��RQ�D�0DF�RU�3&��FOLFN�WKH�FKHFNER[���<RXȇOO�WKHQ�EH�SURPSWHG�WR�FUHDWH�DQ�L&ORXG�HPDLO�DGGUHVV�WR�JR�
DORQJ�ZLWK�\RXU�DFFRXQW�

Starting From Scratch

Never used iTunes before? On an iOS device, go ahead and tap the Get a Free Apple ID button at the bottom of 
WKH�L&ORXG�VHWWLQJV�VFUHHQ���2Q�D�0DF��FOLFN�Create an Apple ID���<RXȇOO�EH�DVNHG�IRU�\RXU�ELUWKGDWH�DQG�QDPH��
DQG�ZKHWKHU�\RXȇG�OLNH�WR�XVH�D�FXUUHQW�HPDLO�DGGUHVV�RU�FUHDWH�DQ�L&ORXG�FRP�HPDLO�DGGUHVV�IRU�\RXU�$SSOH�
Ζ'��(YHQ�LI�\RX�FKRRVH�WR�XVH�\RXU�ROG�HPDLO�DGGUHVV��\RX�FDQ�FUHDWH�D�QHZ�L&ORXG�FRP�DGGUHVV�DIWHU�VHWWLQJ�
up your account by going to Settings > iCloud DQG�WXUQLQJ�RQ�WKH�0DLO�VZLWFK��RU�E\�FOLFNLQJ�WKH�FKHFNER[�RQ�D�
0DF�RU�3&��
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STARTER KIT You can choose to use a current email address or create a new one for your 
Apple ID.

)URP�WKHUH��\RXȇOO�HQWHU�HLWKHU�\RXU�FXUUHQW�HPDLO�DGGUHVV�RU�ZKDW�\RXȇG�OLNH�\RXU�QHZ�L&ORXG�HPDLO�DGGUHVV�WR�
EH��7KH�VHUYLFH�DOVR�SURPSWV�\RX�WR�HQWHU�D�SDVVZRUG�DQG�D�VHFXULW\�TXHVWLRQ�IRU�\RXU�DFFRXQW�

After that, all you need to do to finish up is choose whether you’d like to get email updates from Apple and 
DJUHH�WR�WKH�WHUPV�DQG�FRQGLWLRQV��1RZ��\RXȇUH�UHDG\�WR�VWDUW�XVLQJ�L&ORXG�

Set Up an iOS Device

iCloud was first introduced as a sync mechanism for iOS devices, and consequently, iCloud signup is the most 
VWUDLJKWIRUZDUG�IRU�\RXU�L3KRQH��L3DG��RU�L3RG��7R�VLJQ�XS�IRU�L&ORXG��\RXȇOO�QHHG�D�GHYLFH�UXQQLQJ�L26���RU�ODWHU��
LI�\RXU�L3KRQH�RU�L3RG�LV�VWLOO�UXQQLQJ�L26����\RX�XQIRUWXQDWHO\�ZRQȇW�EH�DEOH�WR�JHW�LQ�RQ�WKH�L&ORXG�DFWLRQ���ΖI�\RX�
ZDQW�WR�WU\�V\QFLQJ�FHUWDLQ�HOHPHQWV�RI�L&ORXG�WR�D�GHYLFH�UXQQLQJ�L26����VHH�ȊAccountsȋ�LQ�WKH�Ȋ7URXEOHVKRRW�
L&ORXGȋ�FKDSWHU��

When you first set up your device, you should have seen a screen during the setup process asking you to sign in 
RU�VLJQ�XS�IRU�DQ�$SSOH�Ζ'�DQG�L&ORXG��HYHQ�LI�\RX�FKRVH�QRW�WR�VHW�WKLV�XS�ZKHQ�\RX�ILUVW�XQER[HG�WKH�GHYLFH��LWȇV�
VLPSOH�WR�JHW�DQ�DFFRXQW�
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THE PORTAL The iCloud settings screen lets you sign into the service or create an 
account for it.

On your device, open the Settings app and tap the iCloud�HQWU\��<RXȇOO�VHH�D�VSDFH�IRU�ORJJLQJ�LQ�ZLWK�DQ�$SSOH�Ζ'�
DQG�SDVVZRUG��DQG�D�EXWWRQ�DW�WKH�ERWWRP��ODEHOHG�Ȇ*HW�D�)UHH�$SSOH�Ζ'ȇ�

USING iCLOUD Once you’ve set up iCloud on your iOS device, most of it gets to work automatically: It syncs 
\RXU�0DLO��LI�\RXȇYH�VHW�0DLO�XS���DORQJ�ZLWK�DQ\�DOUHDG\�FUHDWHG�&RQWDFWV��&DOHQGDUV��5HPLQGHUV��1RWHV��3DVV-
ERRN�SDVVHV��L3KRQH�RQO\���DQG�6DIDUL�ERRNPDUNV��WR�LWV�FHQWUDO�RQOLQH�VHUYHU��3KRWR�6WUHDP�DOVR�VWDUWV�XSORDG-
LQJ�WKH�ODVW�����SKRWRV�\RXȇYH�WDNHQ��$OO�L&ORXG�RSWLRQV�DUH�WXUQHG�RQ�E\�GHIDXOW��LI�\RX�GRQȇW�ZDQW�L&ORXG�WR�
V\QF�D�VSHFLILF�LWHP��MXVW�WDS�WKH�WRJJOH�WR�WXUQ�LW�RII�
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A FULL DECK iOS gives you access to almost all of iCloud’s features.

When you first add an iCloud account, you won’t see any data or third-party documents associated with it until 
\RX�VWDUW�XVLQJ�DSSV�WKDW�VWRUH�WKLV�LQIRUPDWLRQ�LQ�L&ORXG��:KHQ�\RX�RSHQ�DQ�L&ORXG�HQDEOHG�DSS�ZKLOH�ORJJHG�
LQWR�L&ORXG��WKH�DSS�PD\�SURPSW�\RX�WR�VZLWFK�WR�L&ORXG�VWRUDJH�IRU�LWV�GRFXPHQWV�DQG�GDWD��2WKHU�DSSV�PD\�
not switch your storage to iCloud unless you tell them to do so via their app preferences

<RX�FDQ�DOVR�VWDUW�FUHDWLQJ�EDFNXSV�RI�\RXU�L26�GHYLFHV�E\�JRLQJ�WR�Settings > iCloud > Storage & Backup > Back 
Up Now.

Set Up a Mac

7KH�0DF�VHWXS�SURFHVV�LV�YHU\�VLPLODU�WR�VHWWLQJ�XS�DQ�L3DG��L3KRQH��RU�L3RG��<RX�XVH�WKH�L&ORXG�SDQH�LQ�\RXU�
0DFȇV�6\VWHP�3UHIHUHQFHV�
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iCLOUDY GATES The iCloud preference pane on a Mac lets you sign in with your Apple ID 
or create one on the spot.

7R�DGG�RU�FUHDWH�DQ�L&ORXG�DFFRXQW��\RXU�FRPSXWHU�QHHGV�WR�EH�UXQQLQJ�26�;��������DQ\�HDUOLHU��DQG�\RX�ZRQȇW�
KDYH�DQ�L&ORXG�SUHIHUHQFH�SDQH�WR�ORJ�LQWR���)RU�ZD\V�WR�XVH�SDUWV�RI�L&ORXG�RQ�ROGHU�V\VWHPV��VHH�ȊSyncing” in 
WKH�Ȋ7URXEOHVKRRW�L&ORXGȋ�FKDSWHU��

USING iCLOUD�2QFH�VHW�XS��L&ORXG�RQ�\RXU�0DF�DXWRPDWLFDOO\�V\QFV�\RXU�0DLO��LI�\RXȇYH�VHW�0DLO�XS���DORQJ�
with any already created Contacts, Calendars, Reminders, Notes, and Safari bookmarks, to its central online 
VHUYHU��3KRWR�6WUHDP�DOVR�XSORDGV�WKH�ODVW�����SKRWRV�\RXȇYH�WDNHQ��$OO�L&ORXG�RSWLRQV�DUH�WXUQHG�RQ�E\�GHIDXOW�
�H[FHSW�IRU�WKH�0DF�RQO\�%DFN�WR�0\�0DF�IHDWXUH��ZKLFK�\RX�PXVW�WXUQ�RQ�PDQXDOO\���EXW�\RX�FDQ�MXVW�WDS�WKH�
WRJJOH�WR�WXUQ�DQ\�VSHFLILF�LWHP�RII�
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CHECKBOXES, CHECKBOXES Don’t want to enable certain iCloud features? Just uncheck 
those checkboxes.

<RX�FDQȇW�FUHDWH�EDFNXSV�RI�\RXU�0DF�DV�\RX�FDQ�ZLWK�L26�GHYLFHVȃSDUWLDOO\�EHFDXVH�WKRVH�EDFNXSV�ZRXOG�OLNHO\�
HDW�XS�DOO�\RXU�L&ORXG�VWRUDJH�VSDFH��JLYHQ�WKH�VL]H�RI�PRVW�0DF�KDUG�GULYHV��%XW�\RXU�0DF�GRHV�RIIHU�VXSSRUW�
IRU�L&ORXGȇV�GDWD�V\QF��DOORZLQJ�L&ORXG�FRPSDWLEOH�SURJUDPV�WR�VWRUH�WKHLU�GRFXPHQWV�DQG�GDWD�WKHUH�

Set Up a PC

Unlike iOS devices and Macs, your PC doesn’t come with an iCloud preference pane preinstalled—you first have 
to download an iCloud control panel from Apple’s website��<RXU�3&�LV�DOVR�WKH�RQO\�GHYLFH�\RX�FDQȇW�XVH�WR�FUH-
DWH�DQ�L&ORXG�DFFRXQW��VR�\RXȇOO�QHHG�WR�ILUVW�VHW�RQH�XS�RQ�D�0DF�RU�DQ�L26�GHYLFH��

2QFH�WKH�L&ORXG�FRQWURO�SDQHO�ILQLVKHV�GRZQORDGLQJ��LW�DVNV�\RX�WR�VLJQ�LQ�ZLWK�\RXU�$SSOH�Ζ'�DQG�SDVVZRUG�

http://support.apple.com/kb/DL1455?viewlocale=en_US&locale=en_US
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ENTER THE CLOUD Log in to iCloud on your PC with your Apple ID and password.

When you sign in for the first time, you’re asked if you want to send Apple diagnostic and usage information; this 
DOORZV�WKH�FRPSDQ\�WR�DXWRPDWLFDOO\��DQG�DQRQ\PRXVO\��FROOHFW�GDWD�RQ�DQ\�L&ORXG�UHODWHG�FUDVKHV�\RX�H[SHUL-
HQFH��DQG�VHQG�WKDW�GDWD�EDFN�WR�LWV�FHQWUDO�VHUYHUV�WR�SUHYHQW�VLPLODU�FUDVKHV�IURP�KDSSHQLQJ�LQ�WKH�IXWXUH�

<RXU�V\QF�RSWLRQV�IRU�L&ORXG�RQ�WKH�3&�DUH�GUDPDWLFDOO\�OLPLWHG�LQ�FRPSDULVRQ�WR�WKRVH�RQ�ERWK�L26�GHYLFHV�
DQG�WKH�0DF��<RX�FDQ�V\QF�0DLO��LI�\RXȇYH�FUHDWHG�DQ�L&ORXG�FRP�DFFRXQW���&RQWDFWV��&DOHQGDUV��DQG�7DVNV�ZLWK�
2XWORRN��\RXU�:HE�EURZVHU�ERRNPDUNV��DQG�\RXU�3KRWR�6WUHDP��8QIRUWXQDWHO\��WKH�:LQGRZV�RSHUDWLQJ�V\VWHP�
GRHVQȇW�VXSSRUW�V\QFLQJ�ZLWK�DGGLWLRQDO�VHUYLFHV�OLNH�1RWHV��L&ORXG�GDWD�V\QF��%DFN�WR�0\�0DF��RU�)LQG�0\�0DF��
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SIMPLE SYNC You don’t get as many options for syncing iCloud information on Windows 
as you do on the Mac or on iOS.

If you need to change or see your Reminders and Notes, however, you can still access them online via 
L&ORXG�FRP�

Set Up an Apple TV

While your Apple TV doesn’t have access to iCloud’s calendars, reminders, notes, or mail, you can still  
access iCloud features like Photo Stream and iTunes Match when you log in with the Apple ID tied to your 
L&ORXG�DFFRXQW��7R�GR�VR��JR�WR�WKH�6HWWLQJV�VFUHHQ�RI�\RXU�$SSOH�79��FOLFN�iTunes Store, and enter your  
DFFRXQW�LQIRUPDWLRQ�



24

&+$ 3 7 ( 5 �  � �Get Started

Storage in the Cloud
<RXU�IUHH�L&ORXG�DFFRXQW�FRPHV�ZLWK��*%�RI�VWRUDJH��ZKLFK�LW�XVHV�WR�NHHS�D�YDULHW\�RI�GDWD�DFFHVVLEOH�WR�\RX�DW�
DOO�WLPHV��7KLV�GDWD�LQFOXGHV�

ȏ�6\QF�GDWD��<RXU�FDOHQGDUV��UHPLQGHUV��QRWHV��FRQWDFWV��PDLO��:HE�EURZVHU�ERRNPDUNV��DQG�3DVVERRN�SDVVHV�

ȏ�'RFXPHQW�GDWD��$Q\�ILOHV�RU�V\QF�GDWD�IURP�\RXU�L&ORXG�HQDEOHG�DSSV�

ȏ�0RELOH�EDFNXS��$Q\�EDFNXSV�\RX�PDNH�RI�\RXU�L26�GHYLFHV�

<RX�FDQ�YLHZ�HYHU\WKLQJ�L&ORXG�LV�FXUUHQWO\�VWRULQJ�E\�YLVLWLQJ�LWV�VHWWLQJV�VFUHHQ�RQ�\RXU�0DF��3&��RU�L26�GHYLFH��
On a Mac, open System Preferences and select iCloud > Manage; on a PC, open the iCloud control panel and 
click Manage; and on an iOS device, go to Settings > iCloud > Storage & Backup > Manage Storage.

MAXED OUT Curious about what you have stored in iCloud? Take a peek in the Manage 
Storage section of your iCloud settings.

While iCloud manages other aspects of your devices, the following data does not count toward your data limit:

ȏ�3KRWR�6WUHDPV��6KDUHG�3KRWR�6WUHDPV�RU�3KRWR�6WUHDP�SLFWXUHV�H[LVW�RXWVLGH�\RXU�GDWD�SRRO�
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ȏ�0XVLF��0RYLHV��79�6KRZV��%RRNV��$SSV��DQG�L7XQHV�0DWFK�GDWD��$V�L7XQHV�KDV�WR�VWRUH�WKH�FRQWHQW�\RXȇYH�SXU-
FKDVHG�DQ\ZD\ȃLQ�RUGHU�WR�VHOO�LWȃLW�GRHVQȇW�FRXQW�WRZDUG�\RXU��*%�OLPLW��<RXU�XSORDGHG�L7XQHV�0DWFK�WUDFNV�
GRQȇW�ILOO�XS�\RXU�L&ORXG�VWRUDJH�HLWKHU��EHFDXVH�\RX�SD\�VHSDUDWHO\�IRU�WKDW�VHUYLFH�

If you find that you’re running out of space—and if you have more than one device using iCloud, you may 
TXLFNO\�UXQ�LQWR�WKLV�LVVXHȃ\RX�KDYH�WZR�RSWLRQV��%X\�PRUH�VWRUDJH��RU�HOLPLQDWH�VRPH�GDWD�\RXȇUH�VWRULQJ�

Buy More Storage

$SSOH�RIIHUV�VHYHUDO�WLHUV�RI�VWRUDJH�IRU�L&ORXG�FXVWRPHUV�ZKR�QHHG�D�ELW�PRUH�WR�FRYHU�DOO�WKHLU�GHYLFHV��(DFK�
SODQ�LV�D�\HDUO\�FKDUJH��7KH�FKHDSHVW�VWDUWV�DW�����D�\HDU�IRU��*%��)URP�WKHUH��\RX�FDQ�DGG�PRUH�VWRUDJH�DW�D�
UDWH�RI����SHU�JLJDE\WH�SHU�\HDU��LQ���*%�RU���*%�LQFUHPHQWV������RU�����SHU�\HDU��UHVSHFWLYHO\��

EXPAND THE BELT Need more storage? You can easily purchase it right within your 
Settings app.

ΖI�\RX�KDYH�RQH�L26�GHYLFH�DQG�RQH�0DF��WKH�IUHH��*%�DFFRXQW�VKRXOG�XVXDOO\�EH�VXIILFLHQW��6WDUW�DGGLQJ�GHYLFHV��
WKRXJK��DQG�LW�PD\�EH�SUXGHQW�WR�SLFN�XS�D��*%�RU���*%�SODQ��<RX�PD\�DOVR�ZDQW�WR�FRQVLGHU�D��*%�RU���*%�
SODQ�LI�\RX�KDYH�D�ORW�RI�DSSV�WKDW�VWRUH�WKHLU�LQIRUPDWLRQ�LQ�L&ORXG�

To purchase more storage, navigate to the Manage Storage screen on your Mac, PC, or iOS device as described 
above, and click or tap Change Storage Plan. If you’ve previously upgraded to a bigger storage plan and then 
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realized you don’t need quite so much space, you can also downgrade your plan here for a prorated amount 
�EDVHG�RQ�KRZ�PXFK�RI�WKH�\HDU�\RXȇYH�VSHQW�ZLWK�D�ELJJHU�SODQ��

Free Up iCloud Storage

0D\EH�\RXȇUH�QRW�LQWHUHVWHG�LQ�SRQ\LQJ�XS�H[WUD�FDVK�IRU�L&ORXG�VWRUDJH��EXW�\RX�KDYH�D�ORW�RI�L&ORXG� 
compatible apps or multiple iOS devices and you’re finding that you’re rapidly running through that free 
�*%��6RPH�XVHUV�ILQG�WKH\�FDQȇW�HYHQ�EDFN�XS�PRUH�WKDQ�RQH�L26�GHYLFH�WR�L&ORXG��EHFDXVH�WKH\�GRQȇW�KDYH�
HQRXJK�URRP��

Does that mean you need to either pay for more storage or revert to old-fashioned iTunes backups? Not neces-
VDULO\��ΖQVWHDG��\RX�VKRXOG�H[HUFLVH�D�OLWWOH�H[WUD�FRQWURO�RYHU�KRZ�\RX�VWRUH�LWHPV�LQ�L&ORXG�IRU�VDIHNHHSLQJ�DQG��
PRUH�VSHFLILFDOO\��ZKDW�\RX�VHQG�WR�LW�

To start, on your iOS device, go to Settings > iCloud > Storage & Backup. On the screen that appears, you’ll see 
WKH�WRWDO�DPRXQW�RI�VWRUDJH�VSDFH�\RX�KDYH�RQ�L&ORXG���*%�LI�\RX�KDYHQȇW�XSJUDGHG���DORQJ�ZLWK�WKH�DPRXQW�RI�
XQXVHG�VSDFH��%HQHDWK�WKDW�LV�D�0DQDJH�6WRUDJH�EXWWRQ��6HOHFW�LW�

At the top of the subsequent Manage Storage screen, you’ll see a list of all the iOS devices you’re backing up 
WR�L&ORXG��LQFOXGLQJ�WKH�RQH�\RXȇUH�FXUUHQWO\�XVLQJ��([DPLQH�WKH�OLVW�FORVHO\��ΖI�LW�FODLPV�WKDW�\RXȇUH�VWRULQJ��VD\��
DQ�ROG�L3KRQH��*6�\RX�KDYHQȇW�XVHG�LQ�D�IHZ�\HDUV��\RXȇOO�ZDQW�WR�GHOHWH�LWV�EDFNXS�VR�WKDW�LW�VWRSV�JREEOLQJ�
XS�\RXU�SUHFLRXV�VWRUDJH�VSDFH��7DS�WKH�XQQHHGHG�GHYLFHȇV�QDPH��DQG�WKHQ�WDS�WKH�UHG�Delete Backup button 
WKDW�DSSHDUV�

TOO MANY BACKUPS If iCloud is still storing backups from devices you no longer own, 
you can easily get rid of them.
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If you tap the name of the device you’re currently using, you reach a screen offering fine control over each 
LWHP�DQG�FDWHJRU\�\RXȇUH�EDFNLQJ�XS�IRU�WKDW�GHYLFH��2Q�WKLV�VFUHHQ��\RXȇOO�VHH�WKH�FXUUHQW�VL]H�RI�\RXU�GHYLFHȇV�
EDFNXS��DORQJ�ZLWK�DQ�HVWLPDWH�RI�KRZ�ODUJH�\RXU�QH[W�EDFNXS�ZLOO�EH��%HORZ�WKDW��\RXȇOO�VHH�D�OLVW�RI�DSSV�WKDW�
FDQ�EDFN�XS�WKHLU�GDWD�WR�L&ORXG�

ROLL BACK THE CAMERA ROLL�:LWK�RQH�H[FHSWLRQ��WKH�OLVW�DSSHDUV�RUGHUHG�E\�KRZ�PXFK�VSDFH�HDFK�DSS�
UHTXLUHV�WR�EDFN�XS�LWV�GDWD�LQ�L&ORXG��ZLWK�WKH�ODUJHVW�DPRXQW�DW�WKH�WRS��7KH�RQH�H[FHSWLRQ��&DPHUD�5ROO�LV�
DOZD\V�ILUVW��HYHQ�LI�LW�LVQȇW�WKH�ELJJHVW�LWHP�RQ�WKH�OLVW��WKRXJK�LW�RIWHQ�LV�ȃRQH�Macworld contributor’s iPhone 
&DPHUD�5ROO�DFFRXQWHG�IRU��*%�RI�D���*%�EDFNXS��

%\�GHIDXOW��L&ORXG�EDFNV�XS�WKH�&DPHUD�5ROO�RQ�HDFK�RI�\RXU�L26�GHYLFHV��7KDW�ZD\��LI�\RXU�L3KRQH�FURDNV��
FKRNHV��RU�RWKHUZLVH�JLYHV�XS�WKH�JKRVW��\RX�FDQ�UHVWRUH�IURP�L&ORXG�DQG�JHW�DOO�\RXU�SKRWRV�DQG�YLGHRV�EDFN��
Tapping to turn off the Camera Roll, however, brings up an intimidating question: ‘Do you want to turn off Cam-
era Roll backups and delete the backup data from iCloud?’

EXCISE IMAGES Though this warning seems a bit scary, if you have Photo Stream, you 
can probably turn off Camera Roll backups.

If you choose Turn Off & Delete��\RX�DUHQȇW�GHOHWLQJ�WKRVH�YLVXDO�PHPRULHV�IURP�\RXU�GHYLFH��<RXȇUH�VLPSO\�IUHH-
ing up the iCloud backup space they consume, and removing the ability to restore those photos from iCloud 
VKRXOG�GLVDVWHU�VWULNH�\RXU�L26�GHYLFH�

7KDW�LVQȇW�QHFHVVDULO\�DV�ULVN\�D�PRYH�DV�LW�VRXQGV��:KHQHYHU�\RX�FRQQHFW�\RXU�L26�GHYLFH�WR�\RXU�0DF��\RX�FDQ�
EDFN�XS�LWV�VDYHG�SKRWRV�DQG�YLGHRV�WR�L3KRWR��%XW�HYHQ�LI�\RX�UDUHO\ȃRU�QHYHUȃV\QF�\RXU�L26�GHYLFHV�RYHU�
86%��\RX�SUREDEO\�GRQȇW�QHHG�L&ORXG�WR�EDFN�XS�\RXU�SKRWRV��WKDQNV�WR�3KRWR�6WUHDP��ZKLFK�NHHSV�WKH�ODVW�����
SKRWRV�\RX�VQDSSHG�RYHU�WKH�SDVW����GD\V��6LQFH�WKH�L&ORXG�&DPHUD�5ROO�EDFNXS�LV�UHDOO\�WKHUH�RQO\�LQ�FDVH�
RI�HPHUJHQF\��DQG�\RXȇUH�OLNHO\�WR�QRWLFH�D�PDMRU�HPHUJHQF\�LQYROYLQJ�\RXU�L26�GHYLFH�LQ�IHZHU�WKDQ����GD\V��
\RX�FDQ�JHQHUDOO\�WUXVW�WKDW�\RXU�SKRWRV�DUH�VDIH�HYHQ�LI�\RXȇUH�QRW�EDFNLQJ�WKHP�XS�WR�L&ORXG�GLUHFWO\���3KRWR�
6WUHDP�SKRWRV�GRQȇW�FRXQW�DJDLQVW�\RXU��*%�L&ORXG�TXRWD��
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Merely turning off the Camera Roll backup will shave off a significant chunk of your iOS device backups, and it 
PD\�EH�HQRXJK�WR�DOORZ�\RX�WR�EDFN�XS�DOO�RI�\RXU�L26�GHYLFHV�ZLWKRXW�EXVWLQJ�WKH��*%�FDS��%XW�RWKHU�RSWLRQV�
FDQ�DOVR�IUHH�XS�\RXU�VWRUDJH�VSDFH�

TRIM THE APP FAT Depending on how you use your iOS device, you’ll likely want to continue allowing some 
DSSV�WR�EDFN�XS�WKHLU�GDWD�WR�L&ORXG��ΖI�\RX�IUHTXHQWO\�FUHDWH�GRFXPHQWV�LQ�DQ�L26�WH[W�HGLWRU�RU�FRPSRVH�
VRQJV�LQ�*DUDJH%DQG��DQG�\RX�GRQȇW�UHJXODUO\�EDFN�WKRVH�XS�RU�H[SRUW�WKHP��\RX�VKRXOG�XVH�L&ORXG�EDFNXS�
IRU�WKRVH�DSSV�

ELIMINATE APPS You can cut down on the size of your backups by telling iCloud to not 
back up certain apps.

%XW�\RX�SUREDEO\�GRQȇW�QHHG�WR�XVH�L&ORXG�WR�EDFN�XS�GDWD�IURP�HYHU\�DSS�\RX�XVH��(YHQ�LI�PRVW�RI�WKRVH�DSSV�
DFFRXQW�IRU�RQO\�D�IHZ�PHJDE\WHV�SHU�EDFNXS��WKH\�FDQ�DGG�XS�WR�D�VLJQLILFDQW�FKXQN�RI�VWRUDJH��)RU�H[DPSOH��
you might disable iBooks’ iCloud backup, since you can always restore your iBooks purchases within the iBook-
VWRUH��RU�IURP�L7XQHV�RQ�\RXU�FRPSXWHU���

<RX�DOVR�OLNHO\�GRQȇW�QHHG�WR�EDFN�XS�\RXU�GDWD�IRU�JDPHV�LI�\RX�GRQȇW�FDUH�DERXW�LQ�JDPH�SURJUHVV�RU�FXV-
WRPL]DWLRQV��$QG�EDFNXS�PLJKW�EH�XQQHFHVVDU\�IRU�DSSV�WKDW�V\QF�DQG�EDFN�XS�WKHLU�GDWD�RQ�WKH�:HE��VXFK�
DV�ΖQVWDSDSHU�
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&DUHIXO��WKRXJK��'RQȇW�WXUQ�WKLQJV�RII�ZLOO\�QLOO\��)RU�H[DPSOH��\RX�PLJKW�WKLQN��Ȋ+H\��Ζ�GRQȇW�QHHG�WR�EDFN�XS�P\�
GDWD�IURP�WKH�&DUGV�DSS�ȋ�$QG�\RX�PD\�ZHOO�EH�ULJKW��%XW�\RXȇG�EH�FUXVKHG�WR�OHDUQ�DIWHU�DQ�L&ORXG�UHVWRUH�WKDW�
DOO�\RXU�ROG�SKRWR�FDUGV�DUH�QRZ�EXW�D�PHPRU\�

DOCUMENTS & DATA, MAIL On the main Manage Storage screen, past the list of your devices, you’ll see two 
RWKHU�VHFWLRQV��'RFXPHQWV�	�'DWD��DQG�0DLO�

TRIM TRAPPINGS Storing iCloud data for apps you no longer use? Remove it here.

7KH�'RFXPHQWV�	�'DWD�VHFWLRQ�UHIHUV�WR�DOO�WKRVH�ELWV�RI�GDWD�WKDW�L&ORXG�V\QFV�EHWZHHQ�\RXU�GHYLFHV��7KLV�GDWD�
FRXQWV�DJDLQVW�\RXU�L&ORXG�VWRUDJH�DOORWPHQW�

ΖQ�DGGLWLRQ��WKLV�VHFWLRQ�OLVWV�V\QFHG�GDWD�IURP�L&ORXG�OHYHUDJLQJ�DSSV�DQG�JDPHV��2Q�RQH�Macworld editor’s 
iPhone, that list includes Apple’s Pages, Passbook, and Keynote, and Big Bucket Software’s The Incident��&HUWDLQ�
DSSV�PDNH�WKH�FXW�EHFDXVH�WKH\�GRQȇW�XVH�PXFK�GDWD��7KH�ΖQFLGHQW��IRU�LQVWDQFH��FRQVXPHV�D�VLQJOH�NLORE\WH��
2WKHU�DSSV��OLNH�3DJHV��PD\�WDNH�XS�PDQ\�PHJDE\WHV��RU�PRUH���\RX�FDQ�WDS�DQ�DSS�WR�JHW�D�OLVW�RI�DOO�LWV�GRFX-
PHQWV�VDYHG�LQ�&ORXG��DORQJ�ZLWK�WKH�DPRXQW�RI�VSDFH�WKH\ȇUH�WDNLQJ�XS��ΖI�\RX�QRWLFH�ILOHV�\RX�QR�ORQJHU�QHHG��
FOHDQ�WKHP�RXW�

https://itunes.apple.com/us/app/pages/id361309726
https://itunes.apple.com/us/app/keynote/id361285480?mt=8
https://itunes.apple.com/us/app/the-incident/id385533456?mt=8
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<RX�FDQȇW�GHOHWH�\RXU�0DLO�VWRUDJH�WKH�VDPH�ZD\�\RX�FDQ�GHOHWH�DSSV�DQG�EDFNXSV��XQIRUWXQDWHO\��%XW�\RX�FDQ�
PDQXDOO\�SUXQH�PDLO�IURP�\RXU�L&ORXG�DFFRXQW��ΖI�\RX�GRQȇW�UHJXODUO\�DUFKLYH�HPDLO�RIIOLQH��SUXQH�DWWDFKPHQWV��
DQG�GHOHWH�MXQN�DQG�VSDP��0DLO�PD\�JREEOH�XS�DQ�LQFUHDVLQJO\�ODUJH�SHUFHQWDJH�RI�\RXU�L&ORXG�TXRWD�



�

Work With iCloud

GET TO WORK iCloud offers a bevy of delightful features to help you sync, share, back 
up, and groove to great tunes.

iCloud is chock-full of features for syncing, sharing photos, listening to music, reading, backing up your devices, 
KDQJLQJ�RXW�ZLWK�IULHQGV��DQG�PRUH��:H�RIIHUHG�D�EULHI�RYHUYLHZ�RI�WKH�VHUYLFHȇV�YDULRXV�EHOOV�DQG�ZKLVWOHV�LQ�WKH�
ILUVW�FKDSWHU��LQ�WKLV�RQH��ZH�JHW�GRZQ�WR�EXVLQHVV��/HDUQ�KRZ�WR�PDVWHU�L&ORXGȇV�V\QFLQJ�FRPSRQHQWV��SHUIRUP�
D�SHUIHFW�L26�EDFNXS��GLVFRYHU�WKH�LQV�DQG�RXWV�RI�)LQG�0\�L3KRQH��)LQG�0\�)ULHQGV��DQG�%DFN�WR�0\�0DF��DQG�
OLVWHQ�WR�L7XQHV�LQ�WKH�&ORXG�

C H A P T E R  2
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Sync Your Data and Documents
Once you have iCloud set up on your devices, you can take advantage of the service’s syncing and storage capa-
ELOLWLHV��:KHQHYHU�\RX�PDNH�D�FKDQJH�ZLWKLQ�DQ�L&ORXG�VXSSRUWHG�DSSOLFDWLRQ��\RXU�GDWD�LV�VHDPOHVVO\�SXVKHG�
across all of your devices; you won’t actively have to choose when you want to sync your device or what you 
ZDQW�WR�V\QF��ΖQVWHDG��\RXU�GDWD�LV�DXWRPDWLFDOO\�VWRUHG�LQ�L&ORXG��DQG�\RXU�L26�GHYLFHV�V\QF�WR�DQG�SXOO�LQIRU-
PDWLRQ�IURP�WKLV�FHQWUDO�VHUYHU�RQ�D�UHJXODU�EDVLV��NHHSLQJ�HYHU\WKLQJ�XS�WR�GDWH�

How Does Syncing Work?

'RQȇW�SDQLF��7KLV�ERRN�GRHVQȇW�JR�LQWR�QLWW\�JULWW\�H[SODQDWLRQV�DERXW�RQOLQH�VWRUDJH�DQG�SXVK�VHUYHUV��ΖQVWHDG��
ZHȇOO�RXWOLQH�WKH�EDVLFV�RI�KRZ�$SSOHȇV�L&ORXG�V\QF�SURFHVV�ZRUNV��ΖWȇV�D�IDLUO\�VLPSOH�DQG��XVXDOO\��VHDPOHVV�
SURFHVV��

6WHS���<RX�DGG�RU�FKDQJH�D�UHPLQGHU�RQ�\RXU�L3KRQH�

6WHS����ΖI�\RXU�L3KRQH�KDV�D�QHWZRUN�FRQQHFWLRQ��WKDW�FKDQJH�JRHV�XS�WR�WKH�FHQWUDO�L&ORXG�VHUYHU���ΖI��IRU�ZKDW-
ever reason, you don’t have a network connection when you first make an edit, your iPhone stores the change 
ORFDOO\�XQWLO�LW�FDQ�V\QF�ZLWK�L&ORXG�DJDLQ�

6WHS����L&ORXG�FRQILUPV�WKDW�WKLV�LV�WKH�QHZHVW�FKDQJH�RU�DGGLWLRQ�PDGH�WR�WKDW�UHPLQGHU�OLVW�

6WHS����7KH�VHUYHU�PDNHV�WKH�FKDQJH�WR�L&ORXG�FRP��DQG�WKHQ�VHQGV�WKDW�FKDQJH�GRZQ�WR�DOO�RI�\RXU�RWKHU�
L&ORXG�FRQQHFWHG�GHYLFHV�

7KLV�DOO�WDNHV�SODFH�EHKLQG�WKH�VFHQHV�DQG�ZLWKLQ�VHFRQGV�RI�\RXU�LQLWLDO�FKDQJH��

Ȋ%XW�ZKDW�LI�ȋ�\RX�PLJKW�DVN��ȊΖȇP�FKDQJLQJ�WKH�VDPH�UHPLQGHU�RQ�ERWK�P\�FRPSXWHU�and my phone?” While it’s 
not the best idea to do that, iCloud tries to handle near-simultaneous changes by syncing them in the order in 
ZKLFK�LW�JHWV�WKHP��ZLWK�WKH�PRVW�UHFHQW�FKDQJH�V\QFHG�ODVW��)RU�H[DPSOH��LI�\RX�DGG�Ȇ0LONȇ�WR�\RXU�JURFHU\�OLVW�
on your computer, and then immediately add ‘Eggs’ to your iPhone list before iCloud has had a chance to sync, 
L&ORXG�ZLOO�DGG�ILUVW�Ȇ0LONȇ�DQG�WKHQ�Ȇ(JJVȇ�WR�\RXU�OLVW�RQ�L&ORXG�FRP��1H[W��LW�ZLOO�DGG�Ȇ0LONȇ�WR�\RXU�L3KRQH�OLVW�
DERYH�WKH�Ȇ(JJVȇ�LWHP��)LQDOO\��LW�ZLOO�DGG�Ȇ(JJVȇ�WR�\RXU�0DFȇV�JURFHU\�OLVW�
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GROCERY JUMBLE iCloud tries to sync your items in the order in which it receives them, 
but it can goof up if you try making too many nearly simultaneous changes on various 

devices.

That said, any sync service—iCloud included—can get tetchy if you try changing multiple records or the same 
UHFRUG�LQ�PXOWLSOH�SODFHV��L&ORXG�ZLOO�WU\�LWV�EHVW�WR�UHFRQFLOH�\RXU�ZLVKHV��EXW�\RX�PLJKW�RFFDVLRQDOO\�HQG�
XS�ZLWK�GXSOLFDWH�OLVW�HQWULHV��HYHQWV��RU�QRWHV���6HH�ȊSyncingȋ�LQ�WKH�Ȋ7URXEOHVKRRW�L&ORXGȋ�FKDSWHU�IRU�PRUH�
LQIRUPDWLRQ��

What Can I Sync?

$V�PHQWLRQHG�LQ�ȊSync and Shareȋ�LQ�WKH�Ȋ*HW�6WDUWHGȋ�FKDSWHU��L&ORXGȇV�GRFXPHQW�DQG�GDWD�V\QF�PDNHV� 
XS�D�ODUJH�SRUWLRQ�RI�WKH�VHUYLFH��<RX�UHFHLYH�IXOO�V\QF�VXSSRUW�DFURVV�DOO�GHYLFHV��0DF��3&��DQG�L26��IRU�\RXU� 
L&ORXG�FRP�HPDLO��FRQWDFWV��FDOHQGDUV��UHPLQGHUV��DQG�QRWHV��DQG�WKDW�GDWD�DOVR�DSSHDUV�ZKHQ�\RX�ORJ�LQ� 
WR�L&ORXG�FRP��'HSHQGLQJ�RQ�\RXU�GHYLFH��\RX�FDQ�DOVR�V\QF�6DIDUL�ERRNPDUNV�DQG�RSHQ�WDEV��3DVVERRN�SDVVHV��
DQG�DSS�GRFXPHQWV�DQG�GDWD�

Each feature your device supports is listed in the iCloud preference screen; from there, you get to choose what 
LWHPV�\RX�ZDQW�WKH�VHUYLFH�WR�VWRUH��)RU�LQVWDQFH��LI�\RX�HQDEOH�FRQWDFWV�V\QF�IRU�\RXU�L3KRQH��ZKHQHYHU�\RX�
HQWHU�D�QHZ�FRQWDFW�WKHUH��LW�DXWRPDWLFDOO\�JHWV�SXVKHG�WR�L&ORXG�FRP�DQG�DQ\�RWKHU�GHYLFHV�\RX�KDYH�VHW�XS�WR�
DOORZ�FRQWDFW�V\QFLQJ�

MAIL, CALENDARS, CONTACTS, REMINDERS, AND NOTES These five areas are part of iCloud’s core sync pro-
gram; they are the only ones that can be synced across all iCloud-supported platforms and thus the only ones 
YLHZDEOH�RQ�L&ORXG�FRP�
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On the Mac and iOS, these areas sync to the programs of the same name—your email syncs to Mail, calendars 
WR�&DOHQGDU��FRQWDFWV�WR�WKH�&RQWDFWV�DSS��DQG�VR�RQ��2Q�D�3&��L&ORXG�V\QFV�ZLWK�2XWORRN������RU�ODWHU��

SWITCHED ON Most of your iCloud features are enabled by default, though you can turn 
them off at any time.

When you first set up your iCloud account, these features are on by default; that means when you check off a 
UHPLQGHU�RQ�\RXU�L3KRQH��WKDW�UHPLQGHU�ZLOO�DOVR�VKRZ�XS�DV�FRPSOHWHG�RQ�\RXU�0DF��DVVXPLQJ�\RXȇYH�VHW�XS�
WKH�VHUYLFH�RQ�ERWK�0DF�DQG�L3KRQH���$OO�RI�WKLV�VWRUHG�GDWD�FRXQWV�WRZDUG�\RXU��*%�VWRUDJH�OLPLW��VHH�ȊStorage 
in the Cloudȋ�LQ�Ȋ*HW�6WDUWHGȋ�IRU�PRUH�LQIRUPDWLRQ��

If for any reason you don’t want to sync certain data—your contacts, or your calendars—you can turn off sync-
ing by going to System Preferences > iCloud��RQ�\RXU�0DF��RU�Settings > iCloud �RQ�L26��DQG�XQFKHFNLQJ�WKH�ER[HV�
RU�WXUQLQJ�RII�WKH�WRJJOHV�IRU�WKH�DSSURSULDWH�VHOHFWLRQV�

SAFARI BOOKMARKS, READING LIST, AND iCLOUD TABS Available for iOS and Mac users only, the Safari  
RSWLRQ�OHWV�\RX�V\QF�ERRNPDUNV��\RXU�5HDGLQJ�/LVW��DQG�RSHQ�WDEV�DQG�ZLQGRZV��ZKLFK�$SSOH�UHIHUV�WR�DV�L&ORXG�
WDEV���7KLV�GDWD�GRHVQȇW�JR�WR�L&ORXG�FRP��LQVWHDG��LW�JHWV�V\QFHG�GLUHFWO\�EHWZHHQ�GHYLFHV�

%RRNPDUNV�DQG�5HDGLQJ�/LVW�DUH�IDLUO\�VWUDLJKWIRUZDUG��$GG�D�QHZ�ERRNPDUN�WR�\RXU�EURZVHU��RU�DQ�DUWLFOH�WR�
\RXU�5HDGLQJ�/LVW��DQG�WKDW�FKDQJH�JHWV�SXVKHG�WR�DOO�\RXU�RWKHU�GHYLFHV�ZLWKLQ�PRPHQWV�

If you’ve ever found yourself viewing a webpage in Safari on your iPhone and wanting to instead view it on the 
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larger screen of your iPad or Mac—or, conversely, reading an article on your Mac and wanting to transfer it to 
\RXU�L3KRQH�DV�\RX�ZDON�RXW�WKH�GRRUȃL&ORXG�7DEV�LV�IRU�\RX��ΖQVWHDG�RI�HPDLOLQJ�85/V�WR�\RXUVHOI��\RX�FDQ�MXVW�
WDS�WKH�L&ORXG�7DEV�EXWWRQ�DQG�JUDE�WKH�85/�IURP�\RXU�RWKHU�GHYLFH�

TAB SYNC iCloud Tabs automatically syncs tabs between all your iCloud-enabled devices 
and computers.

L&ORXG�V\QFV�DQ\�WDEV�RU�ZLQGRZV�RSHQ�RQ�DQ\�RI�\RXU�GHYLFHVȃDVVXPLQJ�WKH\�KDYH�ΖQWHUQHW�DFFHVV��2Q�\RXU�
iPhone or iPad, you access synced tabs by tapping Safari’s Bookmarks button, and then tapping iCloud Tabs.��ΖI�
you’re already in a sublist in the Bookmarks list, tap the left-facing arrow until you get to the top level, titled 
%RRNPDUNV���7DEV�DUH�JURXSHG�E\�GHYLFH��DQG�HDFK�WDEȇV�HQWU\�VKRZV�WKH�QDPH�RI�WKH�ZHESDJH�DQG�LWV�85/��WDS�
DQ\�LWHP�LQ�WKH�OLVW�WR�RSHQ�WKDW�ZHESDJH�RQ�\RXU�GHYLFH��

On your Mac, you access synced tabs by clicking the iCloud Tabs button—which looks like a cloud—in Safari’s 
WRROEDU��7DEV�DUH�VLPLODUO\�JURXSHG�E\�GHYLFH��DOWKRXJK�RQ�WKH�0DF�WKH\�RQO\�GLVSOD\�WKH�ZHEVLWHȇV�WLWOH�LQVWHDG�
RI�ERWK�LWV�WLWOH�DQG�LWV�85/�

PASSBOOK Designed for the iPhone and iPod touch, Apple’s mobile wallet app stores boarding passes, event 
WLFNHWV��FXVWRPHU�OR\DOW\�FDUGV��FRXSRQV��PRYLH�WLFNHWV��DQG�RWKHU�DVVRUWHG�SDVVHV�DQG�FDUGV�LQ�RQH�ORFDWLRQ��
Whenever you pick up a pass, ticket, or coupon, your iCloud account automatically uploads these to the ser-
YLFHȇV�FHQWUDO�VHUYHU�
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PASSED UP Your Passbook passes are stored in iCloud and can sync with your iPhone 
and iPod touch.

While you can technically sync Passbook with other devices, the only ones available are the iPhone and iPod 
WRXFKȃZKLFK�PHDQV�WKDW�DV�DQ�L3KRQH�RZQHU��\RXȇG�QHHG�WR�DOVR�RZQ�DQ�L3RG�WRXFK��RU�WZR�L3KRQHV��WR�WDNH�
DGYDQWDJH�RI�WKLV��%XW�LI�\RXȇUH�JLYLQJ�\RXU�GDXJKWHU�PRYLH�WLFNHWV��IRU�H[DPSOH��WKH�V\QF�IHDWXUH�PLJKW�EH�XVHIXO�

At the least, you’ll have all your Passbook information stored in iCloud, so you won’t lose it should something go 
DZU\�ZLWK�\RXU�SKRQH�

PHOTO STREAM With Photo Stream, you can snap a picture from any iOS device—or upload a photo to your 
0DF�RU�3&ȃDQG�KDYH�LW�SXVKHG�WR�DOO�\RXU�RWKHU�GHYLFHV�DQG�FRPSXWHUV��<RX�FDQ�DOVR�FUHDWH�6KDUHG�3KRWR�
6WUHDPV��ZKLFK�DOORZ�\RX�WR�FROOHFW�DQG�VHQG�DOEXPV�RI�LPDJHV�WR�\RXU�IULHQGV�DQG�IDPLO\�

On iOS devices, iCloud syncs your Photo Stream to the Photos app, under the Photo Stream tab; on a Mac, 
you use iPhoto or Aperture; and on a PC, you must choose a folder on your hard drive to use as your Picture 
/LEUDU\��7KH�$SSOH�79�FDQ�YLHZ�\RXU�3KRWR�6WUHDP��EXW�\RX�FDQȇW�XSORDG�LPDJHV�WR�LW�IURP�WKH�GHYLFH��DV�WKHUHȇV�
QR�DFWXDO�ZD\�WR�DGG�SKRWRV�WR�WKH�$SSOH�79��
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$V�PHQWLRQHG�LQ�ȊSync and Shareȋ�LQ�WKH�Ȋ*HW�6WDUWHGȋ�FKDSWHU��3KRWR�6WUHDP�NHHSV�D�FRS\�RI�WKH�ODVW�����
photos snapped on your iOS device or uploaded to your Mac or PC; these photos are stored on iCloud’s central 
VHUYHUV�IRU����GD\V��<RXU�FRPSXWHU�DXWRPDWLFDOO\�GRZQORDGV�DQ\�QHZ�V\QFHG�SKRWRV�WR�\RXU�FKRVHQ�SKRWRJ-
UDSK\�SURJUDP��RU�WR�\RXU�GHVLJQDWHG�SKRWR�OLEUDU\�IROGHU��ΖQ�L3KRWR��WKH�SKRWRV�DSSHDU�XQGHU�(YHQWV��ZLWK�D�
GHIDXOW�QDPH�WKDW�LQFOXGHV�WKH�PRQWK�DQG�\HDU��DORQJ�ZLWK�3KRWR�6WUHDP��<RX�FDQ��KRZHYHU��FKDQJH�WKH�HYHQW�
QDPH��RU�UHRUJDQL]H�WKRVH�LPDJHV�DQG�SXW�WKHP�HOVHZKHUH�

iOS devices, in contrast, won’t automatically download full-quality Photo Stream images to your phone—they’re 
RQO\�DYDLODEOH�IRU�YLHZLQJ��ΖI�\RX�ZDQW�WR�HGLW�DQ�LPDJH�RU�VDYH�D�KDUG�FRS\�RI�LW��\RX�PXVW�ILUVW�GRZQORDG�LW�E\�
going to Photos > Photo Stream, selecting the appropriate photo, and then tapping Share > Save to Camera Roll.

<RX�FDQ�GHOHWH�LQGLYLGXDO�3KRWR�6WUHDP�LPDJHV�IURP�L&ORXG�YLD�\RXU�L26�GHYLFH��-XVW�JR�WR�Photos > Photo 
Stream, tap the image in question, and tap the Trash�EXWWRQ��<RX�FDQ�DOVR�GHOHWH�PXOWLSOH�LPDJHV�E\�JRLQJ�WR�
Photos > Photo Stream, tapping the Edit�EXWWRQ��DQG�WKHQ�VHOHFWLQJ�WKH�LPDJHV�\RX�ZLVK�WR�GHOHWH��<RX�FDQ�GHOHWH�
Photo Stream images from iCloud via your Mac by opening iPhoto and selecting Photo Stream, and then choos-
LQJ�WKH�SKRWR�V��\RX�ZLVK�WR�GHOHWH�

DELETE! DELETE! If you have an image you don’t want stored on iCloud and pushed to 
your other devices, you can delete it from your Photo Stream.

<RX�FDQȇW�GHOHWH�LQGLYLGXDO�3KRWR�6WUHDP�LPDJHV�IURP�D�3&��WKRXJK�\RX�FDQ�FOHDU�\RXU�HQWLUH�3KRWR�6WUHDP�
RQOLQH�E\�ORJJLQJ�LQ�WR�L&ORXG�FRP��FOLFNLQJ�\RXU�QDPH�LQ�WKH�WRS�ULJKW�FRUQHU�WR�EULQJ�XS�\RXU�$FFRXQW�SUHIHU-
ences, selecting Advanced, and then clicking Reset Photo Stream.

If you want to share images in your library with friends—whether you’ve added them to Photo Stream or not—
\RX�FDQ�FUHDWH�D�6KDUHG�3KRWR�6WUHDP�RQ�\RXU�0DF�RU�L26�GHYLFH��IURP�L3KRWR�RU�WKH�3KRWRV�DSS��UHVSHFWLYHO\��

On your Mac, select the images you want to share, click the Share button, and then click Photo Stream.�)URP�
KHUH��\RX�FDQ�FUHDWH�D�QHZ�6KDUHG�3KRWR�6WUHDP��RU�DGG�LW�WR�D�6KDUHG�3KRWR�6WUHDP�\RXȇYH�DOUHDG\�FUHDWHG��

Create a new stream, and you’ll need to choose whom to send it to and whether you want to make the images 
DYDLODEOH�RQ�WKH�:HE��)ULHQGV�ZKR�KDYH�L&ORXG�ZLOO�VHH�WKH�VKDUHG�VWUHDP�SRS�XS�LQ�WKH�3KRWR�6WUHDP�VHFWLRQ�
RI�L3KRWR�RU�WKH�3KRWRV�DSS�RQ�L26��WKRVH�ZLWKRXW�DQ�L&ORXG�DFFRXQW�FDQ�YLHZ�WKH�LPDJHV�RQ�WKH�:HE�
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SHARE THE STREAM You can create a new Shared Photo Stream from iPhoto or from the 
Photos app on your iOS device.

<RX�FDQ�DOVR�HDVLO\�FUHDWH�D�6KDUHG�3KRWR�6WUHDP�RQ�\RXU�L3KRQH��L3RG�WRXFK��RU�L3DG�E\�VHOHFWLQJ�WKH�LPDJHV�
you want, and then tapping Share > Photo Stream�

After you make a Shared Photo Stream, your recipients can comment on or like your photo, and even save it to 
WKHLU�RZQ�FRPSXWHU�RU�L26�GHYLFH�

DOCUMENTS & DATA�7KLV�WRJJOH�FRQWUROV�WKH�ZLUHOHVV�V\QF�DQG�VWRUDJH�RI�DOO�L&ORXG�HQDEOHG�DSSV��6RPHWLPHV�
referred to by Apple as Documents in the Cloud, Documents & Data keeps your app information ubiquitous 
across all your iOS devices and computers, allowing you to create a document on one device, save it, and pick 
XS�ZKHUH�\RX�OHIW�RII�VRPHZKHUH�HOVH��

$FFHVVLQJ�GRFXPHQWV�EHWZHHQ�L26�GHYLFHV�LV�VHDPOHVV��6D\�\RX�VWDUWHG�D�1XPEHUV�VSUHDGVKHHW�RQ�\RXU�L3DG��
you could start entering information, save that spreadsheet, and open it up later on your iPhone to do some 
WZHDNLQJ��<RX�FDQ�DFFHVV�\RXU�SURMHFWV�DFURVV�DOO�\RXU�L26�GHYLFHV��DQG��LI�WKH�DSS�LQ�TXHVWLRQ�VXSSRUWV�26�;��
WKH�0DF���VR�LWȇV�QRW�QHFHVVDU\�WR�ILOH�VKDUH�RU�HPDLO�FRSLHV�WR�\RXUVHOI��'RFXPHQWV�	�'DWD�ZLOO�DXWRPDWLFDOO\�
V\QF�\RXU�GRFXPHQWV�WKURXJK�L&ORXG��VR�\RX�FDQ�DFFHVV�WKHP�RQ�DOO�RI�\RXU�L26�GHYLFHV�
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$SSOHȇV�RZQ�$SS�6WRUH�DSSV��VXFK�DV�WKH����Pages, Keynote, Numbers��DQG����iPhoto, among others) use 
WKLV�IXQFWLRQDOLW\��DV�GR�WKLUG�SDUW\�DSSV�OLNH�$JLOH%LWVȇ����3DVVZRUG��7DERWVȇ����Tweetbot, and Autodesk’s 
���SketchBook Pro��8VLQJ�L&ORXG�LQ�DSSV�WKDW�VXSSRUW�LW�LV�VLPSOH�DV�FDQ�EH��-XVW�IOLS�WKH�'RFXPHQWV�	�'DWD�
VZLWFK�RQ�LQ�L&ORXG�VHWWLQJV��7KHQ��ZKHQ�\RX�GRZQORDG�DQ�L&ORXG�HQDEOHG�DSS��LW�VKRXOG�SURPSW�\RX�WR�XVH�
WKH�VHUYLFH�WR�VWRUH�GRFXPHQWV�RU�GDWD���ΖI�WKH�DSS�GRHVQȇW�DVN�\RX�DERXW�L&ORXG�IXQFWLRQDOLW\�DXWRPDWLFDOO\��
\RX�PD\�QHHG�WR�WXUQ�RQ�D�VHWWLQJ�LQ�LWV�SUHIHUHQFHV��

If you ever want to delete an app’s iCloud information, on an iOS device, select Storage & Backup > Manage Stor-
age > Documents & Data; on a Mac or PC, go to the iCloud preference pane or control panel and click the Manage 
EXWWRQ���)RU�PRUH�LQIRUPDWLRQ�DERXW�PDQDJLQJ�VWRUDJH��VHH�ȊStorage in the Cloudȋ�LQ�WKH�Ȋ*HW�6WDUWHGȋ�FKDSWHU��

Use Documents & Data Sync With iWork for iOS

$V�PHQWLRQHG�LQ�WKH�SUHYLRXV�VHFWLRQ��$SSOH�XVHV�'RFXPHQWV�	�'DWD�V\QF�IRU�LWV�L:RUN�SURGXFWLYLW\�VXLWH��3DJHV��
1XPEHUV��DQG�.H\QRWH��RQ�L26�DQG�RQ�WKH�0DF��7KH�SURFHVV�LV�YHU\�VLPLODU�LQ�DOO�WKUHH�L:RUN�DSSV��WKRXJK�ZHȇOO�
XVH�3DJHV�RQ�L26�DV�DQ�H[DPSOH�

TURN IT ON AGAIN To turn iCloud sync on and off, visit the Pages preference screen in 
the Settings app.

If it’s your first time launching Pages, or your first time launching the app after updating to the latest version, 
\RX�PD\�VHH�D�SURPSW�DVNLQJ�LI�\RXȇG�OLNH�WR�XVH�L&ORXG��)ROORZ�WKH�VHWXS�LQVWUXFWLRQV��DQG�\RX�FDQ�FRQQHFW�WR�
\RXU�L&ORXG�DFFRXQW�LQ�MXVW�D�FRXSOH�RI�WDSV��ΖI�\RX�GRQȇW�JHW�WKDW�SURPSWȃRU�LI�\RX�VHOHFWHG�/DWHU�WKH�ILUVW�WLPH�
you saw it—it’s not immediately obvious how to start saving documents to iCloud; it doesn’t appear as an  
RSWLRQ�DQ\ZKHUH�ZLWKLQ�WKH�DSS�

https://itunes.apple.com/us/app/pages/id361309726?mt=8
https://itunes.apple.com/us/app/keynote/id361285480
https://itunes.apple.com/us/app/numbers/id361304891?mt=8
https://itunes.apple.com/us/app/iphoto/id497786065?mt=8
https://itunes.apple.com/us/app/1password/id568903335?mt=8
https://itunes.apple.com/us/app/tweetbot-for-twitter-iphone/id428851691?mt=8
https://itunes.apple.com/us/app/sketchbook-pro-for-ipad/id364253478?mt=8
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In fact, the only way to enable iCloud if you previously dismissed that prompt is to head over to the Settings 
DSS��6FUROO�GRZQ�DQG�WDS�Pages�IURP�WKH�OLVW�RI�DSSV��2QFH�WKHUH��VOLGH�WKH�Use iCloud switch from Off to On. It’s 
DQ�DOO�RU�QRWKLQJ�DSSURDFK��<RX�HLWKHU�V\QF�DOO�RI�\RXU�GRFXPHQWV�ZLWK�L&ORXG��RU�QRQH�RI�WKHP�

Switch back to Pages, and you may briefly see arrows superimposed upon your document icons—they indicate 
GRFXPHQWV�WKDW�KDYH�\HW�WR�V\QF�WR�L&ORXG��3URJUHVV�EDUV�DSSHDU�RYHU�LQGLYLGXDO�GRFXPHQW�LFRQV�DV�WKH�ILOHV� 
XSORDG�WR�WKH�FORXG���1RWH�WKDW�HDFK�DSSȇV�*HWWLQJ�6WDUWHG�SULPHU�GRFXPHQW�ZRQȇW�V\QF�WR�L&ORXG��EXW�\RXȇOO�
notice a Restore option under the iWork app’s preferences, which lets you restore the document on that device 
LI�\RX�ZDQW�WR��

2QFH�\RXȇYH�HQDEOHG�L&ORXG�IRU�D�JLYHQ�L:RUN�DSS�RQ�\RXU�GHYLFH��\RX�GRQȇW�KDYH�WR�WKLQN�DERXW�LW�DJDLQ��<RXU�
L3KRQH�VDYHV�FKDQJHV�WR�L&ORXG�DXWRPDWLFDOO\�DV�\RX�ZRUN��TXLFNO\�DQG�VHDPOHVVO\ȃDV�ORQJ�DV�\RXȇUH�RQOLQH�

If you’re working offline—perhaps you’re using the iPhone to work on your novel while you’re in a plane at 
�������IHHWȃPDNH�VXUH�WR�UHODXQFK�3DJHV�RQFH�WKH�L3KRQH�FDQ�JR�RQOLQH�DJDLQ��&ORVH�\RXU�FXUUHQW�GRFXPHQW�
by tapping the Documents�EXWWRQ�DW�WKH�XSSHU�OHIW��DQG�\RXȇOO�VHH�WKXPEQDLO�LFRQV�IRU�DOO�\RXU�ILOHV��*LYH�LW�D�IHZ�
VHFRQGV��DQG�WKH�QRZ�IDPLOLDU�DUURZ�DSSHDUV��LQGLFDWLQJ�WKDW�\RXU�ILOH�LV�V\QFLQJ��ZKHQ�LW��DQG�DQ\�SURJUHVV�EDU��
YDQLVKHV��\RXȇOO�NQRZ�\RXȇYH�XSGDWHG�WKH�L&ORXG�FRS\�

The only other major hitch to working with iCloud and iWork apps occurs if you try something you should really 
DYRLG��HGLWLQJ�\RXU�GRFXPHQW�RQ�PXOWLSOH�GHYLFHV�DW�RQFH��L&ORXG�LQIRUPV�\RX�LI�\RXU�FRS\�RI�D�GRFXPHQW� 
EHFRPHV�RXW�RI�GDWH��DQG�\RX�VHH�D�QRWLILFDWLRQ�LI�DQ\RQH�PDNHV�XSGDWHV�WR�D�GRFXPHQW�DV�\RXȇUH�UHDGLQJ�LW��
%XW�LI�\RX�PDNH�VLPXOWDQHRXV�HGLWV�RQ�\RXU�L3DG�DQG�L3KRQH��L&ORXG�GRHVQȇW�NQRZ�ZKLFK�FKDQJHV�LW�VKRXOG�V\QF�

Use Documents & Data Sync With the Mac

2Q�WKH�0DF��PDQ\�RI�26�;ȇV�EXLOW�LQ�DSSV�GR�VXSSRUW�L&ORXG��LQFOXGLQJ�3UHYLHZ��7H[W(GLW��WKH�L:RUN�VXLWH��Pages, 
Numbers, and Keynote������HDFK���DQG�GarageBand������

7KLUG�SDUW\�DSSV�WKDW�VWRUH�GRFXPHQWV�LQ�WKH�FORXG�LQFOXGH�WH[W�HGLWRUV�VXFK�DV�ΖQIRUPDWLRQ�$UFKLWHFWVȇ����iA 
Writer��0HWDFODVV\ȇV����Byword��DQG�3HWHU�%RUJ�$SSVȇ����Smultron��6PLOH2Q0\0DFȇV�����3')�HGLWRU��3')SHQ; 
WKH����JUDSKLFV�HGLWRU�3L[HOPDWRU��DQG�VRPH�RWKHUV��6RPH�L&ORXG�HQDEOHG�SURJUDPV�FDQ�SURGXFH�ILOHV�LQ� 
0LFURVRIW�2IILFH�IRUPDWV��EXW�0LFURVRIW�2IILFH�LWVHOI�GRHVQȇW�VXSSRUW�L&ORXG�

1RWH�WKDW�$SSOH�RQO\�OHWV�DSSV�VROG�WKURXJK�WKH�0DF�$SS�6WRUH�VWRUH�GRFXPHQWV�LQ�L&ORXG��ΖI�\RX�FDQ�RQO\�JHW�
\RXU�IDYRULWH�SURGXFWLYLW\�DSS�GLUHFWO\�IURP�WKH�GHYHORSHU��\RXȇUH�RXW�RI�OXFN�

GET USED TO LIVING INSIDE ONE APP iCloud is a great place to store files that you need to access on multiple 
0DFV��+RZHYHU��WKHUH�DUH�OLPLWV�WR�LWV�IXQFWLRQDOLW\ȃVRPH�RI�ZKLFK�PD\�EH�GHDO�EUHDNHUV�

https://itunes.apple.com/us/app/pages/id409201541?mt=12
https://itunes.apple.com/us/app/numbers/id409203825?mt=12
https://itunes.apple.com/us/app/keynote/id409183694?mt=12
https://itunes.apple.com/us/app/garageband/id408980954?mt=12
https://itunes.apple.com/us/app/ia-writer/id439623248?mt=12
https://itunes.apple.com/us/app/ia-writer/id439623248?mt=12
https://itunes.apple.com/us/app/byword/id420212497?mt=12
https://itunes.apple.com/us/app/smultron/id408831307?mt=12
https://itunes.apple.com/us/app/pdfpen/id403624960?mt=12
https://itunes.apple.com/us/app/pixelmator/id407963104?mt=12
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INSIDE THE BOX When you add or move a file to an app’s iCloud storage space, it resides 
there. You can only open it in another app by dragging the file to that app.

7KH�PDLQ�SUREOHP�LV�\RX�FDQ�RQO\�DFFHVV�ILOHV�LQ�L&ORXG�YLD�WKH�DSSOLFDWLRQV�WKDW�FUHDWHG�WKHP��ΖI�\RX�FUHDWH�D�
ILOH�ZLWK�7H[W(GLW��IRU�H[DPSOH��\RX�FDQ�VDYH�WKDW�ILOH�LQ�D�QXPEHU�RI�IRUPDWV��VXFK�DV�57)�DQG��GRF��WKH�0LFUR-
VRIW�:RUG�IRUPDW��ΖWȇV�QRW�OLNH�VWRULQJ�ILOHV�LQ�WKH�)LQGHU��KRZHYHU��7R�DFFHVV�DQ�DSSȇV�L&ORXG�GRFXPHQW�SDQH��\RX�
KDYH�WR�RSHQ�WKH�DSS�ILUVW��7KDW�PHDQV�LI�\RX�ZDQW�WR�RSHQ�D��GRF�ILOH�VWRUHG�LQ�WKH�7H[W(GLW�GRFXPHQW�SDQH�LQ�
:RUG��\RX�PXVW�ILUVW�ODXQFK�7H[W(GLW��DQG�WKHQ�RSHQ�LWV�L&ORXG�GRFXPHQW�SDQH�DQG�GUDJ�WKH�ILOH�RQWR�0LFURVRIW�
:RUGȇV�DSS�LFRQ�WR�ODXQFK�LW���<RX�FDQ�DOVR�PRYH�RU�FRS\�ILOHV�WR�\RXU�GHVNWRS��DV�H[SODLQHG�ODWHU�LQ�WKLV�VHFWLRQ��

CREATE AND SAVE DOCUMENTS If you’re using an application that can save documents in the cloud, doing so 
LV�IDLUO\�VLPSOH��6D\�\RXȇUH�XVLQJ�7H[W(GLW��$IWHU�\RXȇYH�FUHDWHG�D�QHZ�GRFXPHQW��SUHVV��&RPPDQG!�6�DQG�PDNH�
VXUH�\RX�FKRRVH�L&ORXG�DV�WKH�VDYH�ORFDWLRQ��1DPH�WKH�ILOH�DQG�FOLFN�Save, and you’ve stored the document with 
WKH�L&ORXG�VHUYLFH�

2QFH�\RXȇYH�VDYHG�D�ILOH�WR�WKH�FORXG��\RX�FDQ�DFFHVV�LW�IURP�PXOWLSOH�GHYLFHV��6D\�\RX�KDYH�D�GHVNWRS�0DF�DQG�
D�ODSWRS��<RX�FDQ�VDYH�ILOHV�LQ�L&ORXG�RQ�\RXU�GHVNWRS�0DF��DQG�WKHQ�DFFHVV�WKHP�IURP�\RXU�ODSWRS�ZKLOH�\RXȇUH�
RQ�WKH�JRȃDV�ORQJ�DV�\RX�XVH�WKH�VDPH�DSS�

OPEN DOCUMENTS 7R�RSHQ�ILOHV�\RXȇYH�VDYHG�WR�L&ORXG��SUHVV��&RPPDQG!�2�LQ�DQ�L&ORXG�VDYY\�DSSOLFDWLRQ��
and then click the iCloud�EXWWRQ��$�GLDORJ�ER[�DSSHDUV�WKDW�OHWV�\RX�FKRRVH�IURP�ILOHV�VDYHG�LQ�WKH�DSSOLFDWLRQȇV�
L&ORXG�VWRUDJH�VSDFH�

�<RX�FDQ�DOVR�FUHDWH�IROGHUV�LQ�WKLV�VWRUDJH�VSDFH��-XVW�GUDJ�RQH�ILOH�RQ�WRS�RI�DQRWKHU��DV�\RX�ZRXOG�ZLWK�LFRQV�
RQ�DQ�L3KRQH�RU�L3DG��1DPH�WKH�IROGHU��DQG�LWȇOO�EH�VDYHG�WR�L&ORXG��
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MOVE EXISTING FILES TO iCLOUD <RX�PD\�KDYH�D�QXPEHU�RI�ILOHV�RQ�\RXU�0DF�WKDW�\RXȇG�OLNH�WR�SXW�LQ�L&ORXG��
This is fairly straightforward: Open the application you want to store your document in, choose File > Move To, 
and then choose Where > iCloud. If you want to move a file from the cloud to your Mac, click the Where menu 
DQG�ILQG�WKH�IROGHU�ZKHUH�\RX�ZDQW�WR�SODFH�WKH�ILOH��ΖI�WKH�IROGHU�LVQȇW�LQ�WKH�PHQX��FKRRVH�Other from the bot-
WRP�RI�WKH�PHQX�DQG�QDYLJDWH�WR�WKH�ORFDWLRQ�\RX�ZDQW�

Share Events and Tasks With Others

6\QFLQJ�\RXU�FDOHQGDUV��UHPLQGHUV��DQG�QRWHV�KHOSV�\RX�VWD\�FRRUGLQDWHG�DFURVV�GHYLFHV��%XW�ZKDW�LI�\RX�ZDQW�
to share your items with others? If you have an iCloud account, it’s easy to open up your schedule to other 
PHPEHUV�RI�\RXU�KRXVHKROG�DQG�IDPLO\�IULHQGV�

<RX�FDQ�HQDEOH�VKDULQJ�IRU�DQ\�L&ORXG�FDOHQGDU�RU�UHPLQGHU�OLVW�E\�JRLQJ�WR�L&ORXG�FRP�RQ�\RXU�FRPSXWHU�RU�E\�
XVLQJ�WKH�&DOHQGDU�RU�5HPLQGHUV�DSS�RQ�\RXU�0DF��7KHUH�DUH�WZR�NLQGV�RI�RSWLRQV��SULYDWH�DQG�SXEOLF�VKDULQJ�

When you add people to a private reminders list or calendar, they receive an email with a link that allows them 
WR�VXEVFULEH�WR�LW��7KDW�LWHP�ZLOO�WKHQ�V\QF�ZLWK�WKHLU�L&ORXG�DFFRXQW�DQG�WKHLU�&DOHQGDU�DQG�5HPLQGHUV�DSSV�

A public item, in contrast, is only available for calendars and offers a read-only version that anyone can sub-
VFULEH�WR��ΖI�\RXȇUH�SXEOLVKLQJ�SUDFWLFH�WLPHV�IRU�\RXU�VSRUWV�JURXS��RU�SDVVLQJ�DURXQG�D�OXQFK�VFKHGXOH�IRU�IRRG�
WUXFNV��WKLV�PLJKW�EH�WKH�EHWWHU�RSWLRQ�

Share Events From the Calendar�2Q�L&ORXG�FRP��ORJ�LQ�DQG�FOLFN�WKH�Calendar Web app; on your Mac, open the 
&DOHQGDU�DSS��<RXU�FDOHQGDUV�VKRXOG�DSSHDU�RQ�WKH�OHIW�VLGH�RI�WKH�VFUHHQ��WR�VKDUH�D�VSHFLILF�FDOHQGDU��FOLFN�WKH�
Share�EXWWRQ�WR�WKH�ULJKW�RI�LWV�QDPH��

SHARING TIME Click the Share button to bring up your calendar sharing options.

)URP�KHUH��\RX�FDQ�FKRRVH�WR�OHW�IULHQGV�DQG�IDPLO\�ZLWK�L&ORXG�DFFRXQWV�YLHZ�RU�HGLW�WKLV�FDOHQGDU��RU�\RX�FDQ�
SXEOLVK�LW�WR�WKH�:HE��ZKLFK�DOORZV�DQ\RQH�ZLWK�WKH�OLQN�WR�VHH�\RXU�HYHQWV�
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If you share the calendar with friends who have iCloud accounts, they’ll be able to add or edit events on that 
FDOHQGDU��7KRVH�ZLWK�WKH�SXEOLF�OLQN��KRZHYHU��FDQ�RQO\�YLHZ�HYHQWV��QRW�HGLW�WKHP�

Share Reminder Lists 2Q�L&ORXG�FRP��ORJ�LQ�DQG�FOLFN�WKH�Reminders Web app; on your Mac, open the Remind-
HUV�DSS��0RXVH�RYHU�WKH�QDPH�RI�D�5HPLQGHUV�OLVW�WR�PDNH�WKH�6KDUH�EXWWRQ�SRS�XS��DQG�WKHQ�FOLFN�LW��

DELICIOUS EATS You can share all kinds of lists, including good restaurants around town 
you’d like to try.

<RX�FDQ�RQO\�VKDUH�5HPLQGHU�OLVWV�ZLWK�IULHQGV�ZKR�KDYH�L&ORXG�DFFRXQWVȃWKHUHȇV�QR�SXEOLF�OLVW�RSWLRQ�DV�WKHUH�
LV�IRU�&DOHQGDUV�

SHARE CONTACTS�8QIRUWXQDWHO\��L&ORXG�GRHVQȇW�DOORZ�\RX�WR�HDVLO\�VKDUH�FRQWDFWV�EHWZHHQ�DFFRXQWV��<RX�
FDQȇW��IRU�H[DPSOH��FUHDWH�D�JURXS�RI�FRQWDFWV�ZLWKLQ�\RXU�L&ORXG�DFFRXQW��DQG�WKHQ�WLFN�RII�D�OLWWOH�ER[�PDUNHG�
Ȋ0DNH�WKHVH�FRQWDFWV�DYDLODEOH�WR�P\�VSRXVH�DV�ZHOO�ȋ�%XW�LI�\RXȇUH�GHWHUPLQHG�WR�VKDUH�D�OLVW�RI�IULHQGV��\RX�FDQ�
FUHDWH�DQ�DGGLWLRQDO�L&ORXG�DFFRXQW�WKDW�\RX�VKDUH�

To do that, you go through the usual rigmarole to create an iCloud account: On an iOS device, navigate to Set-
tings > Mail, Contacts, Calendars > Add Account��7DS�iCloud�DQG�FUHDWH�D�QHZ�$SSOH�Ζ'��2Q�WKH�0DF��JR�WR�System 
Preferences > Mail, Contacts & Calendars;�FOLFN�WKH�SOXV�EXWWRQ�����DW�WKH�ERWWRP�RI�WKH�ZLQGRZ��FOLFN�iCloud, and 
click Create Apple ID.��2U��LI�\RXȇYH�DOUHDG\�HVWDEOLVKHG�WKDW�QHZ�Ζ'�RQ�DQRWKHU�GHYLFH��MXVW�HQWHU�WKH�$SSOH�Ζ'�
email address and password and click Sign In.) 

2QFH�\RXȇYH�REWDLQHG�WKDW�Ζ'�DQG�VLJQHG�LQ��GLVDEOH�DOO�V\QFLQJ�H[FHSW�IRU�FRQWDFWV��WKHQ�DGG�WKLV�DFFRXQW�WR�
HYHU\�GHYLFH�\RX�LQWHQG�WR�XVH�WR�VKDUH�FRQWDFWV�ZLWK�

When you open the Contacts application on your Mac or the Contacts app on an iOS device, you’ll see your  
QHZ�L&ORXG�DFFRXQW�OLVWHG�XQGHU�WKH�$FFRXQWV�VHFWLRQ��'UDJ�DQ\�FRQWDFWV�WKDW�\RX�ZDQW�WR�VKDUH�RYHU�WR�WKLV� 
DFFRXQW��ΖQ�FDVHV�ZKHUH�\RX�GRQȇW�ZDQW�WR�VKDUH�SDUWLFXODU�FRQWDFWV��VLPSO\�OHDYH�WKHP�LQ�WKH�DFFRXQW�WLHG�WR�
\RXU�SHUVRQDO�L&ORXG�DFFRXQW��RU�DGG�WKHP�WR�LW��ZKHQ�FUHDWLQJ�QHZ�FRQWDFWV��
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Mobile Backup
:LWK�SRUWDEOH�GHYLFHV��WKHUHȇV�DOZD\V�D�ULVN�RI�ORVLQJ�RU�GDPDJLQJ�\RXU�KDUGZDUH�ZKHQ�\RXȇUH�RXW�DQG�DERXW��$V�
VXFK��LW�PDNHV�VHQVH�WR�PDNH�UHJXODU�EDFNXSV�RI�\RXU�L3KRQH��L3DG��RU�L3RG�WRXFK��:LWK�L&ORXG�%DFNXS��\RX�FDQ�
PDNH�D�EDFNXS�RI�\RXU�L26�GHYLFHȇV�GDWD�DXWRPDWLFDOO\�

How Does It Work?

L&ORXG�%DFNXS�UHTXLUHV�L26���RU�ODWHU�DQG�L7XQHV�����RU�ODWHU��DQG�ZRUNV�VLPLODUO\�WR�WKH�EDFNXS�L7XQHV�SHU-
IRUPV�ZKHQ�\RX�FRQQHFW�\RXU�GHYLFH�WR�\RXU�0DF�RU�3&��ΖQVWHDG�RI�VDYLQJ�\RXU�EDFNXS�WR�\RXU�FRPSXWHU��
KRZHYHU��L&ORXG�%DFNXS�VHQGV�GDWD�WR�$SSOHȇV�L&ORXG�VHUYLFH�RYHU�:L�)L��<RXU�GHYLFH�DXWRPDWLFDOO\�PDNHV�D�
EDFNXS�ZKHQ�LWȇV�SOXJJHG�LQ�DQG�FRQQHFWHG�WR�D�:L�)L�QHWZRUN��VR�WKDW�SHUIRUPLQJ�WKH�EDFNXS�GRHVQȇW�GUDLQ�
\RXU�EDWWHU\���<RX�FDQ�DOVR�PDQXDOO\�EDFN�XS�\RXU�GHYLFH�DW�DQ\�SRLQW�E\�JRLQJ�WR�Settings > iCloud > Storage & 
Backup > Back Up Now��

THE CHECKLIST Your iCloud account makes a backup of all these items  
from your iOS device.
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6R�ZKDW�H[DFWO\�GRHV�L&ORXG�%DFNXS�WDNH�FDUH�RI"�$FFRUGLQJ�WR�$SSOH��LW�XSORDGV�\RXU�GHYLFHȇV�VHWWLQJV��DSS�GDWD��
home screens and how your apps are organized; photos and videos in the Camera Roll; iMessage, SMS, and 
006�PHVVDJHV��DQG�ULQJWRQHV�

To save space—and reduce upload times—iCloud Backup won’t store your purchases; instead, it makes a 
UHFRUG�RI�DOO�WKH�SXUFKDVHG�L26�DSSV��ERRNV��PXVLF��DQG�79�VKRZV�RQ�\RXU�GHYLFH��ΖI�\RX�QHHG�WR�UHVWRUH�IURP�D�
EDFNXS��L&ORXG�UHGRZQORDGV�\RXU�SXUFKDVHV�IURP�WKH�$SS�6WRUH�DQG�L7XQHV�6WRUH���'HSHQGLQJ�RQ�\RXU�FRXQWU\��
OLFHQVLQJ�UHVWULFWLRQV�PD\�SUHYHQW�WKH�UHVWRUDWLRQ�RI�VRPH�SXUFKDVHV��

L&ORXG�%DFNXS�ZRQȇW�VWRUH�PXVLF�RU�YLGHRV�\RX�KDYHQȇW�SXUFKDVHG���ΖI�\RX�ZDQW�DFFHVV�WR�WKDW�FRQWHQW�DW�DOO�
WLPHV��FRQVLGHU�VXEVFULELQJ�WR�$SSOHȇV�����L7XQHV�0DWFK��ZKLFK�XSORDGV�XS�WR��������VRQJV�LQ�\RXU�OLEUDU\�WR�
L&ORXGȃDQG�WKLV�GDWD�GRHVQȇW�FRXQW�WRZDUG�\RXU�IUHH��*%�VWRUDJH�OLPLW��

Back Up Your Data

While Apple offers two methods of backing up your iOS device—backing up via iCloud, or backing up to your 
FRPSXWHUȃ\RX�FDQ�RQO\�XVH�RQH�DW�D�WLPH��ΖI�\RX�ZDQW�WR�XVH�L&ORXG�%DFNXS�IRU�\RXU�GHYLFH��\RXȇOO�KDYH�WR�IRUJR�
EDFNLQJ�XS�YLD�L7XQHV��WKRXJK�\RX�FDQ�PDNH�D�PDQXDO�EDFNXS�WR�\RXU�FRPSXWHU��6\QF�\RXU�GHYLFH�WR�L7XQHV��YLD�
WHWKHUHG�RU�:L�)L�V\QF���8QGHU�WKH�%DFNXSV�VHFWLRQ�RI�WKH�6XPPDU\�SDQH��FKRRVH�WR�EDFN�XS�WR�\RXU�FRPSXWHU��
and then click the Back Up Now�EXWWRQ��:KHQ�WKH�EDFNXS�LV�ILQLVKHG��VZLWFK�WKH�EXWWRQ�EDFN�WR�L&ORXG�

BACKUP CHANGE Want to make a manual backup to your computer? Just connect your 
device to iTunes.

If you didn’t elect to turn on iCloud Backup when you set up your device, you can enable it through Settings > 
iCloud > Storage & Backup on your iOS device, or by connecting your device to iTunes and choosing to back up 
WR�L&ORXG�IURP�WKH�6XPPDU\�SDQH��7KH�LQLWLDO�EDFNXS�WDNHV�D�IHZ�PLQXWHV��GHSHQGLQJ�RQ�KRZ�PXFK�GDWD�LWȇV�
XSORDGLQJ��)RU�H[DPSOH��LI�\RX�KDYH�VHYHUDO�YLGHRV�LQ�\RXU�FDPHUD�UROO��WKH�DPRXQW�RI�WLPH�LW�WDNHV�WR�SHUIRUP�
WKH�ILUVW�EDFNXS�ZLOO�EH�ORQJHU��6XEVHTXHQW�EDFNXSV�FDQ�WDNH�PHUH�VHFRQGV�WR�D�IHZ�PLQXWHV��DV�L&ORXG�ZLOO�RQO\�
EDFN�XS�ZKDWHYHU�KDV�FKDQJHG�RQ�\RXU�GHYLFH�
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L&ORXG�%DFNXS�DXWRPDWLFDOO\�EDFNV�XS�\RXU�GHYLFH�RQFH�D�GD\��DFFRUGLQJ�WR�$SSOHȇV�ZHEVLWH��DQG�LQ�RXU�H[SHUL-
HQFH�LW�GRHVQȇW�EDFN�XS�HYHU\�WLPH�\RX�DUH�LQ�WKH�SUHVHQFH�RI�:L�)L�DQG�SOXJ�LQ�\RXU�L26�GHYLFH��+RZHYHU��ZKHQ�
it is performing a backup, there’s no indicator in your iOS device’s status bar—you have to go to Settings >  
iCloud > Storage & Backup WR�VHH�D�SURJUHVV�EDU��7KHUHȇV�DOVR�FXUUHQWO\�QR�ZD\�WR�FUHDWH�VFKHGXOHG�EDFNXSV�
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Location Awareness
(YHU�VLQFH�WKH�)LQG�0\�L3KRQH�VHUYLFH�GHEXWHG�DV�SDUW�RI�WKH�L3KRQH�����VRIWZDUH�LQ�PLG�������$SSOHȇV�L26� 
GHYLFH�ORFDWLRQ�RIIHULQJV�KDYH�EHHQ�D�SRSXODU�IHDWXUH��L&ORXG�DGGV�\RXU�0DF�WR�WKH�OLVW�RI�GHYLFHV�\RX�FDQ�
ORFDWH��LQ�DGGLWLRQ��\RX�FDQ�ILQG�\RXU�IHOORZ�L&ORXG�XVLQJ�IULHQGV��ZLWK�WKHLU�SHUPLVVLRQ��RQ�DQ�L26�GHYLFH��DQG�
UHPRWHO\�WDON�WR�\RXU�0DF�IURP�DIDU�

Find My iPhone, iPad, iPod, and Mac

7KHVH�GD\V��ORVLQJ�D�GHYLFH�LV�DOPRVW�DV�WUDXPDWLF�DV�ORVLQJ�\RXU�ZDOOHW��7KDQNIXOO\��)LQG�0\�L3KRQH can ease 
\RXU�SDQLF�DQG�KHOS�\RX�ILQG�\RXU�PLVVLQJ�GHYLFHV��7KH�VHUYLFH�KDV�DOVR�EHFRPH�SRSXODU�IRU�RWKHU�XVHV��0RUH�
WKDQ�D�IHZ�L3KRQH�XVHUV�ZKRȇYH�PLVSODFHG�WKHLU�GHYLFH�DW�KRPH�KDYH�XVHG�WKH�)LQG�0\�L3KRQH�VRXQG�WR�UHYHDO�
WKH�SKRQHȇV�ORFDWLRQ�XQGHU�D�MDFNHW�QH[W�WR�WKH�VRID�

FIND ME Even if your devices are missing, you can track them and  
send them commands.

%\�XVLQJ�\RXU�L26�GHYLFHȇV�ORFDWLRQȃGHWHUPLQHG�XVLQJ�*36�FLUFXLWU\�RU�ZLUHOHVV�DFWLYLW\��RU�ERWK�ȃ)LQG�0\�
L3KRQH�OHWV�\RX�ORFDWH��DQG�HYHQ�WUDFN��\RXU�L3KRQH��L3DG��L3RG�WRXFK��RU�0DF�YLD�L&ORXG�FRP�RU�WKH�GHGLFDWHG�
)LQG�0\�L3KRQH�DSS��$VVXPLQJ�WKH�GHYLFH�KDV�UHFHQWO\�EHHQ�WXUQHG�RQ��DQG��LQ�WKH�FDVH�RI�:L�)LȂRQO\�GHYLFHV��

https://itunes.apple.com/us/app/find-my-iphone/id376101648?mt=8
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DZDNH��DQG�FRQQHFWHG�WR�D�PRELOH�RU�:L�)L�QHWZRUN��\RX�FDQ�DFWXDOO\�VHH�LWV�ORFDWLRQ�RQ�D�PDS��DV�ZHOO�DV�VHQG�D�
PHVVDJH�WR�LW��SOD\�D�VRXQG�RQ�LW��UHPRWHO\�ORFN�LW��RU�HYHQ�VHFXUHO\�HUDVH�LWV�FRQWHQWV�

A SERVICE IN TWO PARTS If you want to be able to locate the gadget in question, the first thing you need to 
GR�LV�PDNH�VXUH�WKH�)LQG�0\�device�VZLWFK�LV�HQDEOHG�LQ�L&ORXGȇV�SUHIHUHQFH�VFUHHQ��<RX�PXVW�GR�WKLV�IRU�HYHU\�
GHYLFH�\RX�ZDQW�WR�EH�DEOH�WR�WUDFN�

)URP�WKHUH��LI�\RX�QHHG�WR�ORFDWH�D�PLVVLQJ�GHYLFH��\RX�FDQ�XVH�HLWKHU�L&ORXG�FRP�RU�WKH�)LQG�0\�L3KRQH�DSS��RQ�
D�GLIIHUHQW�GHYLFH�WKDQ�WKH�RQH�WKDWȇV�JRQH�PLVVLQJ��SUHVXPDEO\���7R�XVH�WKH�DSS��ODXQFK�LW�RQ�DQ\�L26�GHYLFH��
DQG�WKHQ�VLJQ�LQ�XVLQJ�\RXU�$SSOH�Ζ'�DQG�SDVVZRUG��7R�XVH�WKH�ZHEVLWH��ORJ�LQ�WR�L&ORXG�FRP�DQG�WKHQ�FOLFN�WKH�
Find My iPhone�EXWWRQ�

7KH�'HYLFHV�OLVW�GLVSOD\V�HYHU\�GHYLFHȃL3KRQH��L3DG��L3RG�WRXFK��RU�0DFȃWKDW�KDV�WKH�)LQG�0\�device service 
HQDEOHG��<RXȇOO�ILQG�WKLV�OLVW�E\�FOLFNLQJ�RU�WDSSLQJ�WKH�Devices�EXWWRQ��$�JUHHQ�GRW�QH[W�WR�D�GHYLFH�PHDQV�L&ORXG�
KDV�ORFDWHG�LW��D�JUD\�GRW�PHDQV�LW�FRXOG�QRW�EH�IRXQG��7KH�VWDWXV�RI�HDFK�GHYLFHȃKRZ�ORQJ�DJR�L&ORXG�ORFDWHG�
LW��RU�WKH�IDFW�WKDW�L&ORXG�FRXOGQȇW�ORFDWH�LWȃDSSHDUV�MXVW�EHORZ�LWV�QDPH��
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OFFLINE DEVICE? DON’T PANIC
L&ORXG�XVHV�DQ�ΖQWHUQHW�FRQQHFWLRQ�WR�WUDFN�\RXU�GHYLFH��ΖI�WKHUHȇV�QR�FRQQHFWLRQ�WR�EH�PDGH��\RXU�GHYLFH�ZLOO�VKRZ�XS�
DV�RIIOLQH��%XW�GRQȇW�ORVH�KRSH��<RX�FDQ�VWLOO�VHQG�VRXQG��ORFN��DQG�HUDVXUH�FRPPDQGV�WR�LWȃZKHQ�LW�ILQGV�DQ�ΖQWHUQHW�
VLJQDO��WKRVH�FRPPDQGV�DXWRPDWLFDOO\�JR�LQWR�HIIHFW��<RX�FDQ�DOVR�LQVWUXFW�WKH�VHUYLFH�WR�HPDLO�\RX�ZKHQ�\RXU�GHYLFH�
FRPHV�EDFN�RQOLQH�

7DS�RU�FOLFN�D�GHYLFHȇV�QDPH�WR�YLHZ�LWV�ORFDWLRQ�RQ�WKH�PDS��$V�ZLWK�WKH�0DSV�DSS��\RX�FDQ�]RRP�LQ�RU�RXW��DQG�
\RX�FDQ�VZLWFK�EHWZHHQ�0DS��6DWHOOLWH��DQG�+\EULG�YLHZV��

:KHQ�\RX�KDYH�D�GHYLFH�VHOHFWHG��L&ORXG�RIIHUV�\RX�VHYHUDO�RSWLRQV���&KRRVH�DQ\�RI�WKHVH��DQG�\RXȇOO�DOVR� 
UHFHLYH�DQ�HPDLO�WR�\RXU�L&ORXG�DFFRXQW�QRWLQJ�WKDW�\RXȇYH�VHOHFWHG�RQH�RI�WKHP���

3OD\�6RXQG�HPLWV�D�ORXG�VRXQG�RQ�WKH�GHYLFH��HYHQ�LI�LWȇV�PXWHG���7KH�VRXQG�ZLOO�DXWRPDWLFDOO\�VKXW�RII�DIWHU�WZR�
PLQXWHV��RU�DIWHU�\RX�XQORFN�\RXU�JDGJHW�

/RVW�PRGH��L26��RU�/RFN��0DF��UHPRWHO\�ORFNV�\RXU�GHYLFH�ZLWK�D�IRXU�GLJLW�SDVVFRGH��ΖQ�WKH�FDVH�RI�DQ�L26�
device, it uses your usual lock code, if you have one; otherwise, it asks you to provide a code from the app  
RU�ZHEVLWH�

:KHQ�DQ�L26�GHYLFH�LV�LQ�/RVW�PRGH��$SSOHȇV�JUD\�OLQHQ�WH[WXUH�UHSODFHV�\RXU�ORFN�VFUHHQ�ZDOOSDSHU��DQG�D�FXV-
WRP�PHVVDJH�VKRZV�XS�RQ�DQ�DOHUW�WKDW�FDQȇW�EH�GLVPLVVHG��RQ�DQ�L3KRQH��\RXȇOO�DOVR�VHH�D�SKRQH�QXPEHU�DQG�D�
ELJ�JUHHQ�&DOO�EXWWRQ��

ΖI�\RXU�GHYLFH�ZLQGV�XS�LQ�D�GXPS�WUXFN�DQG�]RRPV�DURXQG�WRZQ��/RVW�PRGH�FDQ�DOVR�PDS�LWV�PRYHPHQWV�� 
XVLQJ�JUD\�SLQV�DQG�DQ�RUDQJH�GRWWHG�OLQH��<RX�FDQ�VHH�\RXU�GHYLFHȇV�FXUUHQW�EDWWHU\�OHYHO��WRR���7KH�VHUYLFH�ZLOO�
DGGLWLRQDOO\�VHQG�\RX�HPDLO�XSGDWHV�DV�WKH�GHYLFH�PRYHV��LI�\RX�WHOO�LW�WR�GR�VR��



50

C H A P T E R  2   Work With iCloud

LOST AND FOUND Lost mode keeps track of your device’s movements and creates a 
map for you.

2QFH�\RXȇYH�XQORFNHG�\RXU�GHYLFH��RU�RQFH�\RXȇYH�GLVDEOHG�/RVW�PRGH�IURP�WKH�DSS�RU�YLD�L&ORXG�FRP��LW�UHWXUQV�
WR�LWV�QRUPDO�VWDWH�DQG�/RVW�PRGH�VWRSV�WUDFNLQJ�LWV�PRYHPHQWV�

ΖI�\RX�RSW�WR�UHPRWHO\�ORFN�D�0DF��RQFH�WKH�0DF�UHFHLYHV�WKH�ORFN�FRPPDQG��LW�DFWXDOO\�VKXWV�GRZQ��7KH�QH[W�
time you attempt to start up the Mac, it boots into Recovery mode and asks you to enter your computer’s pass-
FRGH��LI�\RX�RSWHG�WR�GLVSOD\�D�PHVVDJH��LW�GLVSOD\V�WKDW�PHVVDJH�RQ�WKH�VDPH�VFUHHQ��2QFH�\RXȇYH�HQWHUHG�WKH�
FRUUHFW�SDVVFRGH��WKH�0DF�UHERRWV�QRUPDOO\�

7KH�ILQDO�RSWLRQ�IRU�ERWK�L26�DQG�0DF�LV�D�UHPRWH�ZLSH��7KLV�OHWV�\RX�FRPSOHWHO\�HUDVHȃVHFXUHO\ȃDOO�GDWD�DQG�
VHWWLQJV�IURP�\RXU�GHYLFH��ΖQ�WKH�FDVH�RI�D�0DF��LW�DOVR�VHWV�D�IRXU�GLJLW�SDVVFRGH�WKDW�OHWV�\RX�DFFHVV�\RXU�0DF�
LI�\RX�HYHU�UHFRYHU�LW��<RX�VKRXOG�XVH�WKH�UHPRWH�ZLSH�RSWLRQ�RQO\�DV�D�ODVW�UHVRUW���7KLV�LV�DOVR�D�JRRG�WLPH�WR�
UHPLQG�\RX�WR�PDNH�JRRG�EDFNXSV�RI�\RXU�GHYLFHV��
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Find My Friends

)LQG�0\�)ULHQGV�XVHV�WKH�VDPH�WHFKQRORJ\�DV�)LQG�0\�L3KRQH�WR�OHW�\RX�ORFDWH�IULHQGV�E\�ILQGLQJ�WKHLU�L26�
GHYLFHVȃDVVXPLQJ�WKH\ȇYH�JLYHQ�\RX�SHUPLVVLRQ��RI�FRXUVH��7KH�DSS�DOVR�RIIHUV�ORFDWLRQ�JHRIHQFLQJ�VR�WKDW�\RX�
FDQ�ILQG�RXW�QRW�RQO\�ZKHUH�\RXU�IULHQGV�FXUUHQWO\�DUH��EXW�DOVR�ZKHQ�WKH\�OHDYH�RU�DUULYH�DW�D�FHUWDLQ�SODFH�� 
8QOLNH�)LQG�0\�L3KRQH��)LQG�0\�)ULHQGV�LV�RQO\�DYDLODEOH�IRU�L26�GHYLFHVȃ0DFV�DUH�RXW�RI�OXFN�

FIND ME, FRIENDS The Find My Friends app helps you keep track of your pals  
and buddies.

Download and launch the free )LQG�0\�)ULHQGV app on your iPhone, iPad, or iPod touch, and you’ll be asked 
WR�HQWHU�\RXU�$SSOH�Ζ'�DQG�SDVVZRUG���ΖI�\RX�KDYH�QR�SDVVFRGH�RQ�\RXU�GHYLFH��\RXȇOO�DOZD\V�EH�DVNHG�WR�HQWHU�
your password when you open this app—in case your gadget gets lost or stolen, Apple doesn’t want random 
SHRSOH�WR�EH�DEOH�WR�VHH�\RXU�RU�\RXU�IULHQGVȇ�PRYHPHQWV��

$IWHU�VLJQLQJ�LQ��\RXȇOO�VHH�D�VPDOO�PDS��DORQJ�ZLWK�D�OLVW�RI�IULHQGV�ZKR�KDYH�DOORZHG�\RX�WR�VHH�WKHLU�ORFDWLRQ��
3OHDVH�QRWH��7KLV�OLVW�LV�GLIIHUHQW�IURP��VD\��\RXU�L0HVVDJH�EXGGLHV�RU�\RXU�IULHQGV�LQ�WKH�&RQWDFWV�DSS��7R�VHH�
\RXU�SDOV�KHUH��\RX�PXVW�PDQXDOO\�UHTXHVW�WR�IROORZ�WKHLU�ORFDWLRQ�ZLWKLQ�)LQG�0\�)ULHQGV�

https://itunes.apple.com/us/app/find-my-friends/id466122094?mt=8
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MAKE FRIENDS 2Q�ILUVW�ODXQFK��\RXU�OLVW�ZLOO�OLNHO\�WDXQW�\RX�ZLWK�D�1R�)ULHQGV�EDQQHU��7KH�ILUVW�WKLQJ�\RXȇOO�
ZDQW�WR�GR�LV�DGG�VRPH�EXGGLHV�WR�IROORZ��

7DS�WKH�SOXV�EXWWRQ�WR�DGG�D�IULHQG��HQWHU�HLWKHU�\RXU�IULHQGȇV�$SSOH�Ζ'�RU��WR�FKRRVH�DQ�H[LVWLQJ�FRQWDFW��WDS�
WKH�EOXH�SOXV�EXWWRQ��<RX�FDQ�DGG�PXOWLSOH�QDPHV��VHQGLQJ�WKLV�LQLWLDO�UHTXHVW�WR�VHYHUDO�SHRSOH�DW�RQFH��LI�
\RXȇG�SUHIHU��7KHUHȇV�DOVR�D�VSDFH�IRU�D�FXVWRP�PHVVDJH���ΖI�\RX�GRQȇW�HQWHU�D�PHVVDJH��UHFLSLHQWV�JHW�D� 
JHQHULF�UHTXHVW���

ΖI�\RXȇUH�QRW�VXUH�ZKRȇV�XVLQJ�)LQG�0\�)ULHQGV��WKH�DSSȇV�)ULHQG�6XJJHVWLRQV�PD\�EH�DEOH�WR�KHOS��2Q�DQ�L3KRQH��
tap Friend Suggestions�DW�WKH�ERWWRP�RI�WKH�$GG�)ULHQGV�VFUHHQ��RQ�DQ�L3DG��WKH�)ULHQG�6XJJHVWLRQV�ER[�SRSV�XS�
when you first tap the To�ILHOG��L&ORXG�WKHQ�FKHFNV�\RXU�&RQWDFWV�OLVW�IRU�DQ\�EXGGLHV�ZKR�XVH�WKH�VHUYLFH��6HOHFW�
friends you want to add by tapping their names, then tap Done; this autofills their Apple IDs in the To field of 
\RXU�$GG�)ULHQGV�UHTXHVW�

After choosing whom you wish to follow, tap Send.�<RXȇOO�VHH�D�PHVVDJH�H[SODLQLQJ�WKDW�\RXȇOO�EH�DEOH�WR�IRO-
ORZ�WKHP�DIWHU�WKH\�DFFHSW�\RXU�UHTXHVW��2QFH�D�IULHQG�KDV�DSSURYHG�\RXU�UHTXHVW��KH�ZLOO�DSSHDU�LQ�\RXU�
IULHQGV�OLVW�

ΖI�\RXU�IULHQG�DSSURYHV�\RXU�UHTXHVW��WKDW�MXVW�PHDQV�\RX�FDQ�VHH�KLV�ORFDWLRQ��ΖI�KH�ZDQWV�WR�VLPLODUO\�IROORZ�
your�ORFDWLRQ��KHȇOO�QHHG�WR�VHQG�\RX�D�VHSDUDWH�UHTXHVW��ZKLFK�\RX�PXVW�WKHQ�DSSURYH��ΖQ�RWKHU�ZRUGV��D�IROORZ�
UHTXHVW�LV�XQLGLUHFWLRQDO��QRW�UHFLSURFDO�

:KHQ�IULHQGV�VHQG�\RX�UHTXHVWV��WKH\�DSSHDU�XQGHU�WKH�5HTXHVWV�WDE�LQ�WKH�DSS��7DS�Accept to allow them to 
follow you, and, if you aren’t already following them, tap the Ask to Follow�EXWWRQ�WR�VHQG�D�UHFLSURFDO�UHTXHVW�

If you want friends to be able to send requests to one or more email addresses other than your Apple ID, you 
can add those addresses in your account settings on Apple’s website: On the Name, ID, and Email Addresses 
screen, just click Add Email Address.

LOCATE YOUR FRIENDS�<RX�FDQ�YLHZ�WKH�ORFDWLRQV�RI�\RXU�IULHQGVȃWKH�SHRSOH�\RX�IROORZȃLQ�VHYHUDO�ZD\V��
Tap the Friends�WDE��DQG�\RX�VHH�D�PDS�WKDW�GLVSOD\V��LQ�SXUSOH��WKH�ORFDWLRQ�RI�HYHU\�IULHQG�FXUUHQWO\�DOORZLQJ�
ORFDWLRQ�WUDFNLQJ��\RXU�RZQ�ORFDWLRQ�LV�GLVSOD\HG�LQ�EOXH��ΖQ�DGGLWLRQ��DOO�\RXU�IULHQGV�DUH�OLVWHG�HLWKHU�RQ�WKH�VLGH�
�L3DG��RU�EHORZ�WKH�PDS��L3KRQH���RUJDQL]HG�E\�KRZ�IDU�WKH\�DUH�IURP�\RX��2Q�WKH�L3KRQH��\RX�FDQ�JR�WR�D�IXOO�
VFUHHQ�PDS�E\�WDSSLQJ�RQFH�RQ�LW�

7DS�D�SHUVRQ�RQ�WKH�OLVW��DQG�WKH�PDS�WDNHV�\RX�WR�KHU�ORFDWLRQ��LI�LWȇV�FXUUHQWO\�EURDGFDVW���$�SRS�XS�PHQX� 
DSSHDUV�QH[W�WR�WKH�SXUSOH�GRW��OLVWLQJ�KHU�QDPH��FXUUHQW�ORFDWLRQ��DQG�KRZ�ORQJ�DJR�WKH�VHUYLFH�ORFDWHG�KHU��2Q�
the iPhone, there’s also a blue info button; tap that to see her precise location, along with her photo, contact 
information, an option to label her current location, and a button to notify you when she leaves or arrives at a 
FHUWDLQ�SODFH���2Q�WKH�L3DG��WKLV�LQIRUPDWLRQ�LV�OLVWHG�EHORZ�WKH�PDS��

http://appleid.apple.com
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CHOOSE YOUR FAVORITES
:LWKLQ�\RXU�)ULHQGV�OLVW��\RX�FDQ�GHVLJQDWH�FHUWDLQ�SHRSOHȃOLNH�\RXU�SDUHQWV�RU�\RXU�VLJQLILFDQW�RWKHUȃDV�)DYRULWHV�� 
DOORZLQJ�WKHP�WR�DSSHDU�DW�WKH�WRS�RI�WKH�OLVW��7DS�WKH�Edit button, and then tap the star button to the right of the 
IULHQGȇV�QDPH��7KH\�QRZ�DSSHDU�DERYH�DOO�RWKHU�IULHQGV��ΖI�\RX�KDYH�PXOWLSOH�)DYRULWHV��\RX�FDQ�DUUDQJH�ZKDW�RUGHU�
WKH\�DSSHDU�LQ�E\�GUDJJLQJ�XS�RU�GRZQ�RQ�WKH�WKUHH�KRUL]RQWDO�OLQHV�WR�WKH�ULJKW�RI�WKHLU�QDPHV�

:LWKLQ�WKDW�FRQWDFWȇV�LQIRUPDWLRQ��\RX�FDQ�DVN�)LQG�0\�)ULHQGV�WR�JLYH�\RX�GLUHFWLRQV�WR�KHU�FXUUHQW�ORFDWLRQ��RU�
\RX�FDQ�FDOO�KHU��HPDLO�KHU��VHQG�KHU�DQ�L0HVVDJH��RU�)DFH7LPH�ZLWK�KHU��GRLQJ�VR�VZLWFKHV�\RXU�GHYLFH�WR�WKH�
DSSURSULDWH�DSS�

<RX�FDQ�DOVR�WDS�&KRRVH�/DEHO�IRU�D�IULHQGȇV�ORFDWLRQ�WR�JLYH�KHU�FXUUHQW�ORFDWLRQ�D�PRUH�XVHIXO�ODEHO��VXFK�DV�
*\P��2IILFH��RU�0RPȇV�+RXVH��

NOTIFY ME If you’re waiting for a ride from your buddy and you want to know when he leaves the house, you 
can turn on Notify Me,�ZKLFK�VHQGV�\RX�DQ�DOHUW�ZKHQ�\RXU�IULHQG�DUULYHV�DW�RU�GHSDUWV�IURP�D�FHUWDLQ�DGGUHVV��

NOTIFIED Use Notify Me to find out when your buddy is leaving to pick you up.

<RX�FDQ�DFFHVV�LW�E\�WDSSLQJ�DQ�LQGLYLGXDO�FRQWDFW�DQG�WKHQ�WDSSLQJ�WKH�Notify Me button; from there, you 
FKRRVH�ZKHWKHU�WKH�DOHUW�VKRXOG�ILUH�ZKHQ�KH�HQWHUV�RU�H[LWV��DQG�DW�ZKDW�DGGUHVV��<RX�FDQ�DOVR�VHW�XS�WKHVH�
notifications as repeating alerts; if you want your significant other to know when you leave the office, for 
LQVWDQFH��\RX�FDQ�VHW�XS�D�QRWLILFDWLRQ�WR�SLQJ�KLP�HYHU\�WLPH�\RX�GR���<RX�JHW�QR�VSHFLILFDWLRQ�EH\RQG�5HSHDW�
(YHU\�7LPH��XQIRUWXQDWHO\��VR�LI�\RX�JR�RXW�IRU�OXQFK��KHȇOO�JHW�WKDW�DOHUW�WRR��
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7KLV�IXQFWLRQ�LV�VXUSULVLQJO\�XVHIXO�IRU�WLPLQJ�PHHWLQJV�ZLWK�IULHQGV��)RU�LQVWDQFH��LI�\RXȇUH�ZDONLQJ�GLVWDQFH�IURP�
a restaurant and your pals are driving, you can set a geofence at a stoplight several blocks away; when they go 
WKURXJK�LW��\RX�JHW�D�QRWLILFDWLRQ�DQG�FDQ�VWDUW�ZDONLQJ�

<RX�FDQ�VHH�ZKHQ�\RXU�IULHQG�KDV�SXW�D�QRWLILFDWLRQ�RQ�\RX��WKRXJK�\RX�FDQȇW�UHPRYH�LW��+HDG�WR�WKH�0H�WDE�WR�
VHH�LI�VRPHRQH�KDV�DSSOLHG�D�JHRIHQFH�WR�\RX��LI�VR��WKH�RXWOLQH�RI�WKH�/RFDWLRQ�6HUYLFHV�DUURZ�DSSHDUV�LQ�WKH�
)ROORZHUV�OLVW�QH[W�WR�WKH�QDPH�RI�WKH�SHUVRQ�ZKR�LV�WUDFNLQJ�\RX��<RX�FDQ�WDS�WKH�QDPH�WR�VHH�ZKDW�DGGUHVV�
the person is tracking, though currently the app doesn’t offer a way to get rid of the geofence without remov-
LQJ�WKH�SHUVRQ�DV�D�IROORZHU�DOWRJHWKHU���<RX�FDQ�KLGH�\RXU�ORFDWLRQ�IURP�IROORZHUV�WHPSRUDULO\�E\�HQDEOLQJ�WKH�
switch in the Me tab, but that doesn’t wipe out the geofence—it merely disables the geofence while you’re hid-
GHQ��)RU�H[DPSOH��LI�\RXU�IULHQG�KDV�D�JHRIHQFH�RQ�\RX�IRU�ZKHQ�\RX�OHDYH�ZRUN��DQG�\RX�WXUQ�RII�\RXU�ORFDWLRQ�
EHIRUH�\RX�OHDYH��KH�ZRQȇW�JHW�WKH�QRWLILFDWLRQ��EXW�WKH�JHRIHQFH�VWLOO�H[LVWVȃLI�\RX�WXUQ�\RXU�ORFDWLRQ�EDFN�RQ�
DQRWKHU�GD\��DQG�WKHQ�OHDYH�ZRUN��\RXU�IULHQG�ZLOO�JHW�WKH�QRWLILFDWLRQ�DW�WKDW�WLPH��

If you want, you can flip this feature around and notify others of your location—either currently, or when you leave 
RU�DUULYH�VRPHZKHUH��7DS�WKH�Me tab, then tap the Notify�EXWWRQ�DQG�FKRRVH�ZKRP�\RX�ZDQW�WR�VHQG�DQ�DOHUW�WR�

Unlike Notify Me, which requires that you and your buddy be following each other, you can send your notifica-
WLRQV�WR�DQ\RQH��ZKHWKHU�WKH\�KDYH�)LQG�0\�)ULHQGV�LQVWDOOHG�RU�QRW��ΖI�\RXU�FRQWDFW�LVQȇW�XVLQJ�)LQG�0\�)ULHQGV��
VKHȇOO�UHFHLYH�DQ�HPDLO�ZLWK�\RXU�FXUUHQW�ORFDWLRQ��RU�ZKHQ�\RX�OHIW�RU�DUULYHG���LI�VKH�GRHV�KDYH�WKH�DSS��VKHȇOO�
JHW�DQ�DOHUW�IURP�LW�

CREATE TEMPORARY EVENTS Although these features are nifty for people you trust with your location, you 
PLJKW�QRW�ZDQW�WR�OHW�HYHU\�SHUVRQ�\RX�PHW�DW��VD\��D�FRQIHUHQFH�KDYH�SHUPDQHQW�DFFHVV��)RU�WKRVH�VLWXDWLRQV��
we recommend using the app’s Temporary Event feature, which allows you to set geofences and track location 
IRU�D�OLPLWHG�DPRXQW�RI�WLPH�

Tap the Temporary button at the bottom of the screen, and then tap Invite Friends �RQ�DQ�L3DG�LQ�SRUWUDLW�RULHQWD-
WLRQ��WKLV�EXWWRQ�LV�KLGGHQ�LQ�D�SRSRYHU�OLVWȃWDS�WKH�OLVW�EXWWRQ�LQ�WKH�XSSHU�OHIW�WR�UHYHDO�LW���$GG�WKH�SHRSOH�\RX�
wish to invite, give the temporary event a name, and tap the Ends field to choose a date and time for the event 
WR�HQGȃLQ�RWKHU�ZRUGV��WKH�WLPH�DW�ZKLFK�WKH�OLVWHG�SHRSOH�ZLOO�QR�ORQJHU�EH�DEOH�WR�ORFDWH�HDFK�RWKHU��XQOHVV��
RI�FRXUVH��VRPH�RI�WKHP�DUH�IROORZLQJ�HDFK�RWKHU�LQGHSHQGHQW�RI�WKH�WHPSRUDU\�HYHQW��

Tap Send�WR�FUHDWH�WKH�HYHQW��1RWH�WKDW�LI�\RX�VHQG�DQ�LQYLWDWLRQ�WR�VRPHRQH�ZKR�LVQȇW�DOUHDG\�XVLQJ�)LQG�0\�
)ULHQGV��KHȇOO�UHFHLYH�WKH�LQYLWH�YLD�HPDLO��ZLWK�LQIRUPDWLRQ�RQ�GRZQORDGLQJ�WKH�DSS��LQVWHDG�RI�DV�DQ�L26�QRWLILFDWLRQ��

What’s unique about temporary-event invitations is that when friends accept that invitation, the location shar-
ing is automatically multi-way—for the duration of the event, everyone can follow everyone else, without each 
SHUVRQ�KDYLQJ�WR�H[FKDQJH�WZR�LQYLWHV�ZLWK�HYHU\�RWKHU�SHUVRQ�

$W�DQ\�WLPH��\RX�FDQ�YLHZ�WKH�7HPSRUDU\�OLVW�WR�VHH�D�OLVW�RI�RQJRLQJ�WHPSRUDU\�HYHQWV�DQG�WKHLU�SDUWLFLSDQWV��
)RU�DQ\�HYHQW��\RX�FDQ�WDS�View Map to view a map with each person’s location marked or tap Send iMessage to 
VHQG�D�PHVVDJH�WR�HYHU\RQH�LQ�WKH�JURXS��<RX�FDQ�DOVR�WDS�DQ\�SDUWLFLSDQW�WR�YLHZ�KLV�GHWDLOV��ΖI�\RX�FUHDWHG�WKH�
event, you can tap the event name to view a summary of the event, as well as to edit the event name and end, 
WR�UHPRYH�RU�DGG�SDUWLFLSDQWV��RU�WR�GHOHWH�WKH�HYHQW��)RU�HYHQWV�\RX�GLGQȇW�FUHDWH��\RX�RQO\�KDYH�WKH�RSWLRQ�WR�
OHDYH�WKH�HYHQW�
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STOP FOLLOWING ME If you’d rather not let a particular person or group of people follow you, you have several 
RSWLRQV��ΖI�WKH�SHUVRQ�LV�RQO\�IROORZLQJ�\RX�EHFDXVH�\RXȇUH�ERWK�PHPEHUV�RI�D�WHPSRUDU\�HYHQW��DQG�\RX�FUHDWHG�
the event, you can simply remove the person from the event; if you aren’t the event creator, you must leave the 
HYHQW��ΖI�WKH�SHUVRQ�LV�RIILFLDOO\�IROORZLQJ�\RX��\RXȇOO�QHHG�WR�UHPRYH�KHU�IURP�\RXU�)ROORZHUV�OLVW��7DS�Me at the bot-
tom of the screen to view the list of your followers, tap the person’s name, and then tap Remove From Followers.

<RX�FDQ�DOVR�WHPSRUDULO\�GLVDEOH�ORFDWLRQ�VKDULQJ�WR�SUHYHQW�DQ\RQH�IURP�VHHLQJ�\RXU�ORFDWLRQ��ΖQ�WKH�Me 
screen, simply switch the Hide From Followers setting to On. Switch the setting back to Off to resume location 
VKDULQJ��:KLOH�KLGLQJ��\RX�FDQ�VWLOO�VHQG�DQG�UHFHLYH�)LQG�0\�)ULHQGV�LQYLWDWLRQV��8QIRUWXQDWHO\��WKHUHȇV�QR�ZD\�
WR�WHPSRUDULO\�KLGH�\RXU�ORFDWLRQ�IURP�FHUWDLQ�SHRSOHȃLWȇV�DOO�RU�QRWKLQJ�

USE MULTIPLE DEVICES WITH FIND MY FRIENDS�ΖI�\RXȇYH�JRW��VD\��DQ�L3KRQH�DQG�DQ�L3DG��\RX�FDQ�VLJQ�LQ�WR�)LQG�
0\�)ULHQGV�RQ�ERWK�GHYLFHV�XVLQJ�WKH�VDPH�$SSOH�Ζ'��+RZHYHU��\RXU�IULHQGV�FDQ�RQO\�YLHZ�WKH�ORFDWLRQ�RI�RQH�GHYLFH��

THE ACTIVE ONE If you have multiple devices, choose which one broadcasts your 
location to your friends.

To choose which device will be locatable, tap Me at the bottom of the screen, tap Account in the upper right, and 
WKHQ�WDS�WKH�GHVLUHG�GHYLFH�XQGHU�$FWLYH�'HYLFH��<RXȇOO�VWLOO�EH�DEOH�WR�XVH�WKH�)LQG�0\�)ULHQGV�DSS�RQ�DQ\�RI�
\RXU�L26�GHYLFHV��EXW�\RXU�IROORZHUV�ZLOO�VHH�RQO\�WKH�VHOHFWHG�GHYLFHȇV�ORFDWLRQ�

OTHER SETTINGS The Me screen has information about your current location, as well as an option to assign 
LW�D�PRUH�PHDQLQJIXO�ODEHOȃRQH�WKDW�DSSHDUV�WR�\RXU�IROORZHUV��7DS�Choose Label, and then choose one of the 
VWRFN�ODEHOV��+RPH��:RUN��6FKRRO��*\P��RU�1RQH��RU�FUHDWH�\RXU�RZQ�FXVWRP�ODEHO��7KLV�LV�DOVR�ZKHUH��DV�QRWHG�
DERYH��\RX�FDQ�QRWLI\�VRPHRQH�DERXW�\RXU�FXUUHQW�ORFDWLRQ�DQG�UHPRYH�IROORZHUV�

Tap Account on the Me�VFUHHQ�WR�DFFHVV�D�QXPEHU�RI�DFFRXQW�UHODWHG�VHWWLQJV��ΖQ�DGGLWLRQ�WR�WKH�DIRUHPHQ-
tioned setting for choosing the device to track, you can choose which of the email addresses you’ve configured 
on Apple’s website appears in requests you send to friends, decide whether you want to enable geofence alerts 
IRU�WHPSRUDU\�HYHQWV��DQG�YLHZ�)LQG�0\�)ULHQGȇV�+HOS�GRFXPHQWDWLRQ�

http://appleid.apple.com
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RESTRICT FRIENDS
ΖI�\RX�KDYH�D�FKLOG�DQG�ZDQW�WR�FRQWURO�ZKDW�VKH�FDQ�DQG�FDQȇW�GR�XVLQJ�)LQG�0\�)ULHQGV��\RX�FDQ�XVH�L26ȇV�5HVWULFWLRQV�
�IRXQG�LQ�Settings > General > Restrictions��WR�SUHYHQW�DQ\�FKDQJHV�WR�)LQG�0\�)ULHQGV�VHWWLQJV��DV�ZHOO�DV�WR�WKH�FXUUHQW�
IULHQGV�OLVW��-XVW�HQDEOH�UHVWULFWLRQV��LI�WKH\�DUHQȇW�DOUHDG\�HQDEOHG���SURYLGH�D�IRXU�GLJLW�SDVVFRGH��LI�QHFHVVDU\��VFUROO�
down to the Allow Changes section and tap Find My Friends; and tap Don’t Allow Changes.

Back to My Mac

%DFN�WR�0\�0DF�LV�D�OLIHVDYHU�LI�\RX�HYHU�QHHG�WR�ZRUN�RQ�D�ILOH�RQ�\RXU�FRPSXWHU�ZKHQ�LWȇV�ORFDWHG�IDU�DZD\��7KH�
service performs the nifty magic of letting you remotely access other computers you own over a local network 
RU�WKH�ΖQWHUQHW�E\�JDLQLQJ�DFFHVV�WR�LWV�VKDUHG�YROXPHV�DQG�FRQWUROOLQJ�LWV�VFUHHQ�

CHECK THAT BOX If you don’t have the Back to My Mac checkbox enabled on your home 
computer, you won’t be able to access your files remotely.

The service is very simple to set up: All you should need to do is select the Back to My Mac�FKHFNER[�LQ�L&ORXGȇV�
SUHIHUHQFH�SDQH��:H�VKRXOG�QRWH�WKDW�%DFN�WR�0\�0DF�FDQ�RFFDVLRQDOO\�UXQ�LQWR�WURXEOH�LI�\RXU�FRPSXWHU�LV�
behind a firewall or is using an older wireless router; you may have to change a port number or two first to get 
LW�ZRUNLQJ���$SSOH�KDV�D�JUHDW�DUWLFOH�ZLWK�WURXEOHVKRRWLQJ�WLSV available on its website��

ACCESSING YOUR MAC So you’re far from home or office and you want to grab a file—or, even better, access 
WKH�FRPSXWHU�VFUHHQ�LWVHOI��+RZ�GR�\RX�JR�DERXW�GRLQJ�WKLV"

)LUVW�WKLQJV�ILUVW��7KH�0DF�\RXȇUH�XVLQJ�PXVW�EH�ORJJHG�LQWR�WKH�VDPH�L&ORXG�DFFRXQW�DV�WKH�DFFRXQW�\RX�KDYH�
DFWLYH�RQ�\RXU�0DF�DW�KRPH��7KH�HDVLHVW�ZD\�WR�PDQDJH�WKLV�LV�WR�WUDYHO�ZLWK�D�0DF�WKDW�XVHV�WKH�VDPH�L&ORXG�
DFFRXQWȃD�ODSWRS��IRU�LQVWDQFH��ΖI�ERWK�FRPSXWHUV�DUH�ORJJHG�LQWR�L&ORXG�DQG�KDYH�%DFN�WR�0\�0DF�HQDEOHG��
\RX�VKRXOG�VHH�\RXU�FRPSXWHUȇV�QDPH�SRS�XS�LQ�WKH�VLGHEDU�RI�WKH�)LQGHU�ZLQGRZ��XQGHU�6KDUHG��)URP�WKHUH��
\RX�FDQ�FKRRVH�ZKHWKHU�WR�JHW�ILOHV�RU�VFUHHQ�VKDUH�ZLWK�LW�

8QIRUWXQDWHO\��KDYLQJ�D�VHFRQG�FRPSXWHU�RI�\RXU�RZQ�DURXQG�LV�QRW�DOZD\V�DQ�RSWLRQ��$QG�DV�WKHUHȇV�QR�ZD\�
to get files or view your screen from your iOS devices; if you want to access your files, you’ll need to access 
DQRWKHU�0DF�VRPHKRZ��ΖI�\RXȇUH�WUDYHOLQJ�ZLWKRXW�D�VHFRQG�FRPSXWHU��\RX�KDYH�WZR�RSWLRQV��ERUURZ�D�0DF�
UXQQLQJ�26�;�������LI�\RXȇUH�VWD\LQJ�ZLWK�D�IULHQG�ZKR�KDV�RQH��RU�YLVLW�WKH�$SSOH�6WRUH�

http://support.apple.com/kb/HT4907
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WHEN BACK TO MY MAC WON’T WORK
:KLOH�%DFN�WR�0\�0DF�LV�ZRQGHUIXO�ZKHQ�LW�ZRUNV��LW�GRHVQȇW�DOZD\V�GR�VR��7KLV�LV�LQ�SDUW�GXH�WR�$SSOHȇV�URXWHU�DQG�
network setting requirements; if your Back to My Mac connection is acting up, our own Chris Breen has a great article 
to help you troubleshoot��(LWKHU�ZD\��LI�\RX�NQRZ�DKHDG�RI�WLPH�WKDW�\RX�PLJKW�QHHG�WR�FRQQHFW�WR�\RXU�FRPSXWHU�DW�
KRPH��LWȇV�DOZD\V�SUXGHQW�WR�WHVW�\RXU�VHWXS�LI�SRVVLEOH�EHIRUH�WDNLQJ�RII�RQ�D�WULS�

ΖI�\RXU�IULHQG�KDV�VXFK�D�0DF��WKH�HDVLHVW�PHWKRG�LV�WR�ORJ�LQ�WR�KHU�FRPSXWHU�DV�D�JXHVW��26�;�RIIHUV�D�VSHFLDO�
guest user account: When you log in, it presents itself as a brand-new user install, and it erases all data when 
\RX�ORJ�RXW�

7R�ORJ�LQ�WR�WKH�JXHVW�XVHU�DFFRXQW��KDYH�\RXU�IULHQG�ILUVW�XQFKHFN�%DFN�WR�0\�0DF�LQ�KHU�L&ORXG�SUHIHUHQFHV��LI�
VKH�KDV�DQ�L&ORXG�DFFRXQW���WKHQ�ORJ�RXW�RI�KHU�DFFRXQW�DQG�UHWXUQ�\RX�WR�WKH�ORJLQ�VFUHHQ���<RX�VKRXOG�VHH�D�
Guest User button there; if not, have your friend double-check to see if the guest user profile is set up in the  
8VHUV�	�*URXSV�SUHIHUHQFH�SDQH��$SSOH�DOVR�RIIHUV�D�KDQG\�WXWRULDO�IRU�VHWWLQJ�XS�WKH�DFFRXQW on its website��

2QFH�\RXȇYH�VXFFHVVIXOO\�ORJJHG�LQ��JR�WR�WKH�L&ORXG�SUHIHUHQFH�SDQH�DQG�HQWHU�\RXU�$SSOH�Ζ'�DQG�SDVVZRUG��
�.HHS�\RXU�IULHQG�QHDUE\��EHFDXVH�\RXȇOO�QHHG�KHU�WR�HQWHU�WKH�DGPLQLVWUDWRU�SDVVZRUG�IRU�\RX�LQ�D�PRPHQW���

NO CHECKING Uncheck both of these sync boxes to keep iCloud from needlessly 
downloading data to your guest account.

When iCloud asks if you want to sync your iCloud information with your computer, you can say no and uncheck 
ERWK�ER[HV��WKLV�ZLOO�NHHS�L&ORXG�IURP�WU\LQJ�WR�XSGDWH�WKH�JXHVW�XVHU�DSSV�ZLWK�\RXU�L&ORXG�LQIRUPDWLRQ��2QFH�
you get to the main iCloud screen, select the Back to My Mac�FKHFNER[�

http://www.macworld.com/article/2019272/when-back-to-my-mac-wont.html
http://www.macworld.com/article/2019272/when-back-to-my-mac-wont.html
http://support.apple.com/kb/PH6419
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$W�WKLV�SRLQW��WKH�FRPSXWHU�PD\�SURPSW�\RX�IRU�DGPLQLVWUDWRU�DFFHVV��1RZ�\RX�QHHG�\RXU�IULHQG�WR�HQWHU�WKH�
DGPLQ�SDVVZRUG�DQG�DXWKRUL]H�%DFN�WR�0\�0DF�

Assuming your friend has disabled Back to My Mac on her account, this should now let you access your faraway 
FRPSXWHUȇV�ILOHV��:KHQ�\RXȇUH�GRQH��MXVW�ORJ�RXW�RI�WKH�JXHVW�DFFRXQWȃWKLV�GHOHWHV�\RXU�L&ORXG�DFFRXQW�IURP�
\RXU�IULHQGȇV�FRPSXWHU��DQG�VKH�FDQ�ORJ�EDFN�RQ�DQG�JR�DERXW�KHU�EXVLQHVV�

ΖI�\RXȇG�UDWKHU�QRW�LQFRQYHQLHQFH�D�IULHQGȃRU�\RX�GRQȇW�KDYH�D�IULHQG�DORQJ�WR�LQFRQYHQLHQFHȃ\RXU�QH[W�EHVW�
RSWLRQ�LV�WR�GR�\RXU�ZRUN�DW�D�QHDUE\�$SSOH�6WRUH��3RS�LQ��FKRRVH�D�FRPSXWHU��DQG��LQ�WKH�L&ORXG�SUHIHUHQFH�
SDQH��ORJ�LQ�WR�\RXU�L&ORXG�DFFRXQW��&KHFN�WKH�Back to My Mac�ER[��DQG�\RXU�FRPSXWHU�VKRXOG�VKRZ�XS�XQGHU�
WKH�6KDUHG�VLGHEDU�LQ�D�)LQGHU�ZLQGRZ��ΖI�\RX�XVH�WKLV�PHWKRG��EH�VXUH�WR�ORJ�out of your iCloud account before 
OHDYLQJ�WKH�VWRUH��RWKHUZLVH��DQ\RQH�SDVVLQJ�E\�PD\�EH�DEOH�WR�DFFHVV�\RXU�ILOHV�

VIEWING, EDITING, AND DOWNLOADING FILES Once you have Back to My Mac set up and you spot your 
FRPSXWHU�LQ�WKH�VLGHEDU�RI�WKH�)LQGHU�ZLQGRZ��XQGHU�6KDUHG���MXVW�FOLFN�LW��'HSHQGLQJ�RQ�\RXU�KRPH�FRPSXWHUȇV�
security settings, the service will either automatically log you in to your computer with your Apple ID or log you 
LQ�DV�D�JXHVW��HQWHU�\RXU�FRPSXWHUȇV�XVHUQDPH�DQG�SDVVZRUG�WR�JDLQ�IXOO�DFFHVV�WR�\RXU�ILOHV�

FILE RETRIEVER Connect to your computer to access its file system. 

:KLOH�FRQQHFWHG��\RX�FDQ�SHUXVH�WKH�HQWLUHW\�RI�\RXU�FRPSXWHUȇV�ILOHV��.HHS�LQ�PLQG�WKDW�DV�\RXU�FRPSXWHU�LV�
not on your local network, you may not want to open files directly from it, unless you want to work very slowly 
LQGHHG���:H�XVXDOO\�UHFRPPHQG�FRS\LQJ�ILOHV�E\�GUDJJLQJ�WKHP�IURP�\RXU�KRPH�FRPSXWHU�GLUHFWRU\�WR�WKH�
GHVNWRS�DQG�ZRUNLQJ�RQ�WKHP�ORFDOO\���<RX�FDQ�GLVFRQQHFW�IURP�\RXU�FRPSXWHU�DW�DQ\�WLPH�E\�FOLFNLQJ�WKH� 
Disconnect�EXWWRQ�
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SHARE YOUR SCREEN <RXU�RWKHU�RSWLRQ�IRU�DFFHVVLQJ�\RXU�ILOHV�LV�JRLQJ�VWUDLJKW�WR�WKH�VRXUFH��VKDULQJ�\RXU�
KRPH�0DFȇV�VFUHHQ��7R�DFFHVV�LW��VHOHFW�\RXU�FRPSXWHU�IURP�WKH�6KDUHG�VLGHEDU�LQ�WKH�)LQGHU��DQG�WKHQ�FOLFN�WKH�
Share Screen�EXWWRQ��'HSHQGLQJ�RQ�\RXU�VHFXULW\�VHWWLQJV��\RX�PD\�EH�SURPSWHG�WR�HQWHU�\RXU�XVHUQDPH�DQG�
SDVVZRUGȃPDNH�VXUH�\RX�HQWHU�WKH�FRUUHFW�FRPELQDWLRQ�IRU�WKDW�PDFKLQH��

<RXU�UHPRWH�GHVNWRS�ZLOO�WKHQ�DSSHDU�LQ�D�ZLQGRZ��:KHQ�\RXU�FXUVRU�HQWHUV�WKH�ZLQGRZ��LW�EHFRPHV�WKH�FXUVRU�
on the remote Mac, letting you click buttons, drag windows, and interact with the computer just as if you were 
VLWWLQJ�LQ�IURQW�RI�LW�

To take advantage of some of Screen Sharing’s other features, you may need to choose View > Show Toolbar��
)RU�H[DPSOH��LI�\RX�GRQȇW�ZDQW�WR�LQWHUDFW�ZLWK�WKH�UHPRWH�PDFKLQH��\RX�FDQ�FOLFN�WKH�Switch between Control and 
Observe mode�EXWWRQ�LQ�WKH�WRS�OHIW�

FANCY TOOLS The Screen Sharing app allows you to copy information from your home 
computer’s clipboard, take screenshots, and more.

6FUHHQ�VKDULQJ�HYHQ�OHWV�\RX�FRS\�DQG�SDVWH�EHWZHHQ�WKH�FOLHQW�DQG�KRVW�FRPSXWHUV��7R�SDVWH�VRPHWKLQJ�RQ�
WKH�UHPRWH�PDFKLQH��VHOHFW�LW�RQ�\RXU�ORFDO�0DF�DQG�FRS\�LW�WR�\RXU�FOLSERDUG��7KHQ��LQ�WKH�6FUHHQ�6KDULQJ�
toolbar, click the Send clipboard contents to the remote clipboard�EXWWRQ��<RX�FDQ�WKHQ�SDVWH�\RXU�VHOHFWLRQ�RQ�
WKH�UHPRWH�PDFKLQH��<RX�FDQ�HYHQ�SHUIRUP�WKH�SURFHVV�LQ�UHYHUVHȃMXVW�PDNH�VXUH�WR�FOLFN�WKH�Get the remote 
clipboard contents�EXWWRQ�LQVWHDG�

Keep in mind that while you’re in Screen Sharing, most of the keyboard shortcuts you press pass to the remote 
PDFKLQH��6R��IRU�H[DPSOH��LI�\RX�SUHVV��&RPPDQG!�4��WKDW�ZLOO�TXLW�WKH�DSS�LQ�WKH�IRUHJURXQG�RI�WKH�UHPRWH�
PDFKLQH��QRW�WKH�ORFDO�PDFKLQH�

When you’re finished, just close the window, and the Screen Sharing app will shut down and terminate the con-
QHFWLRQ��$IWHU�GRLQJ�VR��GRQȇW�IRUJHW�WR�FOLFN�WKH�Disconnect�EXWWRQ�LQ�WKH�)LQGHU�ZLQGRZ�
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Purchase Management
Within Apple’s new iCloud service, you can sync, back up your devices, and locate friends—but if you want to 
PDQDJH�\RXU�PXVLF�DQG�SXUFKDVHV��ORRN�WR�WKH�VHUYLFHȇV�L7XQHV�LQ�WKH�&ORXG�LQLWLDWLYH��)RU�IUHH��\RX�FDQ�DXWR-
PDWLFDOO\�GRZQORDG�DQ\�QHZ�SXUFKDVHV�DFURVV�DOO�\RXU�GHYLFHV�DQG�DFFHVV�DQ\�SDVW�SXUFKDVHV��VWLOO�DYDLODEOH�
RQ�L7XQHV���SD\�DQ�H[WUD�����D�\HDU��DQG�\RX�FDQ�VWRUH�DQG�VWUHDP�\RXU�PXVLF�RQOLQH�ZLWK�L7XQHV�0DWFK��+HUHȇV�
KRZ�DOO�WKHVH�RSWLRQV�ZRUN�

Automatic Downloads

Both iOS and iTunes include an automatic downloads feature that lets you choose to have your device or 
computer automatically download any music, books, and apps you’ve downloaded on other computers or 
L26�GHYLFHV�

INSTA-DOWNLOAD Turn on Automatic Downloads and new purchases automatically 
appear in your library.

SET UP YOUR MAC OR PC To set up automatic downloads in iTunes, go to Preferences > Store > Automatic 
Downloads��+HUH��\RX�FDQ�LQGLYLGXDOO\�HQDEOH�WKH�GRZQORDGLQJ�RI�PXVLF��DSSV��DQG�ERRNV�SXUFKDVHG�XVLQJ�\RXU�
L7XQHV�Ζ'��&OLFN�WKH�ER[�QH[W�WR�HDFK�RSWLRQ�WKDW�\RX�ZDQW�WR�HQDEOH��DQG�WKHQ�FOLFN�OK.
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SET UP iOS On your iOS device, go to Settings > iTunes & App Stores; under the Automatic Downloads section are 
WKUHH�WRJJOHV�IRU�0XVLF��$SSV��DQG�%RRNV��7KHUHȇV�DOVR�DQ�RSWLRQ�IRU�XVLQJ�FHOOXODU�GDWD�IRU�WKHVH�GRZQORDGVȃLI�
\RXȇUH�RQ�D�GHYLFH�WKDW�VXSSRUWV�LW��7KRXJK�$SSOH�SURKLELWV�\RX�IURP�GRZQORDGLQJ�DQ\WKLQJ�RYHU���0%�ZKLOH�RQ�
cellular data, keeping the cellular data option turned on can occasionally result in going over your data plan’s 
OLPLWV��VR�EH�ZDU\�

One particularly nice use of the automatic downloads feature involves books: Though you can’t read iBooks on 
\RXU�0DF��\RX�FDQ�EURZVH�DQG�SXUFKDVH�WKHP�YLD�L7XQHV��(YHQ�RQ�WKH�L3DGȇV�ODUJH�VFUHHQ��DQ�L26�GHYLFH�LVQȇW�WKH�
best way to search for and look at the vast selection on the iBookstore, so if you set up automatic download-
ing for books on your device, you can find and purchase a book from your computer, and then have it ready to 
UHDG�WKH�QH[W�WLPH�\RX�ODXQFK�L%RRNV�RQ�\RXU�L3DG�

Previously Purchased Content

Another part of iTunes in the Cloud is the ability to redownload previously purchased content and display that 
FRQWHQW�LQ�\RXU�L7XQHV�OLEUDU\�HYHQ�LI�\RX�GRQȇW�KDYH�LW�ORFDOO\�VWRUHG�WKHUH��<RX�FDQ�UHGRZQORDG�PXVLF��ERRNV��
DSSV��PRYLHV��DQG�79�VKRZV�WKDW�\RXȇYH�SXUFKDVHG�IURP�WKH�L7XQHV�6WRUH��$SS�6WRUH��RU�L%RRNVWRUH�LQ�WKH�SDVW��
�1RWH��5HGRZQORDGLQJ�DQG�VWUHDPLQJ�GHSHQGV�RQ�$SSOHȇV�OLFHQVLQJ�DJUHHPHQWV��VR�FHUWDLQ�PHGLD�PD\�QRW�EH�
DYDLODEOH�LQ�\RXU�FRXQWU\��&KHFN�\RXU�ORFDO�L7XQHV�6WRUH�WR�EH�VXUH��

VIEW AND DOWNLOAD CONTENT ON YOUR MAC OR PC $V�RI�L7XQHV���DQ\�FRQWHQW�\RXȇYH�SXUFKDVHG�VKRZV�XS�
LQ�\RXU�L7XQHV�OLEUDU\��\RX�FDQ�VWUHDP�LW�RII�WKH�L7XQHV�VHUYHUV�E\�SOD\LQJ�LW��RU�GRZQORDG�LW�ORFDOO\�WR�\RXU�PDFKLQH�

GIVE IT ANOTHER GO If you want to redownload an old purchase, you can retrieve it 
from the Purchased section of the iTunes Store.

To view all your previously purchased content, click the iTunes Store button, and then click the Purchased link 
XQGHU�WKH�4XLFN�/LQNV�VLGHEDU��2QFH�LQ�WKH�3XUFKDVHG�LQWHUIDFH��\RXȇOO�VHH�0XVLF��0RYLHV��79�6KRZV��$SSV��DQG�
%RRNV�WDEV�DFURVV�WKH�WRS��&OLFN�DQ\�RI�WKHP�WR�VHH�WKH�FRQWHQW�DYDLODEOH�WR�\RX��\RX�FDQ�GLIIHUHQWLDWH�EHWZHHQ�
DOO�SUHYLRXVO\�SXUFKDVHG�FRQWHQW��DV�ZHOO�DV�FRQWHQW�QRW�RQ�WKLV�FRPSXWHU�
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HIDE UNWELCOME PURCHASES
If you bought an item you no longer wish to see in your purchased list, you can mouse over it and click the X button 
WKDW�DSSHDUV��<RX�FDQ�UHVWRUH�KLGGHQ�WUDFNV�DQG�LWHPV�E\�FOLFNLQJ�WKH�Account button in iTunes, clicking View Hidden 
Purchases, and then selecting Unhide�QH[W�WR�WKH�SXUFKDVHV�\RX�ZLVK�WR�DGG�EDFN�WR�\RXU�L7XQHV�LQ�WKH�&ORXG�OLEUDU\��
�7KHUHȇV�QR�ZD\�WR�SHUPDQHQWO\�GHOHWH�D�KLGGHQ�WUDFN��

7R�GRZQORDG�DQ�LWHP��FOLFN�WKH�FORXG�LFRQ�QH[W�WR�D�VRQJ��DOEXP��PXVLF�YLGHR��PRYLH��79�VKRZ��DSS��RU�ERRN�WR�
EHJLQ�WKH�GRZQORDG�SURFHVV��<RX�FDQ�DOVR�GRZQORDG�DOO�\RXU�PXVLF�RU�LQGLYLGXDO�79�VKRZ�VHDVRQV�E\�XVLQJ�WKH�
Download All�EXWWRQ�

VIEW AND DOWNLOAD CONTENT ON iOS On your iOS devices, the redownload process is fragmented by 
DSS��)RU�PXVLF�DQG�YLGHRV��ODXQFK�WKH�L7XQHV�6WRUH�DSS�DQG�WDS�WKH�Purchased�EXWWRQ�DW�WKH�ERWWRP��RU��RQ�DQ�
iPhone, tap More > Purchased���)URP�WKHUH��FKRRVH�EHWZHHQ�0XVLF��0RYLHV��DQG�79�6KRZV��YLD�D�SRS�XS�PHQX�
RQ�WKH�L3DG�RU�IURP�WKH�3XUFKDVHG�VFUHHQ�RQ�WKH�L3KRQH���$V�ZLWK�L7XQHV��\RX�FDQ�FKRRVH�EHWZHHQ�$OO�DQG�1RW�
2Q�7KLV�L3KRQH��RU�L3RG�RU�L3DG��GHSHQGLQJ�RQ�ZKDW�GHYLFH�\RXȇUH�XVLQJ���XVH�WKH�FORXG�LFRQ�WR�GRZQORDG�

)RU�DSSV��ODXQFK�WKH�$SS�6WRUH�DSS��7DS�WKH�Purchased�EXWWRQ��L3DG��RU�Updates > Purchased�DW�WKH�WRS��L3KRQH��
WR�YLHZ�SUHYLRXVO\�GRZQORDG�DSSV�E\�GRZQORDG�GDWH��QHZHVW�ILUVW���+HUH��WRR��\RX�FDQ�VHH�DOO�DSSV�RU�MXVW�WKRVH�
\RX�KDYHQȇW�LQVWDOOHG��$QG�RQ�WKH�L3DG��\RX�FDQ�FKRRVH�EHWZHHQ�YLHZLQJ�L3DG�VSHFLILF�DQG�XQLYHUVDO�DSSV��DQG�
L3KRQH�RQO\�DSSV��7DS�WKH�LFRQ�WR�GRZQORDG�

iBooks is unique among its media brethren in that it displays your purchased books within the app itself, under 
WKH�3XUFKDVHG�%RRNV�FROOHFWLRQ��WDS�WKH�Collections bar at the top and tap Purchased Books�WR�YLHZ���%RRNV�WKDW�
DUHQȇW�RQ�\RXU�GHYLFH�VKRZ�XS�ZLWK�D�FORXG�LFRQ�RQ�WKHLU�XSSHU�ULJKW�FRYHU��WDS�RQH�WR�GRZQORDG�LW���<RX�FDQ�
also go to Store > Purchased���L%RRNV�DOVR�RIIHUV�L&ORXG�SDJH�V\QFLQJȃVWDUW�D�ERRN�RQ�RQH�GHYLFH��DQG�ZKHQ�\RX�
GRZQORDG�LW�RQ�DQRWKHU�GHYLFH��LW�RSHQV�WR�WKH�FRUUHFW�SDJH�

VIEW CONTENT ON THE APPLE TV One other advantage of the iTunes in the Cloud functionality is that the 
second-generation Apple TV can stream your previously purchased music, movies, and TV shows rather than 
KDYLQJ�WR�ORFDOO\�VWRUH�WKHP��2QFH�\RX�ORJ�LQ�ZLWK�\RXU�$SSOH�Ζ'�DQG�SDVVZRUG�RQ�\RXU�$SSOH�79��\RX�VKRXOG�
KDYH�IXOO�DFFHVV�WR�\RXU�OLEUDU\�

iTunes Match

3HUKDSV�QR�SDUW�RI�$SSOHȇV�L7XQHV�LQ�WKH�&ORXG�LQLWLDWLYH�KDV�SURPSWHG�DV�PXFK�LQWHUHVW�DV�L7XQHV�0DWFK��<RX�
could attribute that to a number of factors, including Apple’s industry-dominating music store, iTunes Match’s li-
EUDU\�PDWFKLQJ�V\VWHP��DQG�WKH�IXQGDPHQWDO�LQWHJUDWLRQ�ZLWK�DOO�RI�$SSOHȇV�GHYLFHV��%XW�LQ�JHQHUDO��LW�PD\�EH�WKH�
LGHD�RI�KDYLQJ�\RXU�PXVLF�HYHU\ZKHUH��DOZD\V�DW�\RXU�ILQJHUWLSV��WKDW�KDV�UHDOO\�FDSWXUHG�WKH�LQWHUHVW�RI�XVHUV�
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WHAT IS IT? iTunes Match allows you to easily stream up to 25,000 tracks of your music collection to any of 
\RXU�GHYLFHVȃDQG�\RX�FDQ�GRZQORDG�WKRVH�WUDFNV�WR�DQ\�RI�\RXU�FRPSXWHUV�RU�L26�GHYLFHV��ΖQ�DGGLWLRQ��LI�\RX�
have low-quality tracks or DRM-shackled tunes from iTunes of old, iTunes Match automatically upgrades them 
WR�D�����NESV�'50�IUHH�KLJK�TXDOLW\�$$&�YHUVLRQ�

A MATCH MADE IN iCLOUD iTunes Match lets you upload and match all your old ripped 
tracks and stream them from any of your iCloud-enabled devices.

L7XQHV�0DWFK�LV�D�SDLG�DGGLWLRQ�WR�$SSOHȇV�L&ORXG�RQOLQH�VHUYLFH��<RXȇOO�KDYH�WR�SRQ\�XS�����SHU�\HDU�YLD�\RXU�
L7XQHV�DFFRXQW�IRU�WKH�IHDWXUH��

That accounts for the iTunes part, but what about the Match? Instead of making you upload all those tracks 
you’ve downloaded, as competing services from Google and Amazon do, iTunes scans your library and com-
SDUHV�WKH�WUDFNV�WR�WKH�L7XQHV�6WRUHȇV�FDWDORJ��ΖI�LW�FDQ�PDWFK�D�VRQJ�LQ�\RXU�OLEUDU\�ZLWK�D�WUDFN�IURP�WKH�L7XQHV�
6WRUH��L7XQHV�0DWFK�GRHVQȇW�ERWKHU�XSORDGLQJ�WKH�PXVLF�ILOHȃZKLFK�VDYHV�\RX�WLPH�DQG�EDQGZLGWK�

Of course, you may have some tracks in your library that aren’t available in the iTunes Store; in that case, iTunes 
ZLOO�XSORDG�MXVW�WKRVH�ILOHV��1HLWKHU�PDWFKHG�WUDFNV�QRU�XSORDGHG�WUDFNV�FRXQW�DJDLQVW�WKH��*%�RI�VWRUDJH�WKDW�
L&ORXG�SURYLGHV�WR�HYHU\�XVHU��KRZHYHU�

Still, iTunes Match has its limits: As many music listeners with large libraries have noted, if your library contains 
more than 25,000 songs that haven’t been purchased from the iTunes Store, you won’t be able to sign up for 
L7XQHV�0DWFK�ZLWKRXW�GRLQJ�VRPH�IDQF\�IRRWZRUN�
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SET UP iTUNES MATCH The initial setup of iTunes Match takes place right on your Mac—you’ll need iTunes 
�����RU�ODWHU�WR�JHW�VWDUWHG��2SHQ�L7XQHV�DQG�JR�WR�Store > Turn On iTunes Match, and then follow the onscreen 
LQVWUXFWLRQV�

MATCHMAKER, MATCHMAKER After you sign up for iTunes Match, it scans your library, 
matching and uploading songs.

2QFH�\RXȇYH�HQDEOHG�L7XQHV�0DWFK��$SSOH�VWDUWV�VFDQQLQJ�\RXU�OLEUDU\��7KLV�SURFHVVȃDQG�WKH�VXEVHTXHQW� 
uploading of any unmatched tracks—can take a while, but since it happens in the background, you can continue 
MDPPLQJ�WR�\RXU�PXVLF�LQ�WKH�PHDQWLPH��1RWH�WKDW�\RX�FDQȇW�UXQ�WKH�0DWFK�SURFHVV�RQ�PXOWLSOH�FRPSXWHUV�
simultaneously, so don’t start matching tracks on a second computer until the first one has completely finished 
UXQQLQJ�WKH�VFDQ�

$IWHU�L7XQHV�KDV�ILQLVKHG�LWV�VFDQQLQJ�DQG�XSORDGLQJ�SURFHVV��D�FORXG�LFRQ�DSSHDUV�QH[W�WR�WKH�0XVLF�LWHP�LQ�
\RXU�L7XQHV�VLGHEDU��DQG�D�FROXPQ�KHDGLQJ�ZLWK�WKH�VDPH�LFRQ�LV�DGGHG�WR�\RXU�OLEUDU\��7KLV�FROXPQ�VKRZV�D�OLW-
WOH�FORXG�GRZQORDG�LFRQ�IRU�VRQJV�VWRUHG�LQ�WKH�FORXGȃORFDOO\�VWRUHG�WUDFNV�ZRQȇW�KDYH�DQ\WKLQJ�LQ�WKLV�FROXPQ�

<RX�FDQ�DOVR�HQDEOH�DQ�L&ORXG�6WDWXV�FROXPQ�E\�ULJKW�FOLFNLQJ�WKH�FROXPQ�KHDGHU�RU�E\�JRLQJ�WR�View > View  
Options and selecting iCloud Status; that column tells you whether a track has already been matched, is waiting 
IRU�D�PDWFK��LV�D�GXSOLFDWH�RI�D�PDWFKHG�VRQJ��LV�LQHOLJLEOH��DV�LV�WKH�FDVH�IRU�GLJLWDO�ERRNOHWV��IRU�H[DPSOH��RU�
certain types of audio files), has been removed from one of your devices, or is a track that you purchased from 
WKH�L7XQHV�6WRUH�

If you download songs from iTunes Match to your computer, their Kind will be listed as ‘Matched AAC file’; that’s 
EHFDXVH�L7XQHV�0DWFK�XSJUDGHV�DQ\�PDWFKHG�WUDFNV�WR�KLJK�TXDOLW\�����NESV�$$&�ILOHV��$V�ZLWK�DQ\�WUDFN�SXU-
FKDVHG�IURP�WKH�L7XQHV�6WRUH��PHWDGDWD�ZLWK�\RXU�DFFRXQW�QDPH�ZLOO�EH�HPEHGGHG�ZLWKLQ�WKH�ILOH�
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MATCH FOR iOS 7KH�UHDO�XVHIXOQHVV�RI�L7XQHV�0DWFK�FRPHV�ZKHQ�\RX�DFWLYDWH�LW�RQ�\RXU�L26�GHYLFHV��7R� 
enable it, go to Settings > Music and toggle the iTunes Match slider to On. Though iOS warns you that this will  
replace your Music library, any tracks that are already on the device—because you’ve synced them from 
L7XQHVȃZLOO�UHPDLQ�VWRUHG�ORFDOO\�RQ�\RXU�GHYLFH���ΖI�\RX�GLVDEOH�L7XQHV�0DWFK�DJDLQ��WKRVH�WUDFNV�VKRXOG�
UHPDLQ�LQWDFW���$V�RQ�\RXU�0DF��DOEXPV�LQ�\RXU�L26�GHYLFHȇV�PXVLF�OLEUDU\�WKDW�DUH�VWRUHG�LQ�WKH�FORXG�ZLOO�QRZ�
IHDWXUH�D�GRZQORDG�LFRQ�

After you’ve enabled iTunes Match, any music you’ve purchased from the iTunes Store is automatically available 
WR�DOO�RI�\RXU�GHYLFHV��UHJDUGOHVV�RI�ZKHWKHU�LWȇV�FXUUHQWO\�VWRUHG�RQ�\RXU�GHYLFHV�

USING iTUNES MATCH Thanks to the integration between iTunes on your Mac and PC and the Music app on 
L26��WKHUHȇV�YHU\�OLWWOH�GLIIHUHQFH�EHWZHHQ�L7XQHV�0DWFK�WUDFNV�\RX�KDYHQȇW�GRZQORDGHG�DQG�WKRVH�\RX�KDYH��
)RU�WUDFNV�VWRUHG�LQ�WKH�FORXG��\RX�PLJKW�QRWLFH�D�EULHI�SDXVH�EHWZHHQ�WKH�PRPHQW�ZKHQ�\RX�WDS�D�VRQJ�DQG�
the start of playback, or when you’re skipping between songs, but other than that, they ought to behave pretty 
PXFK�H[DFWO\�OLNH�ORFDOO\�VWRUHG�VRQJV��<RX�FDQ�VRUW�WKHP��VHDUFK�WKHP��EURZVH�E\�DOEXP�DQG�DUWLVW��DQG�HYHQ�
GUDJ�WUDFNV�LQWR�SOD\OLVWV�RU�XVH�*HQLXV�WR�ILQG�VLPLODU�VRQJV�

2Q�\RXU�L3KRQH�RU�FHOOXODU�HQDEOHG�L3DG��\RX�FDQ�HLWKHU�FRQILJXUH�L7XQHV�0DWFK�WR�ZRUN�RQO\�RYHU�:L�)L��RU�
choose to let music stream over cellular data by visiting Settings > Store and enabling Use Cellular Data��ΖI�\RX�WU\�
to play a track over cellular without this option enabled, you’ll get an error message that invites you to enable 
WKH�FHOOXODU�GDWD�RSWLRQ�

ΖI�\RX�GRQȇW�ZDQW�WR�GHSHQG�RQ�KDYLQJ�D�QHWZRUN�FRQQHFWLRQ��\RX�FDQ�GRZQORDG�WUDFNV�WR�\RXU�GHYLFH��-XVW�WDS�WKH�
FORXG�GRZQORDG�LFRQ�QH[W�WR�DQ\�DUWLVW�RU�DOEXP��DQG�L7XQHV�DXWRPDWLFDOO\�VWDUWV�WUDQVIHUULQJ�WKH�PXVLF�WR�\RXU�
iOS device; on your Mac or PC, you can also select multiple tracks, control-click them, and choose Download. If you 
decide at some point that you need to free up some space on your device, you can delete the songs from your 
OLEUDU\�E\�JRLQJ�WR�L7XQHV��VHOHFWLQJ�WKH�WUDFNV�DQG�SUHVVLQJ�WKH��'HOHWH!�NH\��7KH�FORXG�GRZQORDG�LFRQ�ZLOO�RQFH�
DJDLQ�DSSHDU�QH[W�WR�WKH�VRQJV��EXW�\RXȇOO�VWLOO�EH�DEOH�WR�SOD\�WKHP�EDFN���ΖI�\RX�ZDQW�WR�GHOHWH�WKH�VRQJ�IURP�ERWK�
\RXU�FRPSXWHU�DQG�L&ORXG��SUHVV�WKH��'HOHWH!�NH\��DQG�WKHQ�FKHFN�WKH�Also delete this item from iCloud�ER[��

In cases where you know you won’t have access to your online music library for a while—say you’re on a lengthy 
plane trip—you can make your iOS device show only those tracks stored on it by going to Settings > Music and 
switching the Show All Music option to Off��2Q�\RXU�FRPSXWHU��\RX�FDQ�JR�WR�View > Hide Music Not On This Com-
puter�WR�JHW�WKH�VDPH�HIIHFW�

Because iTunes Match syncs with the music library on your Mac, any playlists you’ve created in that library get 
synced with your devices as well; if you’ve created playlists on your iOS device, you need to sync those with 
\RXU�PXVLF�OLEUDU\�EHIRUH�HQDEOLQJ�0DWFK�RQ�WKDW�GHYLFH��RWKHUZLVH��WKH\�ZLOO�EH�UHPRYHG�IURP�WKH�GHYLFH��
L7XQHV�0DWFK�ZLOO�LQVWDQWO\�V\QF�DQ\�FKDQJHV�\RX�PDNH�WR�WKRVH�SOD\OLVWV�EHWZHHQ�DOO�0DWFKHG�GHYLFHV��3OD\OLVWV�
that contain media types other than music—including voice memos, digital booklets, and so on—will not sync 
EHWZHHQ�GHYLFHV�

If for some reason a track doesn’t correctly sync with iTunes Match, you can right-click it and select Add to 
iCloud�WR�DGG�LW�PDQXDOO\��'HSHQGLQJ�RQ�WKH�W\SH�RI�HUURU��KRZHYHU��WKLV�PD\�QRW�DOZD\V�ZRUN��IRU�H[DPSOH��
LI�0DWFK�GRHVQȇW�VXSSRUW�WKH�VRQJȇV�ILOH�W\SH���)RU�PRUH�RQ�0DWFK�HUURUV��VHH�ȊiTunes Matchȋ�LQ�WKH�Ȋ7URXEOH-
VKRRW�L&ORXGȋ�FKDSWHU�
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THE TROUBLE WITH THE CLOUD Even the best services run into trouble now and again.

ΖWȇV�D�IDFW�RI�OLIH��7HFKQRORJ\�EUHDNVȃHYHQ�WHFKQRORJ\�DV�SK\VLFDOO\�LQWDQJLEOH�DV�L&ORXG��ΖI�\RXȇYH�UXQ�LQWR�HUURUV�
ZLWK�\RXU�L&ORXG�DFFRXQW��V\QFLQJ��3KRWR�6WUHDP��EDFNXSV��RU�L7XQHV�0DWFK��ZH�KRSH�WKLV�FKDSWHU�KHOSV�\RX�IL[�
\RXU�SUREOHP�

WHEN TO GO TO THE EXPERTS
While this guide attempts to answer basic questions and provide troubleshooting help for most simple problems, don’t 
EH�DIUDLG�WR�VHHN�RXW�WKH�SURIHVVLRQDOV�IRU�D�WRXJKHU�SUREOHP��6\QFLQJ�LVVXHV�FDQ�VRPHWLPHV�JHW�QDVW\��DQG�VLPSOH�
VROXWLRQV�PD\�QRW�DOZD\V�ZRUN��ΖI�WKLV�KDSSHQV��WKH�IRONV�DW�\RXU�Apple Store are always happy to try and help; you can 
also try going through Apple’s online support system�

C H A P T E R  3

http://www.apple.com/retail
http://apple.com/support/
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Accounts
While Apple’s iCloud service offers users a whole wealth of new sync features, access to purchased content, 
and geolocation fun, running into account creation problems can be confusing at best, slam-your-head-against-
D�ZDOO�LQ�IUXVWUDWLRQ�DW�ZRUVW��7R�KHOS�HDVH�WKH�SDLQ��DQG�NHHS�\RXU�ZDOOV�GHQW�IUHH���ZHȇYH�SXW�WRJHWKHU�VRPH�
FRPPRQ�XSJUDGLQJ�VFHQDULRV�IRU�PLJUDWLQJ�WR�L&ORXG�

The Basics

:H�KDYH�D�IHZ�VSHFLILF�DFFRXQW�EDVHG�VFHQDULRV�EHORZ��EXW�EHIRUH�ZH�JR�RQ��KHUH�DUH�D�IHZ�JHQHUDO�WLSV�

IF YOU HAVE AN APPLE ID THAT YOU WANT TO USE FOR SYNC AND PURCHASES�&RQYHUW�LW�WR�L&ORXG��ΖI�\RX�
XVHG�\RXU�$SSOH�Ζ'�IRU�RQH�RI�$SSOHȇV�ROGHU�V\QF�VHUYLFHV��\RX�PD\�DOVR�KDYH�DFWLYH�PH�FRP�DQG�PDF�FRP� 
DFFRXQWV��:KLOH�\RX�VKRXOG�JHW�LQ�WKH�KDELW�RI�XVLQJ�H[DPSOH#LFORXG�FRP��GRQȇW�ZRUU\��<RX�FDQ�VWLOO�XVH�\RXU�
�PH�DQG��PDF�HPDLO�DGGUHVVHV�

IF YOU WANT TO SYNC WITH ONE ID AND PURCHASE WITH ANOTHER Convert one to iCloud; use the other 
WR�ORJ�LQ�WR�WKH�L7XQHV�DQG�$SS�6WRUHV�

IF YOU WANT TO SYNC WITH MULTIPLE IDS Hook up your primary account to your device; add a secondary 
account for calendar and contacts syncing using the Mail, Contacts & Calendars pane in System Preferences on 
\RXU�0DF�RU�WKH�6HWWLQJV�DSS�RQ�\RXU�L26�GHYLFH�

Hardware and Software Scenarios

%\�GHIDXOW��L&ORXG�VXSSRUWV�GHYLFHV�UXQQLQJ�L26���RU�ODWHU��0DFV�UXQQLQJ�26�;�/LRQ�RU�ODWHU��DQG�3&V�UXQQLQJ�
:LQGRZV�9LVWD�RU�ODWHU��%XW�ZKDW�LI�\RXȇUH�VWLOO�UXQQLQJ�6QRZ�/HRSDUG�RU�L26��"

WHAT IF I UPGRADE TO iCLOUD AND I’M STILL RUNNING SNOW LEOPARD (OR LEOPARD)? As Apple has yet 
to release a patch for its earlier operating systems that enables iCloud in System Preferences, you won’t be able 
to automatically sync your iCloud mail, contacts, and calendars, though you can set up sync for your mail and 
FDOHQGDUV�E\�PDQXDOO\�DGGLQJ�\RXU�L&ORXG�DFFRXQW�WR�0DLO��VHH�ȊSyncing” later in this chapter for more informa-
WLRQ���<RXȇOO�DOVR�EH�DEOH�WR�DFFHVV�L&ORXG�IHDWXUHV�YLD�WKH�L&ORXG�ZHEVLWH��:KHQ�LW�FRPHV�WR�IHDWXUHV�OLNH�'RFX-
PHQWV�LQ�WKH�&ORXG��3KRWR�6WUHDP��DQG�)LQG�0\�0DF��KRZHYHU��\RXȇOO�EH�OHIW�RXW�LQ�WKH�FROG�

WHAT IF I UPGRADE TO iCLOUD ON MY MAC OR PC, BUT I’M STILL RUNNING iOS 4 ON MY IPHONE? If you 
KDYH�D�GHYLFH�WKDWȇV�VWLOO�UXQQLQJ�L26����\RXȇOO�EH�DEOH�WR�DFWLYDWH�)LQG�0\�device by adding a MobileMe account 
with your iCloud credentials under Settings > Mail, Contacts, Calendars, but you’ll need to set up your iCloud mail, 
FRQWDFWV��DQG�FDOHQGDUV�PDQXDOO\��ZKLFK�UHTXLUHV�D�ELW�RI�OHJZRUN��WKLV�EORJ�E\�%ULDQ�/L�has some great tips 
DERXW�KRZ�WR�JR�DERXW�GRLQJ�LW���$V�ZLWK�L&ORXG�RQ�6QRZ�/HRSDUG��LWȇV�QRW�WKH�HDVLHVW�VHWXS��EXW�LWȇV�GRDEOH��

http://bwhli.com/configuring-icloud-for-ios4/
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Single-User Setup Scenarios

ΖI�\RXȇUH�ORRNLQJ�WR�VLJQ�XS�\RXUVHOIȃDQG�\RXUVHOI�RQO\ȃIRU�L&ORXG��KHUH�DUH�YDULRXV�VFHQDULRV�\RX�PD\�UXQ�LQWR�

YOU HAVE NEVER PURCHASED ANYTHING FROM APPLE (BESIDES THIS BRAND-NEW DEVICE YOU NOW 
HAVE IN YOUR HANDS), YOU DON’T KNOW WHAT AN APPLE ID IS, AND YOU WANT TO SIGN UP FOR A 
FREE iCLOUD ACCOUNT *UHDW��<RX�FDQ�GR�WKLV�LQ�RQH�RI�WZR�ZD\V��6LJQ�XS�IURP�D�PRELOH�GHYLFH�UXQQLQJ�L26���
RU�ODWHU��RU�VLJQ�XS�YLD�WKH�L&ORXG�SUHIHUHQFH�SDQH�RQ�D�0DF�UXQQLQJ�26�;�������RU�ODWHU���6HH�ȊSet Up iCloud” in 
WKH�Ȋ*HW�6WDUWHGȋ�FKDSWHU�IRU�PRUH�LQIRUPDWLRQ��

YOU HAVE AN APPLE ID YOU USE FOR PURCHASING ITEMS THAT YOU ALSO WANT TO USE FOR iCLOUD 
Convert it to iCloud by logging in to the iCloud website with your Apple ID; you can also do this by logging in 
WR�L&ORXG�RQ�\RXU�L26�GHYLFH�RU�0DF���2Q�DQ�L26�GHYLFH��JR�WR�Settings > iCloud; on a Mac, go to System Prefer-
ences > iCloud.)

YOU CREATED AN iCLOUD ACCOUNT FOR SYNCING, BUT YOU ALSO HAVE A SEPARATE APPLE ID FOR PUR-
CHASES If you don’t want to convert your Apple ID into an iCloud account—possibly to keep your sync data and 
\RXU�SXUFKDVH�GDWD�VHSDUDWHȃ\RX�FDQ�KDYH�WZR�FRH[LVWLQJ�DFFRXQWV�RQ�\RXU�0DF��3&��DQG�L26�GHYLFHV��$IWHU�
\RX�VHW�XS�\RXU�L&ORXG�DFFRXQW��MXVW�DGG�\RXU�L7XQHV�6WRUH�FUHGHQWLDOV�VHSDUDWHO\��

On a Mac or PC, open iTunes, go to Store > Log In, and HQWHU�WKH�$SSOH�Ζ'�DQG�SDVVZRUG�\RX�XVH�IRU�SXUFKDVHV�

On an iOS device, go to Settings > iTunes & App Stores. If you’ve added your iCloud account to your device, those 
credentials appear by default; to replace them with the Apple ID you use for purchases, tap your iCloud ID at 
the top of the screen and then tap Sign Out.�2QFH�\RXȇYH�VLJQHG�RXW��\RX�FDQ�ORJ�EDFN�LQ�ZLWK�WKH�VHFRQGDU\�Ζ'�

YOU WANT TO CHANGE YOUR APPLE ID TO A DIFFERENT EMAIL ADDRESS If you already have an Apple ID 
but want to use a different email address, it’s easy to do from Apple’s website��

On the My Apple ID website, click the Manage your Apple ID EXWWRQ��$IWHU�ORJJLQJ�LQ�ZLWK�\RXU�$SSOH�Ζ'�DQG�SDVV-
word, click the Sign In�EXWWRQ��ΖI�\RX�KDYH�DQ\WKLQJ�EXW�D�PDF�FRP��PH�FRP��RU�LFORXG�FRP�DGGUHVV��\RX�VKRXOG�
VHH�DQ�(GLW�OLQN�QH[W�WR�WKH�HPDLO�DGGUHVV�WKDW�DSSHDUV�XQGHU�WKH�Ȇ$SSOH�Ζ'�DQG�3ULPDU\�(PDLO�$GGUHVVȇ�KHDGLQJ�
LQ�WKLV�VFUHHQ��&OLFN�LW��HQWHU�WKH�HPDLO�DGGUHVV�\RX�ZDQW�WR�XVH��DQG�WKHQ�FOLFN�Save Changes.

:H�FLWH�WKH�PDF�FRP��PH�FRP��DQG�LFORXG�FRP�H[FHSWLRQV�EHFDXVH�QR�(GLW�EXWWRQ�DSSHDUV�LQ�WKLV�VFUHHQ�LI�\RX�
KDYH�RQH�RI�WKHVH�DGGUHVVHV��ΖI�IRU�VRPH�UHDVRQ�\RX�QHHG�WR�GLVDVVRFLDWH�\RXU�$SSOH�Ζ'�IURP�VXFK�DQ�DFFRXQW�
�RU�\RXȇUH�KDYLQJ�D�SUREOHP�XVLQJ�WKH�PHWKRG�Ζ�MXVW�GHVFULEHG���\RXȇOO�QHHG�WR�FRQWDFW�$SSOH�WR�DUUDQJH�LW��<RX�
can do that through the iTunes Support website�

YOU WANT TO MERGE SEVERAL APPLE IDS INTO ONE ICLOUD ACCOUNT Unfortunately, Apple currently 
GRHVQȇW�DOORZ�\RX�WR�PHUJH�$SSOH�Ζ'V�

YOU HAD AN ACCOUNT WITH ONE OF APPLE’S OLDER, EXPIRED SERVICES (iTOOLS, .MAC, OR MOBILEME), 
BUT STOPPED SUBSCRIBING, AND YOU STILL USE THAT MAC.COM OR ME.COM ADDRESS AS YOUR APPLE 
ID FOR PURCHASES Convert your old account by going to the iCloud website and logging in with that account’s 
FUHGHQWLDOV��<RX�FDQ�DOVR�GR�WKLV�E\�ORJJLQJ�LQWR�L&ORXG�RQ�\RXU�L26�GHYLFH�RU�0DF��

https://appleid.apple.com
https://www.apple.com/support/itunes/
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YOU HAD AN ACCOUNT WITH ONE OF APPLE’S OLDER, EXPIRED SERVICES (iTOOLS, .MAC, OR MOBILEME), 
BUT STOPPED SUBSCRIBING; NOW YOU WANT TO USE THAT EMAIL ADDRESS FOR iCLOUD, BUT YOU USE 
A DIFFERENT APPLE ID FOR PURCHASES Convert that address to iCloud by using the method detailed in the 
VFHQDULR�DERYH��$IWHU�\RXȇYH�GRQH�VR��\RX�FDQ�DGG�\RXU�6WRUH�FUHGHQWLDOV�VHSDUDWHO\��

On a Mac or PC, open iTunes and go to Store > Log In, and then enter the Apple ID and password you use for 
SXUFKDVHV�

On an iOS device, go to Settings > iTunes & App Stores. If you’ve added your iCloud account to your device, those 
credentials appear by default; to replace them with the Apple ID you use for purchases, tap your iCloud ID at 
the top of the screen, and then tap Sign Out.�2QFH�\RXȇUH�VLJQHG�RXW��\RX�FDQ�ORJ�EDFN�LQ�ZLWK�WKH�VHFRQGDU\�Ζ'�

Multiple-User Setup Scenarios

Want to sync your own data, but share parts of it with others? Is your iCloud account also the account people in 
\RXU�IDPLO\�XVH�IRU�WKHLU�L7XQHV�6WRUH�SXUFKDVHV"�:HȇOO�ZDON�\RX�WKURXJK�DOO�VRUWV�RI�PXOWLSOH�XVHU�VFHQDULRV�

YOU AND YOUR FAMILY WANT SEPARATE iCLOUD ACCOUNTS FOR SYNCING; EVERYONE CURRENTLY USES 
YOUR ACCOUNT FOR iTUNES STORE PURCHASES It’s fairly easy to get started with iCloud if you use a single 
$SSOH�Ζ'�VROHO\�RQ�\RXU�RZQ�GHYLFHV��%XW�PDQ\�IDPLOLHV�VKDUH�D�VLQJOH�$SSOH�Ζ'�DFURVV�PXOWLSOH�SHRSOH�DQG� 
GHYLFHV�IRU�SXUFKDVHV��WR�JLYH�HYHU\ERG\�LQ�WKH�IDPLO\�DFFHVV��0XVW�\RX�DOO�VKDUH�WKDW�$SSOH�Ζ'�IRU�L&ORXG��WRR"

1R��\RX�GRQȇW�KDYH�WR��DQG�\RX�SUREDEO\�VKRXOGQȇW�HLWKHU��-XVW�EHFDXVH�\RX�DOO�ZDQW�WR�RZQ�Hanging With 
)ULHQGV�GRHVQȇW�PHDQ�\RX�ZDQW�WR�VKDUH�WKH�VDPH�FRQWDFWV��LQER[��RU�ERRNPDUNV��$QG�VKDULQJ�L&ORXG�DFFRXQWV�
ZRXOG�DOVR�PHDQ�WKDW�\RX�ZRXOG�KDYH�WR�VKDUH�\RXU�L26�EDFNXS�VSDFH�

The good news is that you can continue to share an Apple ID with your family for iTunes purchases while main-
WDLQLQJ�LQGLYLGXDO��VHSDUDWH�L&ORXG�DFFRXQWV��$QG�WKH�HYHQ�EHWWHU�QHZV�LV�WKDW�$SSOH�WRWDOO\�DSSURYHV�RI�\RXU�
GRLQJ�VR��VR�\RX�QHHGQȇW�IHHO�JXLOW\�DERXW�LW�

As the owner of the Apple ID for purchases, you can go ahead and convert your ID to iCloud, then log in to 
L&ORXG�RQ�\RXU�GHYLFHV�DV�\RX�ZRXOG�QRUPDOO\�

<RXU�RWKHU�IDPLO\�PHPEHUV�ZLOO�ZDQW�WR�FUHDWH�QHZ�L&ORXG�DFFRXQWV��DQG�WKHQ�IROORZ�WKHVH�VWHSV�

On a Mac or PC, open iTunes and go to Store > Log In, and WKHQ�HQWHU�\RXU�$SSOH�Ζ'�DQG�SDVVZRUG�

On an iOS device, go to Settings > iTunes & App Stores. If the user of that device has added an iCloud account to 
it, those credentials appear by default; to replace them with the Apple ID you use for purchases, tap the iCloud 
ID at the top of the screen and then tap Sign Out��2QFH�VLJQHG�RXW��\RX�FDQ�ORJ�EDFN�LQ�ZLWK�WKH�VHFRQGDU\�Ζ'�

If you instead want to keep everyone’s syncing—including your own—separate from purchases, leave your 
Apple ID alone and create a new iCloud account for syncing, and then follow the instructions above to add your 
$SSOH�Ζ'�EDFN�WR�L7XQHV�

http://www.hangingwithfriends.com
http://www.hangingwithfriends.com
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YOU’VE ALREADY MADE A BUNCH OF PURCHASES USING SEPARATE APPLE IDS, AND YOU WANT TO 
SHARE ALL OF THEM WITH YOUR FAMILY�7KRXJK�WKH�IROORZLQJ�SURFHVV�LV�WHGLRXV��LW�FDQ�ZRUN��$GG�DOO� 
WKH�FRQWHQW��DVVRFLDWHG�ZLWK�WKH�GLIIHUHQW�Ζ'V��WR�L7XQHV��DQG�WKHQ�WU\�WR�SOD\�RU�V\QF�LW��<RXȇOO�EH�DVNHG�WR�
DXWKRUL]H�L7XQHV�ZLWK�WKH�Ζ'V�DVVRFLDWHG�ZLWK�WKDW�FRQWHQW��$IWHU�\RX�GR�VR��\RX�FDQ�V\QF�DOO�\RXU�GHYLFHV�ZLWK�
that computer to get that content; if an app requires an update on an iOS device, you’ll be prompted for the 
RULJLQDO�DFFRXQWȇV�SDVVZRUG�

The only hassle with this method comes from authorization limits—Apple currently prohibits you from authoriz-
ing more than ten devices with your Apple ID, so if each family member has a computer, iPhone, and iPad, you 
PD\�UXQ�XS�DJDLQVW�WKHVH�OLPLWV�YHU\�TXLFNO\�

YOU AND YOUR FAMILY MEMBERS WANT SEPARATE iCLOUD ACCOUNTS FOR EMAIL, BUT YOU WANT TO 
SHARE CONTACTS AND CALENDARS Not a problem—you can each have individual accounts but share con-
WDFWV��FDOHQGDUV��UHPLQGHUV��DQG�QRWHV��(DFK�RI�\RX�VKRXOG�FUHDWH�D�VHSDUDWH�L&ORXG�DFFRXQW�IRU�\RXU�HPDLO��
NHHSLQJ�V\QFLQJ�WXUQHG�RQ�IRU�FRQWDFWV��FDOHQGDUV��UHPLQGHUV��DQG�QRWHV��7KHQ�FUHDWH�D�QHZ�VHFRQGDU\�L&ORXG�
DFFRXQW�IRU�V\QFLQJ���$OWHUQDWLYHO\��\RX�FDQ�HDFK�FUHDWH�\RXU�RZQ�L&ORXG�DFFRXQW��DQG�WKHQ�FKRRVH�RQH�RI�\RXU�
DFFRXQWV�DV�WKH�VHFRQGDU\�DFFRXQW�IRU�DOO�RWKHU�SDUWLHV��

On a Mac, go to System Preferences > Mail, Contacts & Calendars > iCloud, and then add the secondary iCloud  
DFFRXQW���8QIRUWXQDWHO\��\RX�FDQȇW�DGG�VHFRQGDU\�L&ORXG�DFFRXQWV�RQ�D�3&���2Q�DQ�L26�GHYLFH��JR�WR�Settings > 
Mail, Contacts, Calendars > Add Account > iCloud��

Toggle the calendars, contacts, notes, and reminders switches on for the secondary account, and you should be 
VKDULQJ�LQ�QR�WLPH��6HFRQGDU\�L&ORXG�DFFRXQWV�RQ�D�GHYLFH�DUH�OLPLWHG�WR�MXVW�WKH�V\QFLQJ�RI�FRQWDFWV��FDOHQGDUV��
PDLO��UHPLQGHUV��DQG�QRWHV��<RX�FDQȇW�XVH�\RXU�VLJQLILFDQW�RWKHUȇV�DFFRXQW�WR�V\QF�6DIDUL�ERRNPDUNV��3KRWR�
6WUHDP��'RFXPHQWV�	�'DWD��RU�)LQG�0\�L3KRQH��RU�WR�EDFN�XS�L26�GHYLFHV�
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Syncing
In theory, having all your data magically synced between your devices should be a wonderful and painless pro-
FHVV��ΖQ�DFWXDOLW\��WHFKQRORJ\�LVQȇW�SHUIHFWȃDQG�PLVWDNHV�FDQ�DQG�ZLOO�KDSSHQ��ΖQ�WKLV�VHFWLRQ��ZHȇYH�FROOHFWHG�D�
IHZ�FRPPRQ�L&ORXG�V\QFLQJ�SUREOHPV�DQG�ZD\V�WR�WURXEOHVKRRW�

General Sync Problems

ΖI�LWȇV�GXSOLFDWHV��PHUJLQJ�HUURUV��RU�PDLO�SUREOHPV�\RXȇYH�UXQ�LQWR��ZHȇYH�JRW�VRPH�VROXWLRQV�IRU�\RX�

DUPLICATES, DUPLICATES, DUPLICATES Unfortunately, while we’d love Apple’s iCloud syncing to be perfect  
DOO�WKH�WLPH��RIWHQ�LWȇV�QRW��7KURZ�WKLUG�SDUW\�VHUYLFHV�DQG�L7XQHV�V\QFLQJ�LQWR�WKH�PL[��DQG�LWȇV�SUHWW\�HDV\�WR� 
DFFLGHQWDOO\�ILQG�\RXUVHOI�ZLWK�D�FRQWDFW�OLVW�LQ�WULSOLFDWH��+HUH�DUH�VRPH�SLWIDOOV�WR�ZDWFK�RXW�IRU��

)LUVW��\RXȇUH�LQ�GDQJHU�RI�JHWWLQJ�GXSOLFDWH�LWHPV�LI�\RXȇUH�XVLQJ�D�YHUVLRQ�RI�L7XQHV�ROGHU�WKDQ�L7XQHV����ΖI�
\RXȇYH�XSJUDGHG�WR�L7XQHV���\RX�FDQ�GLVUHJDUG�WKLV�VHFWLRQ��

ΖI�\RX�DUH�XVLQJ�L7XQHV���RU�HDUOLHU��WKRXJK��DQG�\RXȇYH�VZLWFKHG�RQ�FDOHQGDU�V\QFLQJ�ZLWK�ERWK�L&ORXG�DQG�
L7XQHV��\RX�FRXOG�EH�LQ�IRU�VRPH�VHULRXV�GXSOLFDWLRQ��7R�FKHFN��FRQQHFW�\RXU�L26�GHYLFH�WR�\RXU�0DF��VHOHFW�LW�LQ�
iTunes’ Source list, choose the Info�WDE��DQG�SHHU�DW�WKH�6\QF�&DOHQGDUV�HQWU\��/RRN�IRU�WKHVH�ZRUGV��Ȇ<RXU�FDO-
HQGDUV�DUH�EHLQJ�V\QFHG�ZLWK�L&ORXG�RYHU�WKH�DLU��<RXU�FDOHQGDUV�ZLOO�DOVR�V\QF�GLUHFWO\�ZLWK�WKLV�FRPSXWHU��7KLV�
PD\�UHVXOW�LQ�GXSOLFDWHG�GDWD�VKRZLQJ�RQ�\RXU�GHYLFH�ȇ

This is a very strong hint that you’re doing The Bad Thing and that you need to make a choice between syncing 
ZLWK�\RXU�0DF�RU�V\QFLQJ�ZLWK�L&ORXG��<RX�FDQ�GLVDEOH�FDOHQGDU�V\QFLQJ�ZLWKLQ�L7XQHV�E\�XQFKHFNLQJ�WKH�6\QF�
&DOHQGDUV�RSWLRQ��:KHQ�\RX�GR��L7XQHV�ZLOO�RIIHU�WR�UHPRYH�LWV�FDOHQGDU�HQWULHV�IURP�\RXU�L3KRQH�

�ΖI�\RXȇUH�VWLOO�QRW�VXUH�WKDWȇV�ZKDWȇV�KDSSHQLQJ��ODXQFK�WKH�&DOHQGDU�DSS�RQ�\RXU�L3KRQH��WDS�WKH�Calendars 
EXWWRQ�LQ�WKH�WRS�OHIW�FRUQHU��DQG�ORRN�DW�WKH�KHDGLQJV�RQ�WKH�UHVXOWLQJ�&DOHQGDUV�VFUHHQ��ΖI�\RX�VHH�RQH�HQWU\�
IRU�)URP�0\�0DF�DQG�DQRWKHU�WKDW�LQFOXGHV�\RXU�L&ORXG�DGGUHVVȃexample#LFORXG�FRP��IRU�LQVWDQFHȃ\RXȇUH�
GXSOLFDWLQJ�\RXU�HIIRUWV��

But suppose you have different events in the calendars synced from your Mac and those synced via iCloud, 
DQG�\RXȇG�OLNH�WR�KDYH�DOO�RI�\RXU�HYHQWV�RQ�WKH�L3KRQH��7U\�WKLV��$WWDFK�\RXU�L3KRQH�WR�\RXU�0DF�DQG��LQ�WKH�Info 
tab, disable Calendar syncing. When you see the offer to keep or remove the calendars currently on the iPhone, 
choose to keep them, and then click the Apply�EXWWRQ�DW�WKH�ERWWRP�RI�WKH�ZLQGRZ��

Now, move to your iPhone, choose Settings > iCloud��DQG�IOLFN�WKH�WRJJOH�QH[W�WR�&DOHQGDUV�WR�Off. Again, you’ll be 
RIIHUHG�WKH�FKRLFH�WR�NHHS�RU�GHOHWH�\RXU�FDOHQGDUV��ΖQ�WKLV�LQVWDQFH��GHOHWH�WKHP��GRQȇW�ZRUU\��WKH\ȇUH�VWRUHG�LQ�
WKH�FORXG���1RZ�VZLWFK�WKH�&DOHQGDUV�WRJJOH�EDFN�WR�On. In the sheet that appears, tap Merge.

:KDW�KDSSHQV"�7KH�GXSOLFDWH�HYHQWV�FXUUHQWO\�VWRUHG�RQ�\RXU�L3KRQH��WKH�RQHV�V\QFHG�IURP�\RXU�0DF��DQG�
RQ�L&ORXG�DUH�PHUJHG�LQWR�D�VLQJOH�HYHQW��$Q\�DGGLWLRQDO�HYHQWV�QRW�IRXQG�LQ�\RXU�L&ORXG�FDOHQGDU�JHW�DGGHG�
WR�L&ORXG�
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MERGING DIFFICULTIES Content merges—which happen when you try to sync an active iCloud account with a 
GHYLFH�WKDW�DOUHDG\�KDV�FDOHQGDUV�DQG�FRQWDFWV�RQ�LWȃFDQ�DOVR�EH�D�VRXUFH�RI�WURXEOH�

L&ORXG�DOZD\V�DWWHPSWV�WR�PHUJH�WKLQJV�VHDPOHVVO\��ΖI�LWȇV�PHUJLQJ�FDOHQGDUV��IRU�H[DPSOH��DQG�\RX�KDYH�WZR�
HYHQWV�ZLWK�WKH�VDPH�QDPH��LW�DXWRPDWLFDOO\�WULHV�WR�DFFHSW�WKH�RQH�\RX�FUHDWHG�PRVW�UHFHQWO\��0RVW�RI�WKH�
WLPH��GDWD�PHUJHV�VKRXOG�ZRUN�VHDPOHVVO\��EXW�WKHUH�FDQ�RFFDVLRQDOO\�EH�JRRI�XSV��ΖI�\RXȇUH�ZRUULHG�DERXW�
accidentally overwriting your device’s data with your iCloud data, make a backup of your device before you 
WXUQ�RQ�L&ORXG�

2Q�D�0DF�UXQQLQJ�0RXQWDLQ�/LRQ��\RX�FDQ�EDFN�XS�&DOHQGDU�GDWD�E\�JRLQJ�WR�File > Export > Calendar Archive; 
back up Contacts by going to File > Export > Contacts Archive; back up Reminders by going to File > Export; and 
back up Notes by copying the contents of youruserfolder�/LEUDU\�&RQWDLQHUV�FRP�DSSOH�1RWHV�'DWD�/LEUDU\�
1RWHV���<RX�FDQ�DOVR�UXQ�D�7LPH�0DFKLQH�EDFNXS�EHIRUH�DGGLQJ�L&ORXG�WR�EDFN�XS�WKH�ZKROH�NLW�DQG�FDERRGOH��

2Q�DQ�L26�GHYLFH��\RX�FDQ�EDFN�XS�\RXU�GDWD�E\�FUHDWLQJ�D�GHYLFH�EDFNXS�WKURXJK�L7XQHV���ΖQ�L7XQHV���FKRRVH�
This computer under the Automatically Back Up section in the Summary pane, and then click Back Up Now��

SECONDARY EMAIL ERRORS If your Mac generates errors when you try to add an iCloud email address via the 
0DLO��&RQWDFWV�	�&DOHQGDUV�SUHIHUHQFH�SDQH��\RX�PD\�QHHG�WR�VHW�XS�\RXU�DFFRXQW�PDQXDOO\��7R�GR�VR��RSHQ�WKH�
Mail app and go to Preferences > Accounts. 

ΖQ�0DLOȇV�$FFRXQWV�VHWWLQJ��FOLFN�WKH�SOXV�EXWWRQ�����DQG�HQWHU�\RXU�L&ORXG�DGGUHVV�DQG�SDVVZRUG�DV�\RX�QRUPDOO\�
ZRXOG��+ROG�GRZQ�WKH��2SWLRQ!�NH\�DQG�FOLFN�Continue. Instead of having Mail set up your account for you, you 
FDQ�QRZ�VHW�LW�XS�PDQXDOO\�

ΖQ�WKH�QH[W�VKHHW��ZKLFK�UHDGV�ΖQFRPLQJ�0DLO�6HUYHU���FKRRVH�IMAP�IURP�WKH�$FFRXQW�7\SH�SRS�XS�PHQX��/HDYH�
L&ORXG�LQ�WKH�GHVFULSWLRQ�ILHOG��ΖQ�WKH�ΖQFRPLQJ�0DLO�6HUYHU�ILHOG��HQWHU�imap.mail.me.com. <RXU�XVHUQDPH�DQG�
SDVVZRUG�VKRXOG�EH�ILOOHG�LQ�DXWRPDWLFDOO\��+ROG�GRZQ��2SWLRQ!�DQG�FOLFN�Continue�DJDLQ�

ΖQ�WKH�QH[W�VKHHW��ΖQFRPLQJ�0DLO�6HFXULW\���HQDEOH�WKH�Use Secure Socket Layer (SSL) option and choose Password 
IURP�WKH�$XWKHQWLFDWLRQ�SRS�XS�PHQX��&OLFN�Continue.

7KH�ILQDO�VKHHW�ZLOO�VKRZ�\RX�WKH�DFFRXQW�FRQILJXUDWLRQ��/RRN�LW�RYHU�WR�PDNH�VXUH�HYHU\WKLQJ�LV�HQWHUHG�FRU-
UHFWO\���ΖI�LW�LVQȇW��FOLFN�WKH�Go Back�EXWWRQ�WR�GR�H[DFWO\�WKDW�DQG�PDNH�FRUUHFWLRQV�ZKHUH�QHHGHG���&OLFN�Create to 
FUHDWH�\RXU�DFFRXQW��<RXU�HPDLO�DFFRXQW�VKRXOG�QRZ�ZRUN�DV�H[SHFWHG�

iCloud Syncing With Older Machines

2IILFLDOO\��L&ORXG�RQO\�VXSSRUWV�0DFV�UXQQLQJ�26�;�������RU�ODWHU��L26�GHYLFHV�UXQQLQJ�L26���RU�ODWHU��DQG�3&V�
UXQQLQJ�:LQGRZV�9LVWD�RU�ODWHU��ΖI�\RXȇUH�VWXFN�ZLWK�DQ�ROGHU�GHYLFH��KRZHYHU��LWȇV�SRVVLEOH�WR�JHW�VRPH�IHDWXUHV�
ZRUNLQJȃWKRXJK�QRW�DOO��

SYNC SUPPORT ON iOS 4 ΖI�\RXȇUH�XVLQJ�DQ�ROGHU�L3KRQH����RU�HDUOLHU��RU�DQ�L3RG�WRXFK��VHFRQG�JHQHUDWLRQ�RU�
HDUOLHU���\RX�XQIRUWXQDWHO\�FDQȇW�XSJUDGH�WR�L26��ȃDQG�L&ORXG�DORQJ�ZLWK�LW��%XW�\RX�FDQ�VWLOO�JHW�L&ORXG�HPDLO��
FRQWDFWV��DQG�FDOHQGDU�V\QFLQJ��8QIRUWXQDWHO\��LWȇV�QRW�WKH�HDVLHVW�SURFHVV�LQ�WKH�ZRUOG��DQG�UHTXLUHV�D�ELW�RI�
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ILGGOLQJ�ZLWK�SOLVW�ILOHV�RQ�\RXU�0DF��ΖI�\RX�UHDOO\�QHHG�V\QF�VXSSRUW��WKRXJK��%HQ�/LȇV�/LIH��0XVLF��DQG�(YHU\WKLQJ�
Else blog�KDV�D�JUHDW�VWHS�E\�VWHS�WXWRULDO�

SYNC SUPPORT FOR OS X SNOW LEOPARD�ΖI�\RXȇUH�VWLOO�XVLQJ�6QRZ�/HRSDUG�RQ�\RXU�0DF��\RX�ZRQȇW�VHH�DQ�
L&ORXG�SDQH�LQ�6\VWHP�3UHIHUHQFHV��LQVWHDG��\RXȇOO�VHH�D�SDQH�IRU�0RELOH0H��$SSOHȇV�E\JRQH�V\QF�VHUYLFH��ΖI�
you’re determined to sync your mail, calendars, contacts, and bookmarks, however, you can do so without too 
PXFK�WURXEOH��7KRPDV�%UDQGȇV�(JJ�)UHFNOHV�EORJ�RIIHUV�WLSV�RQ�VHWWLQJ�XS�WKHVH�IHDWXUHV�LQ�6QRZ�/HRSDUG�

SYNC SUPPORT FOR WINDOWS XP Apple’s iCloud control panel for Windows is currently available only for PCs 
UXQQLQJ�:LQGRZV�9LVWD�RU�ODWHU��<RX�FDQ�JHW�\RXU�L&ORXG�HPDLO�UXQQLQJ�RQ�DQ�;3�FRPSXWHU�ZLWKRXW�PXFK�KDVVOH��
if you want to do much else, however, you’ll have to do some fiddling with the control panel file—not for the 
IDLQW�RI�KHDUW���ΖI�\RXȇUH�GHWHUPLQHG�WR�GR�VR��WKH�[OLL�EORJ offers a step-by-step tutorial; note that we at Macworld 
KDYHQȇW�WHVWHG�WKLV�ZDONWKURXJK�DQG�FDQȇW�YRXFK�IRU�LWV�HIIHFWLYHQHVV��

The Nitty-Gritty of Documents & Data Sync

Apple’s Documents & Data sync for OS X apps and App Store apps generally works fairly seamlessly, but if 
\RXȇUH�FXULRXV�DERXW�KRZ�LW�ZRUNVȃRU�LI�\RXȇUH�UXQQLQJ�LQWR�DQ�HUURUȃKHUH�DUH�VRPH�DQVZHUV�

WHAT FILES DOES DOCUMENTS & DATA SYNC BACK UP? iCloud syncs documents and data created by any 
L26�$SS�6WRUH�DQG�0DF�$SS�6WRUH�DSSV��LQFOXGLQJ�$SSOHȇV�RZQ��WKDW�FDQ�WDNH�DGYDQWDJH�RI�WKH�VHUYLFH��ΖI�\RXU�
app isn’t sold on the Mac App Store or App Store, it can’t use iCloud, and the iCloud service won’t back up or 
sync those files; you’ll need a third-party service such as 'URSER[�WR�GR�WKDW�

CAN I SEE ALL MY iCLOUD DOCUMENTS IN ONE PLACE?�1R��8QOLNH�WKH�ILOH�V\VWHP�RQ�D�FRPSXWHU��L&ORXG�
GRHVQȇW�VWRUH�GRFXPHQWV�LQ�IROGHUV��LQVWHDG��HDFK�DSS�KDV�FRQWURO�RI�LWV�ILOHV�DQG�GDWD��$V�VXFK��ZKHQ�\RXȇUH�LQ�
Numbers, you can view all the spreadsheets you’ve saved to iCloud from the Numbers app, but you can’t view 
DQ\�VSUHDGVKHHWV�\RXȇYH�VDYHG�WR�L&ORXG�IURP�D�GLIIHUHQW�SURJUDP��

<RX�FDQ�VHH�KRZ�PXFK�L&ORXG�LV�FXUUHQWO\�VWRULQJȃVRUWHG�E\�DSSȃIURP�WKH�0DQDJH�%DFNXS�VHFWLRQ�RI�\RXU�
L&ORXG�SUHIHUHQFH�VFUHHQ��EXW�\RX�ZRQȇW�EH�DEOH�WR�RSHQ�DQ\�RI�WKH�ILOHV�

DELETING GAMES AND RESCUING DATA If you delete a game on your iOS device or Mac—and that game  
KDV�L&ORXG�VXSSRUWȃZKHQ�\RX�UHLQVWDOO�WKH�JDPH��LW�VKRXOG�UHWDLQ�\RXU�GDWD��<RX�FDQ�DOVR�V\QF�JDPH�VDYHV�
EHWZHHQ�GHYLFHV��VR�\RX�FDQ�SDXVH�SOD\�RQ�DQ�L3DG�DQG�SLFN�LW�XS�RQ�DQ�L3KRQH�

HOW DO I GET RID OF DATA? If you have documents you no longer want saved to iCloud, you can either delete 
them one by one within the relevant app, or you can go to the Manage Storage section of your iCloud prefer-
HQFH�VFUHHQ�DQG�GHOHWH�WKHP�IURP�WKHUH�

http://bwhli.com/configuring-icloud-for-ios4/
http://bwhli.com/configuring-icloud-for-ios4/
http://eggfreckles.net/notes/bringing-icloud-to-snow-leopard/
http://xlii.be/2011/10/how-to-get-icloud-windows-xp-and-outlook-to-work-together/
http://www.dropbox.com
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Finesse Photo Stream

+DYH�TXHVWLRQV�DERXW�3KRWR�6WUHDP"�:H�FDQ�KHOS�

I WANT TO SEE PHOTO STREAM IMAGES ON MY MAC MORE QUICKLY There are plenty of ways to transfer 
SKRWRV�IURP�DQ�L26�GHYLFH�WR�D�0DF��EXW�LW�FDQ�VWLOO�EH�D�KDVVOH��3KRWR�6WUHDP�LV�QR�H[FHSWLRQ��7KH�VHUYLFH�KDV�
no problem streaming recently taken images, but you still have to load iPhoto or Aperture before you can look 
DW�WKHPȃWKDW�LV��XQOHVV�\RX�NQRZ�WKLV�WULFN�

)LUVW��PDNH�VXUH�\RX�KDYH�3KRWR�6WUHDP�WXUQHG�RQ�IRU�\RXU�L26�GHYLFHV��DV�ZHOO�DV�RQ�\RXU�0DF��1H[W��JR�WR� 
youruserfolder�/LEUDU\�$SSOLFDWLRQ�6XSSRUW�L/LIH$VVHW0DQDJHPHQW�DVVHWV�VXE���ΖI�\RX�DUHQȇW�VXUH�KRZ�WR�YLHZ�
\RXU�/LEUDU\�IROGHU�LQVLGH�\RXU�KRPH�IROGHU��ZH�KDYH���ZD\V�WR�GR�VR���

7KHUH��\RXȇOO�VHH�D�EXQFK�RI�VXEIROGHUV�ZLWK�QDPHV�OLNH�����G�I�DD��GE�H��E������HII�FDF��D��3HUIRUP�
a search for image files in this subfolder by typing kind:image in the search field and selecting Sub as the focus 
RI�WKH�VHDUFK���ΖI�\RX�WDNH�D�ORW�RI�SKRWRV�RU�VFUHHQVKRWV��DQG�RQO\�ZDQW�WR�ILQG�RQH�RU�WKH�RWKHU��\RX�FRXOG�
instead search for png for screenshots or jpg�IRU�SKRWRV��

<RX�FDQ�VDYH�WKLV�VHDUFK�DV�D�VPDUW�IROGHU�E\�FOLFNLQJ�WKH�Save�EXWWRQ�MXVW�EHORZ�WKH�VHDUFK�ILHOG��<RX�FDQ�VDYH�LW�
wherever you want: By default, it will go in the Saved Searches folder, but you can check the Add to Sidebar�ER[�
LI�\RX�ZDQW�TXLFN�DFFHVV�IURP�WKH�)LQGHU�VLGHEDU��<RX�FDQ�DOVR�FKRRVH�D�GLIIHUHQW�ORFDWLRQ�IRU�WKH�VPDUW�IROGHU��
VXFK�DV�\RXU�GHVNWRS��ΖI�\RX�ZDQW�WKLV�IROGHU�LQ�WKH�'RFN��DGG�LW�E\�GUDJJLQJ�WKH�IROGHU�WKHUH�

MORE OPTIONS Right-click the title bar in List view to add more organizational columns.

Now, whenever you need to get quick access to a photo or screenshot taken on an iOS device, just open this 
IROGHU��ΖI�\RX�KDYH�D�ORW�RI�ILOHV��\RX�PLJKW�ZDQW�WR�FKDQJH�WR�/LVW�YLHZ�DQG�DGG�WKH�'DWH�&UHDWHG�FROXPQ��ULJKW�
click the title bar and check the Date Created�ER[�IURP�WKH�OLVW���DQG�WKHQ�VRUW�E\�WKDW�GDWH��FOLFN�WKH�Date Created 
KHDGHU�VR�WKH�PRVW�UHFHQW�GDWH�DSSHDUV�DW�WKH�WRS��

http://www.macworld.com/article/1161156/view_library_folder_in_lion.html
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:+<�&$1�Ζ�21/<�6<1&�7+(�/$67�����Ζ0$*(6"�7KLV�LV�SDUWLDOO\�GXH�WR�L&ORXGȇV�VWRUDJH�OLPLWDWLRQV��7KDW�VDLG��
while the service only stores your recent images online, if you sync Photo Stream with your Mac or PC, all Photo 
6WUHDP�LPDJHV�JHW�SHUPDQHQWO\�GRZQORDGHG�WR�\RXU�FRPSXWHU�

WHAT APPS CAN I USE WITH PHOTO STREAM?�2Q�D�0DF��\RX�FDQ�XVH�L3KRWR�ȇ�RU�$SHUWXUH����2Q�D�3&��\RX�
RQO\�KDYH�WKH�FKRLFH�RI�GHVLJQDWLQJ�D�3LFWXUHV�IROGHU�
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Backups
+DYH�TXHVWLRQV�DERXW�L26�EDFNXSV"�+HUH�DUH�D�IHZ�DQVZHUV�

CAN I STILL MAKE iTUNES BACKUPS IF I BACK UP MY DEVICE TO iCLOUD? <RX�FDQ��EXW�RQO\�PDQXDOO\��\RXȇOO�
KDYH�WR�FRQQHFW�\RXU�GHYLFH�WR�L7XQHV��FKDQJH�WKH�%DFNXSV�VHFWLRQ��ORFDWHG�LQ�WKH�6XPPDU\�SDQH��WR�Automati-
cally Back Up This Computer, and click Back Up Now��$IWHU�WKH�EDFNXS�KDV�ILQLVKHG��FKDQJH�WKLV�RSWLRQ�EDFN�WR�
Automatically Back Up iCloud�WR�FRQWLQXH�EDFNLQJ�XS�UHPRWHO\�

CAN YOU DELETE APPS FROM ALL YOUR DEVICES THROUGH iCLOUD? 1R��<RX�FDQ�RQO\�PDQDJH�\RXU�GHYLFHȇV�
DSSV�IURP�WKH�GHYLFH�LWVHOI��RU�ZKHQ�LWȇV�FRQQHFWHG�WR�L7XQHV��

WILL iCLOUD BACKUPS EAT UP MY DATA PLAN? 1RSH��L&ORXG�VHHPV�WR�EH�LQWHQWLRQDOO\�IRFXVHG�RQ�:L�)L�
V\QFLQJ��%DFNXSV�ZRQȇW�KDSSHQ�XQOHVV�\RXU�GHYLFH�LV�RQ�:L�)L�DQG�SOXJJHG�LQ��IRU�H[DPSOH��%XW�VRPH�IHDWXUHV�
V\QF�RYHU�FHOOXODU�FRQQHFWLRQV��DQG�\HV��WKH\�ZLOO�XVH�\RXU�GDWD�SODQ��8VHUV�RQ�OLPLWHG�GDWD�SODQV�QHHG�WR�FRQ-
VLGHU�WKHLU�L&ORXG�VWUDWHJ\�FDUHIXOO\�
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Location Services
Here we’ve collected a few questions and answers about iCloud’s location services, as well as some tips for opti-
PL]LQJ�)LQG�0\�)ULHQGV�DQG�WXUQLQJ�RII�\RXU�ORFDWLRQ�

HOW DOES iCLOUD USE MY LOCATION? iCloud uses your GPS location for two services, assuming you’ve  
RSWHG�LQ��)LQG�0\�L3KRQH�DQG�)LQG�0\�)ULHQGV���%DFN�WR�0\�0DF��ZKLOH�JURXSHG�ZLWK�RWKHU�ORFDWLRQ�EDVHG�VHU-
YLFHV��GRHVQȇW�XVH�\RXU�ORFDWLRQ��LW�XVHV�\RXU�ZLUHOHVV�URXWHU���

WILL APPLE SELL MY LOCATION DATA TO PEOPLE? 1R��<RXU�ORFDWLRQ�GDWD�PD\�EH�XVHG�WR�JLYH�\RX�ORFDWLRQ�
WDUJHWHG�L$GV��EXW�WKDW�GDWD�LV�DQRQ\PL]HG�ZKHQ�VHQW�WR�$SSOHȇV�VHUYHUV�WR�SUHYHQW�QHIDULRXV�W\SHV��DQG�DGYHU-
WLVHUV��IURP�NQRZLQJ�ZKR�LV�DWWDFKHG�WR�ZKDW�ORFDWLRQ��$QG�\RX�FDQ�GLVDEOH�ORFDWLRQ�EDVHG�L$GV�DW�DQ\�WLPH�RQ�
your device by going to Settings > Privacy > Location Services > System Services�DQG�WXUQLQJ�WKH�/RFDWLRQ�%DVHG�
L$GV�WRJJOH�RII�

HOW DO I STOP PEOPLE FROM FOLLOWING ME IN FIND MY FRIENDS?�2SHQ�)LQG�0\�)ULHQGV�DQG�WDS�WKH�Me 
tab, and then turn Hide from Followers�RQ��8QIRUWXQDWHO\��WKHUHȇV�QR�ZD\�WR�VHOHFWLYHO\�KLGH�\RXUVHOI�IURP�FHUWDLQ�
IROORZHUVȃ\RX�HLWKHU�KLGH�IURP�HYHU\RQH�RU�IURP�QR�RQH��$OWHUQDWLYHO\��\RX�FDQ�UHPRYH�SHRSOH�IURP�\RXU�IRO-
ORZHUV�OLVW�LI�\RX�QR�ORQJHU�ZDQW�WKHP�WR�VHH�\RXU�ORFDWLRQ�

I DON’T WANT TO BROADCAST MY LOCATION If you don’t want your GPS data used for anything, you can go 
to Settings > Privacy > Location Services and disable Location Services��.HHS�LQ�PLQG�WKDW�WKLV�ZLOO�DOVR�SUHYHQW�)LQG�
0\�L3KRQH�DQG�WKH�0DSV�DSS�IURP�IXQFWLRQLQJ�
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iTunes Match 
Having trouble with iTunes Match? Whether it’s song identification or iCloud errors, we have an overview of 
VRPH�EDVLF�LVVXHV�DQG�KRZ�WR�VXUPRXQW�WKHP�

iTunes Match and Purchased Content Questions

+DYH�D�IHZ�PRUH�TXHVWLRQV�DERXW�L7XQHV�0DWFK"�<RXȇYH�FRPH�WR�WKH�ULJKW�SODFH�

WHAT KINDS OF CONTENT CAN iTUNES MATCH UPLOAD OR MATCH? <RX�FDQ�PDWFK�RU�XSORDG�DQ\�PXVLF�
IRUPDW�WKDWȇV�FRPSDWLEOH�ZLWK�L7XQHV��7KDW�LQFOXGHV�$$&��3URWHFWHG��'50�RU�GLJLWDO�ULJKWV�PDQDJHPHQW��$$&�
�0�3���03���:$9��$Ζ))��$SSOH�/RVVOHVV��DQG�PRUH��<RX�FDQ�DOVR�UHGRZQORDG�PXVLF�YLGHRV�WKDW�\RX�RULJLQDOO\�
purchased from the iTunes Store, but the service will not match video content or any other iTunes file types 
�3')�ERRNOHWV��YRLFH�PHPRV��

According to a support document Apple released, you also won’t be able to match or upload certain types of 
music files: files over 200MB, DRM-encumbered tracks that you aren’t authorized to play, DRM-encoded songs 
SXUFKDVHG�IURP�DQ�L7XQHV�6WRUH�RWKHU�WKDQ�WKH�8�6��YHUVLRQ��DQG�DQ\�PXVLF�HQFRGHG�DW�OHVV�WKDQ����NESV�

<RX�FDQ�IRRO�L7XQHV�0DWFK�RQ�WKDW�ODVW�RQH��KRZHYHU��LI�\RX�FUHDWH�DQ�$$&�YHUVLRQ�RI�WKH�VRQJ�ZLWKLQ�L7XQHV� 
�File > Create New Version > Create iPod or iPhone Version���DQG�WKHQ�DWWHPSW�WR�PDWFK�WKDW�YHUVLRQ�

WHAT DOES iCLOUD DO WITH MY PURCHASED iTUNES CONTENT? Using your free iCloud account, you can 
DFFHVV�D�FRPSOHWH�UHFRUG�RI�DOO�\RXU�SXUFKDVHV�IURP�L7XQHV��&KRRVH�WR�GRZQORDG�QHZ�PXVLF��DSSV��DQG�ERRNV�
DXWRPDWLFDOO\��DQG�UHGRZQORDG�DQ\WKLQJ�IRU�IUHH��ΖI�WUDFNV�\RXȇYH�SXUFKDVHG�DUH�QR�ORQJHU�DYDLODEOH�IURP�WKH�
L7XQHV�6WRUH��KRZHYHU��\RX�ZRQȇW�EH�DEOH�WR�UHGRZQORDG�WKHP�

WILL iTUNES MATCH LET ME UPLOAD OTHER USERS’ DRM-PROTECTED FILES? If you’re authorized to play the 
ILOH��\HVȃDQ\�FRPSXWHU�WKDW�LV�DXWKRUL]HG�WR�SOD\�SURWHFWHG�L7XQHV�PXVLF�FDQ�DGG�WKDW�PXVLF�WR�L7XQHV�0DWFK��
7KLV�LV�WKH�FDVH�HYHQ�LI�WKH�$SSOH�Ζ'�\RXȇUH�XVLQJ�IRU�L7XQHV�0DWFK�LVQȇW�WKH�VDPH�RQH�\RX�XVHG�WR�EX\�WKH�PXVLF�

)RU�H[DPSOH��VD\�\RX�KDYH�DQ�DOEXP�LQ�\RXU�L7XQHV�OLEUDU\�WKDW�\RX�SXUFKDVHG�XVLQJ�D�IDPLO\�PHPEHUȇV�$SSOH�
Ζ'��<RX�ERXJKW�WKLV�DOEXP�LQ�WKH�GD\V�EHIRUH�L7XQHV�ZHQW�'50�IUHH��VR�HYHU\�VRQJ�LV�D�3URWHFWHG�$$&�ILOHȃWKDW�
LV��LWȇV�FRS\�SURWHFWHG�DQG�OLQNHG�WR�D�VLQJOH�$SSOH�Ζ'��<RXU�ODSWRS�LV�DXWKRUL]HG�WR�SOD\�FRQWHQW�SXUFKDVHG�E\�
that ID, so you can listen to the song on your computer and on your iPhone, but you can’t move it to any other 
computer you own because that Apple ID has reached its limit of five authorized computers, and protected 
L7XQHV�PXVLF�ZRQȇW�SOD\�RQ�XQDXWKRUL]HG�FRPSXWHUV�

(QWHU�L7XQHV�0DWFK��6LQFH�\RXU�FRPSXWHU�LV�DXWKRUL]HG�WR�SOD\�WKRVH�WUDFNV��WKH�SURWHFWHG�VRQJV�VKRZ�XS�LQ�
L&ORXG�DV�0DWFKHG��7KLV�LV�WKH�VDPH�VWDWXV�L7XQHV�0DWFK�XVHV�IRU�VRQJV�\RXȇYH�ULSSHG�IURP�D�&'�RU�UHFHLYHG�
IURP�RWKHU�VRXUFHV��DQG�LW�LQGLFDWHV�WKDW�\RX�FDQ�UHGRZQORDG�WKH�VRQJ�DJDLQ�DV�D�'50�IUHH�����NESV�$$&�ILOH�

When you delete one of these protected songs from your library and redownload it by clicking the iCloud download 
EXWWRQ��RZQHUVKLS�LV�WUDQVIHUUHG�WR�\RXU�L7XQHV�0DWFK�DFFRXQW�DQG�WKH�ILOH�LV�GRZQORDGHG�DV�D�'50�IUHH�$$&�ILOH�
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$JDLQ��WKLV�ZLOO�RQO\�ZRUN�ZLWK�VRQJV�\RXU�FRPSXWHU�LV�DXWKRUL]HG�WR�SOD\��7U\�DGGLQJ�D�SURWHFWHG�VRQJ�\RX�DUHQȇW�
DXWKRUL]HG�WR�XVH��DQG�L7XQHV�0DWFK�GLVSOD\V�D�1RW�(OLJLEOH�ZDUQLQJ�

Unprotected purchases do not have this restriction: DRM-free purchased songs immediately show up as 
0DWFKHG��QR�DXWKRUL]DWLRQ�UHTXLUHG���2I�FRXUVH��ZLGHVSUHDG�PXVLF�VKDULQJ�LV�VWLOO�WHFKQLFDOO\�LOOHJDO��L7XQHV�
0DWFK�GRHVQȇW�FKDQJH�WKDW��

%RWK�RI�WKHVH�PHWKRGV�UHTXLUH�WKDW�WKH�WUDFN�VWLOO�H[LVW�RQ�WKH�L7XQHV�6WRUH��LI�$SSOH�KDV�SXOOHG�WKH�WUDFN��\RXȇOO�
have the option to upload the song, but when you redownload it, it will return to your library as a protected 
0�3�ILOH��LI�LW�KDV�'50��RU�D�'50�IUHH�ILOH��ZLWK�WKH�RULJLQDO�RZQHU�LQ�LWV�PHWDGDWD�

HOW DOES THE iPOD CLASSIC FIT INTO THE SCHEME OF PUSHING SONGS TO ALL DEVICES? iCloud requires 
DQ�ΖQWHUQHW�FRQQHFWLRQ�WR�GR�LWV�MRE��DQG�WKXV�LWȇV�OLPLWHG�WR�L26�GHYLFHVȃZKLFK�FDQ�FRQQHFW�WR�:L�)L�QHWZRUNV�
DQG�LQ�PRVW�FDVHV�FHOOXODU�GDWD�QHWZRUNV�DV�ZHOO��:H�FDQȇW�VHH�KRZ�DQ�L3RG�QDQR�RU�FODVVLF�FRXOG�HYHU�ILW�LQWR�WKH�
L&ORXG�HFRV\VWHP�

CAN I STREAM MY iTUNES-PURCHASED MUSIC DIRECTLY FROM THE MUSIC APP OR iTUNES ON MY COM-
PUTER, OR DO I HAVE TO FIRST DOWNLOAD IT TO A DEVICE? <HV��\RX�FDQ�VWUHDP�SXUFKDVHG�PXVLF�IURP�
\RXU�OLEUDU\�RQ�\RXU�0DF��3&��RU�L26�GHYLFHȃQR�QHHG�WR�GRZQORDG�LW�ILUVW�

IF I DON’T RENEW iTUNES MATCH AFTER A YEAR, DO I LOSE THOSE 256-KBPS AAC VERSIONS OF MY RIPPED 
TRACKS? 1R��<RXȇOO�NHHS�DQ\�VRQJV�\RXȇYH�XSJUDGHG��ΖI�\RX�XQVXEVFULEH��\RXȇOO�MXVW�ORVH�DFFHVV�WR�VWUHDPLQJ�DQG�
GRZQORDGLQJ�WKRVH�WUDFNV��DQG�RWKHUV��WR�\RXU�GHYLFHV��DQG�\RX�ZRQȇW�EH�DEOH�WR�UHGRZQORDG�WKHP�IURP�WKH�
L7XQHV�0XVLF�6WRUH��XQOLNH�\RXU�L7XQHV�SXUFKDVHG�FRQWHQW�

DOES iTUNES MATCH COPY YOUR LYRICS AS WELL? iTunes Match does retain lyrics you’ve added to your 
PXVLF��WR�DGG�O\ULFV�LQ�L7XQHV��VHOHFW�D�WUDFN��SUHVV��&RPPDQG!�Ζ��DQG�WKHQ�FOLFN�WKH�Lyrics tab and paste the lyr-
LFV�LQ���:KHQ�\RX�GRZQORDG�D�WUDFN�IURP�WKH�FORXG�WR�L7XQHV��WKH�O\ULFV�DUH�WKHUH��2QH�H[FHSWLRQ��ΖQ�RXU�WHVWV��ZH�
ORVW�WKH�O\ULFV�DGGHG�WR�SXUFKDVHG�WUDFNV�ZKHQ�ZH�UHGRZQORDGHG�WKHP�

L7XQHV�0DWFKȂV\QFHG�O\ULFV�GRQȇW��KRZHYHU��GLVSOD\�RQ�L26�GHYLFHV��<RXȇOO�VHH�O\ULFV�RQ�\RXU�L3KRQH��L3DG��DQG�
L3RG�WRXFK�IRU�PXVLF�V\QFHG�GLUHFWO\�IURP�L7XQHV��EXW�QRW�IRU�PXVLF�GRZQORDGHG�IURP�L7XQHV�0DWFK�

WILL iTUNES MATCH MESS WITH MY TITLE METADATA? )RUWXQDWHO\��ZKLOH�L7XQHV�0DWFK�VHHPV�WR�KDYH�
SUREOHPV�ZLWK�O\ULFV�DQG�DUWZRUN��DOO�RWKHU�WDJV�DUH�UHWDLQHG�MXVW�DV�\RX�VHW�WKHP��L7XQHV�0DWFK�PDWFKHV�PXVLF�
by the actual sound in the files, using digital fingerprinting—it doesn’t look at the tags you set, such as name, 
DOEXP��RU�DUWLVW�

MATCHED VERSUS UPLOADED TRACKS If iTunes returns a song of yours as Matched, this means it has a high-
TXDOLW\�YHUVLRQ�DYDLODEOH�LQ�LWV�WUDFN�FDWDORJ��DQG�\RX�ZRQȇW�KDYH�WR�XSORDG�\RXU�FXUUHQW�YHUVLRQ��ΖW�ZRQȇW�DXWR-
matically delete your current, low-quality file; instead, to replace it, you’ll need to delete the current file from 
\RXU�OLEUDU\�DQG�UHGRZQORDG�WKH�WUDFN�

Uploaded WUDFNV�DUH�WKRVH�L7XQHV�0DWFK�KDV�QRW�EHHQ�DEOH�WR�UHFRQFLOH�ZLWK�LWV�FDWDORJ��7KH�VHUYLFH�ZLOO�LQVWHDG�
XSORDG�VXFK�D�WUDFN��DV�LV��WR�LWV�VHUYHU�IRU�SOD\EDFN�
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WHERE DOES MATCH STORE MY UPLOADED SONGS? $V�SDUW�RI�\RXU�����SHU�\HDU�VXEVFULSWLRQ��L7XQHV�0DWFK�
stores uploaded songs on an iCloud server; when you want to play them back or download them, it redown-
ORDGV�WKDW�GDWD�ORFDOO\�WR�\RXU�GHYLFH��7KLV�VWRUDJH�LV�QRW�DVVRFLDWHG�ZLWK�\RXU�L&ORXG�DFFRXQW�DQG�GRHVQȇW�FRXQW�
WRZDUG�LWV�GDWD�OLPLW��

IF I ADD NEW MUSIC TO MY LIBRARY, DO I HAVE TO MANUALLY TELL iTUNES MATCH TO SCAN IT? 1RSH��
iTunes Match automatically rescans for content every so often, though you can force a refresh by going to  
Store > Update iTunes Match ZLWKLQ�L7XQHV��ΖI�\RX�UXQ�LQWR�HUURUV�RQ�LQGLYLGXDO�VRQJV��RU�\RX�KDYH�VRQJV�WDJJHG�
as Removed that you’d like to add back in, you can manually tell Match to scan those songs by right-clicking 
them and clicking Add to iCloud�

DO MY PLAYLISTS SYNC ACROSS DEVICES? <HV��WKH\�GR��<RX�FDQ�FUHDWH��HGLW��RU�GHOHWH�D�SOD\OLVW�RQ�\RXU�0DF��
3&��L3KRQH�RU�L3DG��DQG�WKRVH�FKDQJHV�V\QF�DFURVV�DQ\�L7XQHV�0DWFKȂHQDEOHG�GHYLFH�\RX�RZQ��2QH�FDYHDW��
3OD\OLVWV�ZLWK�LQHOLJLEOH�ILOHV�LQ�WKHP��YLGHRV��YRLFH�PHPRV��RU�3')V��IRU�H[DPSOH��ZLOO�QRW�V\QF�

WILL iTUNES MATCH SONGS DOWNLOAD OVER A CELLULAR CONNECTION ON MY iOS DEVICE? They 
ZLOO��EXW�RQO\�LI�\RX�DOORZ�WKHP�WR��1DYLJDWH�WR�Settings > iTunes & App Stores�RQ�\RXU�GHYLFH��7KH Use Cellular 
Data switch enables you to download content over a cellular connection; turn it off if you’d rather down-
ORDG�RYHU�:L�)L�

WHAT IF I HAVE MORE THAN 25,000 NONPURCHASED TRACKS? There are a couple tricks for getting around 
this—chopping up your library, or tagging some of your songs as podcasts or audiobooks—but unfortunately 
WKHUHȇV�QR�HDV\�ZD\��)RU�WKDW��ZHȇOO�KDYH�WR�ZDLW�DQG�VHH�LI�$SSOH�H[SDQGV�WKH�QXPEHU�RI�WUDFNV�\RX�FDQ�DGG��RU�
GHYHORSV�D�ZD\�IRU�XVHUV�WR�VLJQ�XS�HYHQ�LI�WKH\�KDYH�PRUH�WKDQ��������VRQJV�

IF I SYNC MUSIC TO MY iOS DEVICE VIA iTUNES, WILL IT REPLACE MY MUSIC WITH iTUNES MATCH SONGS? 
$V�ZH�GLVFRYHUHG�GXULQJ�RXU�WHVWLQJ��LW�GHSHQGV��ΖI�\RXȇYH�V\QFHG�\RXU�L26�GHYLFH�WR�D�PXVLF�OLEUDU\�WKDWȇV�FRQ-
nected to iTunes Match, iTunes will only supplement your currently synced content, leaving already synced 
VRQJV�DORQH�DQG�DGGLQJ�L&ORXG�GRZQORDG�LFRQV�IRU�WKRVH�LW�KDVQȇW�\HW�DGGHG�WR�\RXU�GHYLFH��ΖI�\RXȇYH�V\QFHG�WKH�
GHYLFH�ZLWK�PXVLF�QRW�LQ�\RXU�L7XQHV�0DWFK�FROOHFWLRQ��KRZHYHU��L7XQHV�ZLOO�UHSODFH�DOO�RI�WKDW�FRQWHQW�

I WANT iTUNES MATCH ON MY COMPUTERS, BUT NOT ON MY iOS DEVICES. CAN I STILL SYNC MUSIC NOR-
MALLY? $EVROXWHO\��ΖI�\RX�OHDYH�WKH�L7XQHV�0DWFK�WRJJOH�IOLSSHG�RII�RQ�\RXU�L26�GHYLFH��LW�ZLOO�FRQWLQXH�WR�V\QF�
QRUPDOO\�ZLWK�\RXU�FRPSXWHUȃHYHQ�LI�WKDW�FRPSXWHU�LV�XVLQJ�L7XQHV�0DWFK�

CAN I DELETE EVERYTHING OFF MY COMPUTER AND JUST USE MY STORED MATCH COLLECTION FROM 
iCLOUD? 6XUH��$SSOH�GRHVQȇW�UHTXLUH�\RX�WR�KDYH�D�ORFDO�FRS\�RI�\RXU�ILOHV��VR�\RX�FDQ�WKHRUHWLFDOO\�PDWFK�DQG�
XSORDG�HYHU\WKLQJ�WR�WKH�FORXG��DQG�WKHQ�GHOHWH�DOO�WKRVH�ILOHV�IURP�\RXU�FRPSXWHU��:H�ZLOO�VD\��KRZHYHU��WKDW�
while the iTunes Match servers are most likely pretty ironclad, and you run little risk of losing your data, flying 
ZLWKRXW�DQ\�EDFNXS�LV�QHYHU�VRPHWKLQJ�ZH�UHFRPPHQG���ΖI�\RX�ZDQW�WR�VDYH�VSDFH�RQ�\RXU�PDLQ�FRPSXWHU��\RX�
VKRXOG�PDNH�D�FRS\�RI�\RXU�L7XQHV�0HGLD�IROGHU�DQG�VWLFN�LW�RQ�DQ�H[WHUQDO�GULYH��DW�WKH�YHU\�OHDVW��
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Match Maladies

ΖI�L7XQHV�0DWFK�LV�KDYLQJ�WURXEOH�PDWFKLQJ�\RXU�VRQJV��KHUH�DUH�D�IHZ�EDVLF�VWHSV�WR�WDNH�

The first thing you can do is update iTunes Match on your Mac or PC by opening iTunes and going to Store > 
Update iTunes Match��7KLV�LV�$SSOHȇV�JR�WR�DOO�SXUSRVH�WURXEOHVKRRWLQJ�IL[ȃXVHIXO�LI�\RX�VHH�WUDFNV�ZLWK�HUURU�
OLVWLQJV�RU�PLVPDWFKHG�VRQJV�

$OWHUQDWLYHO\��LI�\RX�ZDQW�WR�DWWHPSW�WR�IL[�D�SUREOHP�ZLWK�MXVW�RQH�VRQJ�DW�D�WLPH���&RQWURO!�FOLFN��ULJKW�FOLFN��D�
problem song and select the Add to iCloud�FRPPDQG�

If you have DRM-protected songs, make sure your computer is authorized for playback from the account that 
SXUFKDVHG�WKH�PXVLF��ΖI�\RX�SXUFKDVHG�DOO�\RXU�PXVLF�\RXUVHOI��WKLV�VKRXOG�QRW�EH�DQ�LVVXH��ΖI�\RX�KDYH�VRQJV�
WKDW�RWKHU�$SSOH�Ζ'V�RULJLQDOO\�SXUFKDVHG��XQDXWKRUL]HG�SURWHFWHG�VRQJV�ZLOO�QRW�XSORDG�RU�PDWFK�WR�L&ORXG��
To address this, authorize the computer via the Store > Authorize this Computer command; then select Update 
iTunes Match.

ΖI�\RXȇUH�VWLOO�VHHLQJ�HUURUV��ZH�UHFRPPHQG�WXUQLQJ�L7XQHV�0DWFK�RII�DQG�RQ��E\�JRLQJ�WR�Store > Turn Off 
iTunes Match���'RQȇW�ZRUU\ȃGRLQJ�WKLV�ZRQȇW�ZLSH�RXW�\RXU�SULRU�PDWFKLQJ��:KHQ�\RX�UHHQDEOH�L7XQHV�
Match, what may have taken hours to do when you first subscribed should now only take a minute or two 
WR�UHVWRUH��2QH�Macworld�FRQWULEXWRU�KDG�WR�XVH�WKLV�WHFKQLTXH�WR�IL[�D�IDLOXUH�WR�GRZQORDG�VRQJV�IURP�
L&ORXG�WR�KLV�0DF�

%HORZ��ZHȇYH�FROOHFWHG�VRPH�RWKHU�FRPPRQ�L7XQHV�0DWFK�SUREOHPV�

MY ALBUM ARTWORK IS MISSING ΖW�VHHPV�WKDW�L7XQHV�0DWFK�LV�D�ELW�EXJJ\�UHJDUGLQJ�DUWZRUN��ΖI�\RXȇYH�
spent a lot of time adding artwork to your music, you may not want to delete any original files in case you 
SHUPDQHQWO\�ORVH�WKDW�DUWZRUN��<RX�FDQ�DOVR�DOZD\V�JR�WR�File > Library > Get Album Artwork within iTunes on 
\RXU�0DF�RU�3&�WR�JUDE�DUWZRUN�RII�L7XQHVȇ�VHUYHUV� 

HOW CAN I DELETE DUPLICATES THAT HAVE BEEN MATCHED? Delete the duplicates from both your library 
DQG�L&ORXG��:KHQ�\RX�SUHVV�WKH�Delete NH\��FKHFN�WKH�ER[�WKDW�VD\V�Also delete this item from iCloud.

WHY WON’T MY SONGS MATCH? Sometimes iTunes Match will match only one or two songs in an album, even 
LI�WKH�HQWLUH�DOEXP�LV�RQ�L7XQHV��DQG�OLVW�WKH�UHPDLQLQJ�VRQJV�DV�XSORDGHG��7KLV�PHDQV�\RX�FDQQRW�DFFHVV�WKH�
KLJKHU�TXDOLW\�YHUVLRQV�RI�WKH�XSORDGHG�VRQJV�

Unfortunately, there’s no way to force iCloud to match rather than upload songs; the consensus is that a server 
HUURU�LV�DW�IDXOW��7KDW�LV��LWȇV�D�SUREOHP�LQ�WKH�FORXG��QRW�RQ�\RXU�0DF��DOO�\RX�FDQ�GR�LV�KRSH�WKDW�$SSOH�ZLOO�HYHQ-
WXDOO\�DGGUHVV�LW���ΖI�\RX�VWLOO�ZDQW�WR�WU\�WR�VHOI�WURXEOHVKRRW��\RX�FDQ�WXUQ�L7XQHV�0DWFK�RII�DQG�RQ��

I HAVE DUPLICATE PLAYLISTS When you create a new playlist, especially if you create it on an iOS device, you 
PLJKW�ILQG�WKDW�WKH�OLVW�JHWV�GXSOLFDWHG��7KLV�VHHPV�HVSHFLDOO\�OLNHO\�LI�\RX�KDYH�$LUSODQH�PRGH�HQDEOHG�RQ�\RXU�
L26�GHYLFH�DW�WKH�WLPH��7KH�GXSOLFDWHV�DUH�XVXDOO\�HPSW\��EXW�WKH\�VWLOO�DUH�REYLRXVO\�DQQR\LQJ�

7KH�V\PSWRP�DSSHDUV�WR�EH�OLQNHG�WR�L7XQHV�0DWFK��ΖQ�IDFW��LQ�VRPH�FDVHV��SOD\OLVW�GXSOLFDWLRQV�RFFXU�VKRUWO\�
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DIWHU�\RX�WXUQ�L7XQHV�0DWFK�RQ��HYHQ�LI�\RX�GRQȇW�FUHDWH�D�QHZ�SOD\OLVW��ΖQ�DQ\�FDVH��RQFH�WKH�GXSOLFDWLRQV�SRS�
XS��WKH\ȇUH�OLNHO\�WR�VSUHDG�WR�DOO�\RXU�GHYLFHV�WKDW�KDYH�L7XQHV�0DWFK�HQDEOHG�

7KH�ILUVW�VWHS�LQ�UHVROYLQJ�WKLV�SUREOHP�LV�WR�JHW�ULG�RI�WKH�GXSOLFDWH�SOD\OLVWV��7KLV�FDQ�EH�D�WLPH�FRQVXPLQJ�SDLQ�
WR�GR�PDQXDOO\��GHOHWLQJ�SOD\OLVWV�RQH�E\�RQH���7R�VSHHG�WKLQJV�XS��\RX�FDQ�ODXQFK�$XWRPDWRU��D�XWLOLW\�EXLOW�LQWR�
your Mac) and select the Remove Empty Playlists�DFWLRQ�IURP�LWV�0XVLF�/LEUDU\��(YHQ�VLPSOHU��\RX�FDQ�SXUFKDVH�
'RXJ�$GDPVȇV����7UDFN6LIW�XWLOLW\�DQG�GHOHWH�HPSW\�SOD\OLVWV�ZLWK�MXVW�D�FOLFN�

1H[W��WR�KRSHIXOO\�SUHYHQW�WKLV�IURP�KDSSHQLQJ�DJDLQ�DQG�WR�EULQJ�EDFN�DQ\�QRQGXSOLFDWH�SOD\OLVWV�WKDW�PD\�
have disappeared at some point, select Store > Update iTunes Match�LQ�L7XQHV��ΖI�WKLV�GRHVQȇW�ZRUN��WU\�WKH�VDPH�
IL[�QRWHG�LQ�WKH�SUHYLRXV�VHFWLRQ��:KLOH�KROGLQJ�GRZQ�WKH��6KLIW!�RU��2SWLRQ!�NH\��WXUQ�RII�iTunes Match, and 
WKHQ�WXUQ�LW�EDFN�RQ�DJDLQ��ΖI�\RX�GR�WKLV��$SSOH�UHFRPPHQGV�WKDW�\RX�ILUVW�GLVDEOH�L7XQHV�0DWFK�RQ�DOO�RI�\RXU�
L26�GHYLFHV��DQG�WKHQ�UHHQDEOH�LW�RQ�WKHVH�GHYLFHV�DIWHU�WXUQLQJ�RQ�0DWFK�RQ�\RXU�0DF�

HOW DO I GET PODCASTS AND iTUNES U CONTENT TO MATCH? iTunes Match is technically only for your 
PXVLF��ΖI�\RX�UHDOO\�ZDQW�WR�VWRUH�\RXU�SRGFDVWV��KRZHYHU��FKDQJH�WKH�*HQUH�FDWHJRU\�IURP�3RGFDVW�WR�D�PXVL-
FDO�FDWHJRU\�

CAN ONE LIBRARY HAVE TWO SEPARATE iTUNES MATCH ACCOUNTS? 8QIRUWXQDWHO\��QR��'XH�WR�ZKDW�ZH�
suspect is a record company restriction, you can only associate your computer with one Apple ID for iTunes 
0DWFK�DQG�SDVW�SXUFKDVHV��ΖI�\RX�ZDQW�WR�FKDQJH�LW�WR�DQRWKHU�$SSOH�Ζ'��\RXȇOO�EH�DEOH�WR�GR�VRȃEXW�DIWHU�\RX�
VZLWFK��\RX�ZRQȇW�EH�DEOH�WR�FKDQJH�LW�EDFN�IRU����GD\V�

In theory, this prevents you from logging in to your friend’s iTunes Match account on your computer, download-
LQJ�DOO�KLV�PXVLF��DQG�WKHQ�VZDSSLQJ�EDFN�WR�\RXU�RZQ��ΖQ�DFWXDOLW\��LW�PDNHV�LW�D�WDG�GLIILFXOW�IRU�IDPLOLHV�ZKR�
VKDUH�DQ�L7XQHV�OLEUDU\��EXW�QRW�DQ�$SSOH�Ζ'��7R�JHW�DURXQG�WKLV��ZHȇG�VXJJHVW�HLWKHU�PDNLQJ�VHSDUDWH�XVHU� 
accounts on your computer, each with its own library, or option-clicking iTunes and creating a new library for 
HDFK�PHPEHU�RI�WKH�IDPLO\�

iTUNES SAYS IT HAS MATCHED TRACKS OF MINE THAT IT DOESN’T HAVE IN THE iTUNES STORE—WHAT’S 
UP WITH THAT?�L7XQHV�0DWFK�GRHV�RIIHU�VRPH�PDWFKHG�WUDFNV�IRU�DUWLVWV�LW�GRHVQȇW�RIILFLDOO\�VHOO�LQ�LWV�FDWDORJ��
This may come down to licensing: It’s possible that while record companies and certain artists may be OK with 
XVHUV�XSJUDGLQJ�DQ�DOUHDG\�RZQHG�&'�FROOHFWLRQ��WKH\�GRQȇW�ZDQW�WR�VHOO�WKHLU�PXVLF�GLJLWDOO\�

CAN I DOWNLOAD LOW-QUALITY VERSIONS OF MATCHED TRACKS TO MY iPHONE? 1RW�DW�WKLV�WLPH�

CAN I TELL iTUNES MATCH NOT TO SYNC CERTAIN SONGS? <HV��EXW�LWȇV�D�ELW�FRPSOLFDWHG�

ΖI�\RX�GRQȇW�ZDQW�L7XQHV�0DWFK�WR�GLVSOD\�FHUWDLQ�SXUFKDVHG�WUDFNV��VD\�\RX�GRZQORDGHG�D�6SLFH�*LUOV�DOEXP�LQ�
your impressionable youth), head to the iTunes Store on your Mac and click the Purchased link in the right side-
EDU��+RYHU�RYHU�WKH�WUDFNV�LQ�TXHVWLRQ�DQG�FOLFN�WKH�X�EXWWRQ�WR�KLGH�WKHP��<RX�FDQ�GR�WKLV�RQ�\RXU�L26�GHYLFH�E\�
going to the iTunes app and tapping Purchased,�DQG�WKHQ�VZLSLQJ�RQ�D�WUDFN�WR�KLGH�LW��7R�YLHZ�KLGGHQ�WUDFNV��JR�
to the iTunes Store on your Mac, click your email address, and scroll down to select View Hidden Purchases.
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If you want to avoid syncing songs in your library with iTunes Match, you can tag them as podcasts or audio-
ERRNV��XQIRUWXQDWHO\��WKH\ȇOO�KDYH�WR�VWD\�OLNH�WKDW�DV�ORQJ�DV�\RX�KDYH�L7XQHV�0DWFK�HQDEOHG�

Another option is to sync your entire music library with iTunes Match, and then enable Match on a second-
DU\�FRPSXWHU��RU�D�VHFRQG�L7XQHV�OLEUDU\���2Q�WKLV�VHFRQGDU\�FRPSXWHU��ORFDWH�WKH�VRQJV�\RX�ZDQW�WR�UHPRYH�
�WKH\ȇOO�VKRZ�XS�LQ�\RXU�OLEUDU\�ZLWK�DQ�L&ORXG�GRZQORDG�LFRQ���KLJKOLJKW�WKHP��DQG�SUHVV�WKH��'HOHWH!�NH\�RQ�
\RXU�NH\ERDUG��:KHQ�\RX�UHWXUQ�WR�\RXU�RULJLQDO�PXVLF�OLEUDU\��WKRVH�GRZQORDGHG�WUDFNV�ZLOO�VWLOO�H[LVW��EXW�
they’ll show up with an iCloud status of Removed, and an icon of a cloud with an X�WKURXJK�LW��L7XQHV�0DWFK�ZLOO�
continue to scan new tracks from your library, but Removed tracks will stay out of the cloud unless you manu-
DOO\�WHOO�WKHP�WR�UH�V\QF�ZLWK�0DWFK�

HOW CAN I HIDE SONGS NOT ON MY DEVICE? Both iTunes and the Music app have settings that allow you to 
KLGH�VRQJV�QRW�RQ�\RXU�GHYLFH��2Q�\RXU�0DF��RSHQ�L7XQHV�DQG�JR�WR�View > Hide Music in the Cloud��2Q�\RXU�L26�
device, go to Settings > Music DQG�WXUQ�RII�WKH�6KRZ�$OO�0XVLF�WRJJOH�

I MOVED TO ANOTHER COUNTRY—HOW CAN I MERGE MY iTUNES PURCHASES? Unfortunately, you can’t 
PRYH�DQ�DFFRXQW�WR�DQRWKHU�FRXQWU\�RU�PHUJH�WZR�$SSOH�Ζ'V��<RX�FDQ��KRZHYHU��GRZQORDG�DOO�SXUFKDVHG�FRQ-
tent from your previous country, and then create an iTunes Match account for the new Apple ID’s country, and 
XSORDG�RU�PDWFK�DOO�WKDW�PXVLF�

1RWH�WKDW�LI�\RX�FKDQJH�VWRUHV�RQ�D�FRPSXWHU�RU�L26�GHYLFH�WR�UHGRZQORDG�FRQWHQW��IRU�WKH�QH[W����GD\V�$SSOH�
ZRQȇW�OHW�\RX�FKDQJH�WKH�DFFRXQW��DQG�LQ�\RXU�FDVH��WKH�VWRUH��WKDW�WKH�GHYLFH�LV�OLQNHG�WR�

THE 5099 DOWNLOAD ERROR Occasionally, clicking Download icons can lead to 5099 error messages; the 
PHVVDJH�VXJJHVWV�\RX�FKHFN�WR�VHH�LI�\RX�KDYH�DQ�DFWLYH�QHWZRUN�FRQQHFWLRQ��7XUQLQJ�L7XQHV�0DWFK�RII�DQG�
EDFN�RQ�DJDLQ�VHHPV�WR�GR�WKH�WULFN�

Match Tips and Tricks

:DQW�WR�PDNH�L7XQHV�0DWFK�ZRUN�ZHOO�IRU�\RX"�&KHFN�RXW�WKHVH�VXJJHVWLRQV�

CHECK YOUR iCLOUD STATUS Want to know what songs of yours are matched, uploaded, ineligible, or have  
errors? In iTunes, click the Songs tab to ensure you’re viewing your music in Song view, and then select View > 
View Options��)URP�KHUH��PDNH�VXUH�WKDW�ERWK�WKH�iCloud Download and iCloud Status�LWHPV�DUH�VHOHFWHG�
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ADD iCLOUD STATUS Check the iCloud Download and iCloud Status options to organize 
your iTunes Match music.

7KH�'RZQORDG�FROXPQ�GLVSOD\V�LFRQV�LQGLFDWLQJ�WKH�FXUUHQW�VWDWXV�RI�\RXU�VRQJV��7KHVH�LFRQV�JHQHUDOO\� 
appear only when an action is pending or something has gone awry—such as a song that is ineligible to upload 
�EHFDXVH�LWȇV�LQ�DQ�LQFRPSDWLEOH�IRUPDW��RU�DQ�HUURU�LQ�WKH�XSORDGLQJ�SURFHVV��7KDWȇV�ZK\��LI�DOO�KDV�JRQH�ZHOO�
ZLWK�\RXU�LQLWLDO�L7XQHV�0DWFK�VHWXS��\RX�VKRXOG�VHH�IHZ�LI�DQ\�LFRQV�LQ�WKLV�FROXPQ�

7KH�L&ORXG�6WDWXV�FROXPQ�OLVWV�WH[W�GHVFULELQJ�WKH�VWDWXV�RI�\RXU�VRQJV��ΖI�WKHUHȇV�DQ�LFRQ�LQ�WKH�'RZQORDG�
FROXPQ�IRU�D�SDUWLFXODU�VRQJ��WKH�WH[W�PDWFKHV�WKH�PHDQLQJ�RI�WKH�LFRQ��+RZHYHU��WKLV�FROXPQ�DOVR�WHOOV�\RX�WKH�
VWDWXV�RI�VRQJV�WKDW�KDYH�QR�GRZQORDG�LFRQ��ΖQ�SDUWLFXODU��LW�OLVWV�ZKHWKHU�HDFK�VRQJ�LV�SXUFKDVHG��\RX�DFTXLUHG�
WKH�VRQJ�IURP�WKH�L7XQHV�6WRUH���0DWFKHG��\RX�DFTXLUHG�WKH�VRQJ�RQ�\RXU�RZQ��EXW�L&ORXG�KDV�D�PDWFKHG�DQG�
XVXDOO\�KLJKHU�TXDOLW\�YHUVLRQ���RU�XSORDGHG��\RX�DFTXLUHG�WKH�VRQJ�RQ�\RXU�RZQ�DQG�L7XQHV�GLGQȇW�ILQG�D�PDWFK��
VR�LW�XSORDGHG�\RXU�FRS\�WR�L&ORXG��

7KH�PDMRU�YDOXH�RI�WKHVH�FROXPQV�LV�DV�D�GLDJQRVWLF�DLG��7KH\�JLYH�DQ�LQGLFDWLRQ�RI�ZK\�D�VRQJ�LV�QRW�DYDLODEOH�LQ�
L&ORXG��KHOSLQJ�\RX�ILJXUH�RXW�ZKDW�\RX�PD\�EH�DEOH�WR�GR�WR�IL[�LW�

GET THE HIGHER-QUALITY VERSION OF YOUR MATCHED SONGS Have some poor-quality ripped tracks that 
WKH�VHUYLFH�KDV�PDWFKHG"�<RX�FDQ�GHOHWH�WKRVH�VRQJV�WKDW�L7XQHV�OLVWV�DV�0DWFKHG�DQG�UHGRZQORDG�WKHP�WR�
UHFHLYH�D�KLJKHU�TXDOLW\�YHUVLRQ�IURP�L&ORXG��7R�JHW�WKH�LPSURYHG�YHUVLRQ��FOLFN�WKH�Download icon in the iCloud 
'RZQORDG�FROXPQ�
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